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Introduction

Thank you for purchasing RM-64/RM-25/RM-9 v4.5 Network Video Recording Software (hereafter referred to as “RM-64/25/
9” or “this software”).

This manual also explains how to use RM-Lite v4.5 Network Video Recording Software (hereafter referred to as “RM-Lite”).
For the difference between RM-64/25/9 and RM-Lite, please refer to “About RM-Lite” (P. 33).

Please read this manual before using the software. After reading this manual, keep it in a safe place for future reference.
The cameras described in this manual may include models not available in your country and/or region.

In addition, please read the license agreement before using the software. The license agreement for RM-64/RM-25/RM-9
can be found in the LICENSE folder on the setup CD-ROM. The license agreement for RM-Lite is the text file provided with
the installer.

Precautions for Use (Disclaimer)

B Video Recording

Flaws or other problems with this software may result in recording failure or destruction or loss of recorded data.
Canon shall have no liability whatsoever for any loss or damages incurred by the user as a result of such problems.

B Copyright

Videos, images or sounds recorded with your camera may not be utilized or published without consent of copyright
holders, if any, except in such a way as permitted for personal use under the relevant copyright law.

Trademarks

e Canon and the Canon logo are registered trademarks of Canon Inc.

¢ Microsoft, Windows, Windows Server, Windows Vista, Internet Explorer, SQL Server, and Visual C++ are registered
trademarks or trademarks of Microsoft Corporation in the United States and other countries.

e Windows is legally recognized as Microsoft Windows Operating System.

e QuickTime is a trademark of Apple Inc.

e Apache is a trademark of the Apache Software Foundation.

e Pentium, Intel Core and Xeon are trademarks of Intel Corporation in the United States or other countries (or both).

e NVIDIA and GeForce are registered trademarks or trademarks of NVIDIA Corporation in the United States and other
countries.

e Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their
respective owners.

¢ All other company or product names used in this manual are trademarks or registered trademarks of their respective
holders.

Third Party Software

This product contains third party software modules.
Each module's license conditions are available in the OpenSourceSoftware folder in the LICENSE folder on the RM-64/RM-
25/RM-9 setup CD-ROM. For RM-Lite, refer to the text file provided with the installer.

THIS PRODUCT IS LICENSED FROM MPEGLA, LLC. UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR
THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE
MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A
CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL,



INTERNAL AND COMMERCIAL USES AND ADDITIONAL LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE
http://www.mpegla.com.

This product is licensed under AT&T patents for the MPEG-4 standard and may be used for encoding MPEG-4 compliant
video and/or decoding MPEG-4 compliant video that was encoded only (1) for a personal and non-commercial purpose or
(2) by a video provider licensed under the AT&T patents to provide MPEG-4 compliant video. No license is granted or
implied for any other use for MPEG-4 standard.

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE VIDEO IN
COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEQO") AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A
CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO
PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM




User Manuals

Types of User Manuals

This product has the following manuals:

Administrator Manual (this manual)
This manual is intended for the system administrator and provides information on how to operate this software product.

Please also read the manuals provided with each camera, as required.

B Notes

1 Any unauthorized reproduction of this guide is prohibited.

2 The contents of this manual are subject to change without any prior notice.

3 This document has been prepared with the utmost attention to accuracy. If you have any comments, however,
please contact a Canon sales representative.

4 Canon shall assume no liability for any outcome of using this product, regardless of ltems 2 and 3 above.

How to Use This Manual

This manual is intended for display and reading on your computer screen.

B Software Screenshots

The software screenshots samples shown in this guide are for illustration only. The screenshots may differ from the
actual screens displayed.

The VB-R11 is mainly used as the example camera in this manual. In addition, screens using Windows 8.1 are
displayed as samples to describe operations.

Symbols Used in This Manual

B Symbols Indicating Camera models

The following symbols indicate information unique to a specific camera model.

Symbol Camera Model
H45 VB-H45
VB-M44
VB-H730F Mk Il
VB-S30D MK I
VB-S31D MK I
S80xMKIl VB-S800D Mk Il and VB-S805D MKk
VB-S900F Mk Il and VB-S905F Mk I
VB-S30VE
VB-S800VE
VB-S910F
R13 VB-R13VE and VB-R13
R12 VB-R12VE




Symbol Camera Model

M50 VB-M50B

H65 VB-HB652LVE

H65 VB-H651VE and VB-H651V

H76 VB-H761LVE-H and VB-H761LVE
VB-H760VE

VB-H751LE-H and VB-H751LE

ity

VB-R11VE and VB-R11

VB-R10VE
M64 VB-M641VE and VB-M641V
V64 VB-M640VE and VB-M640V
VB-M741LE-H and VB-M741LE
M74 VB-M740E
S30 VB-S30D
3 VB-S31D
80X VB-S800D and VB-S805D
SO0X VB-S900F and VB-S905F
H43 VB-H43
VB-H41
H63 VB-HB30VE and VB-H630D
VB-H610VE and VB-H610D
VB-H730F
VB-H710F
7 VB-M42
7 VB-M40

VB-M620VE and VB-M620D

VB-M6B00VE and VB-M600D
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VB-M720F

VB-M700F
C50! VB-C500VD and VB-C500D
C6 VB-C60

VB-C300
C50! VB-C50Fi and VB-C50FSi
C50i VB-C50i and VB-C50iR

Symbols Indicating Products

The following symbols indicate information that is unique to the RM-64/25/9 and the RM-Lite version.

Symbol Meaning
VG50 Features unique to the RM-64/25/9. They cannot be used with RM-Lite.
Information unique to RM-Lite.

Symbols Indicating Precautions

The following symbols indicate descriptions you should pay close attention to.



Meaning

Cautions and restrictions during operation. Make sure to read these carefully.

Supplementary descriptions and reference information.
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Chapter

Before Use

This chapter introduces items that should be understood before using the software.
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Features

The RM-64/25/9 is a software product family used to monitor multiple locations using network cameras and to record and
play back video from the cameras. It is possible to set up a monitoring system with a maximum of 512 cameras when using
multiple Storage Servers.

Operation when using the Viewer and RM Manager

The Viewer is used to view video, and RM Manager is used for system management and to configure Storage Server
settings.

Multiple recording modes

In addition to being able to record video for a specific period, you also have recording modes, such as sensor
recording, motion detection recording, intelligent function recording and volume detection recording, which start
recording when a particular type of camera event occurs.

Support for JPEG/MPEG-4 and H.264 *

The JPEG, MPEG-4 and H.264 video formats are supported for live view and recording. Using MPEG-4 or H.264
formats decreases the load on the network bandwidth, while maintaining high quality video and saving hard disk
space when recording.

Direct camera operation *

You can change the camera angle and use the zoom while watching the live view.

Two-way audio*
Send and receive live audio and simultaneously record audio with the video. You can also use this feature to

communicate with a location that has a camera.

* Only available for cameras that support the feature.

Flexible screen layout

You can arrange multiple video windows in the Viewer, so you can compare video from different locations at the
same time. The Viewer lets you create multiple layouts and organize them in tabs on the viewing area, so you can
easily switch between different camera video.

You can also operate up to two Viewer windows at the same time. With an environment that supports multiple
displays, you can create a dual-display monitoring setup by locating a Viewer on each of the displays.

Tags

You can assign tags to a camera that give you information about the camera, such as its location and camera type.
This is particularly useful when searching for cameras in a large-scale system.

Dynamic layouts

With this feature, you can automatically display videos in the Viewer on a layout from cameras that meet specific
criteria, such as the camera status.

User access management with user groups

You can create user groups to more easily manage user access. By assigning permissions to a group, you
automatically assign the same permissions to each member of the group.



Shade control

Shade control automatically compensates for the dark regions in the video and can be used for both live and
recorded video.

Record Now (Manual recording)

Use this feature to immediately start recording when you do not have a recording schedule set up.

Saving the specified video

You can extract part of a recording and save it as a video file that can be played on a computer.

Viewer PTZ

You can instantly crop a region of live video or recorded video during playback using an intuitive operation to zoom in

on that region.
You can also crop and zoom several videos simultaneously for side-by-side comparison.

Some features have limited functionality. For details, please refer to “About RM-Lite” (P. 33).

m Important

Storage Server/Viewer v3.2 and earlier, and Storage Server/Viewer/RM Manager v4.5 cannot connect.

A

osM aiojog
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Operating Environment

For High-reliability/H.264 Video Format Systems

Storage Server Viewer/RM Manager
CPU Intel Xeon 3060 or Intel Core 2 Duo 2.4 GHz or Intel Core i5 750 2.67 GHz or higher
higher Intel Core i7 3.5 GHz or higher recommended
or an Intel CPU of equivalent class that meets the | when displaying 1920 x 1080 video
following requirements:
Clock speed: 2.4 GHz or greater
L2 cache 4 MB or greater
No. of cores: 2 or more
Memory 2 GB or greater
Hard disk Interface: SAS / SATA 100 MB is required for installation (an additional
Cache: 16 MB or greater 500 MB is required if .NET Framework 3.5 SP1 or
Spindle speed: 7200 rpm or faster .NET Framework 4.5 is not installed)
100 MB is required for installation (an additional Additional space for saving extracted video files,

500 MB is required if NET Framework 3.5 SP1 or as required.
.NET Framework 4.5 is not installed)

Additional space for recording files and other files
depends on the number of cameras and the
recording settings

Itis recommended that you use separate hard disk
drives for the OS and the recording data.

Network controller

1000 BASE-T or similar, supporting 1 Gbps transfer speed

Display

- 1280x1024 resolution or higher
16-bit colors or greater
Required to display all user interfaces of the Viewer

Graphics

- NVIDIA GeForce GT 220 or higher

Or a graphics card of equivalent class that meets
the following requirements:

Video memory size: 1 GB or greater

Memory interface width: 128-bit or larger

Memory clock: 790 MHz or greater

NVIDIA GeForce GTX 660 or higher recommended
when displaying 1920 x 1080 video

Others

- Audio support is required for audio playback
(P. 108).

Operating system

Windows Vista Ultimate/Business/Enterprise SP2 32/64-bit

Windows Vista Ultimate/Business/Enterprise/Home Premium SP2 32/64-bit
Windows 7 Ultimate/Professional/Enterprise SP1 32/64-bit

Windows 7 Ultimate/Professional/Enterprise/Home Premium SP1 32/64-bit
Windows 8/Windows 8 Pro/Windows 8 Enterprise 32/64-bit

Windows 8.1/Windows 8.1 Pro/Windows 8.1 Enterprise 32/64-bit

Windows 10 Pro/Windows 10 Enterprise/Windows 10 Home 32/64-bit

Windows Server 2008 Standard SP2 32/64-bit

Windows Server 2008 R2 Standard SP1 64-bit

Windows Server 2012 Standard 64-bit

Windows Server 2012 R2 Standard 64-bit

When a highly reliable system (such as 24 hours of uninterrupted use) is required, server operating
systems are recommended.

The tablet mode for Windows 10 is not supported.

Operating system language

English, German, Spanish, French, Italian, Turkish, Russian, Thai, and Japanese
Environment languages switched using language-packs are not supported.




A

e The system requirements described in the previous section are the minimum requirements, assuming the following
operating environment:

Storage Maximum recording/playback data rate 80 Mbps # @
Server - 5 o
Overall recording frame rate 1280 fps or slower * @
c
Maximum number of cameras with motion 10 units 3

detection*3

Maximum events processed *4 20,000 events per day

When using recommended Intel i5 + GT 220

Viewer Estimated display frame rate *5
For 1920 x 1080 display size: 20 fps (15 fps for H.264)*®

For 1280 x 720 display size: 40 fps
For 1280 x 960 display size: 40 fps

For 960 x 540 display size
For 640 x 360 display size
For 640 x 480 display size
For 480 x 270 display size
For 320 x 180 display size
For 320 x 240 display size

For 1280 x 720 display siz
For 1280 x 960 display siz
For 960 x 540 display size
For 640 x 360 display size
For 640 x 480 display size
For 480 x 270 display size
For 320 x 180 display size
For 320 x 240 display size

45 fps
. 80 fps
: 80 fps
160 fps
1 320 fps
1 320 fps

When using Intel i7 + GTX 660
For 1920 x 1080 display size: 30 fps (15 fps for H.264)*6

e: 40 fps
e: 40 fps
145 fps
: 80 fps
. 80 fps
. 160 fps
320 fps
1 320 fps

32 or less per layout 7
(12 or less for H.264 video windows. 6 or less for displaying MPEG-4
or H.264 and MPEG-4 simultaneously.)

Number of video windows available to
display simultaneously.

*1 If the volume per second of recording and playback data handled by one Storage Server is 80 Mbps or greater, you should
review your recording requirements to ensure system stability. The following shows an estimate of the recording and playback
data volume per second for various video formats.

320 x 240 640 x 480 1920 x 1080

JPEG 810 fps 280 fps 50 fps
MPEG-4

80 Mbps
H.264

For standard resolution ([Video Quality] set to [3]), the JPEG video frame rates will result in an estimated data rate of 80 Mbps.
Audio data requires a Storage Server of 64 Kbps, regardless of the type of camera.
You can check the recording/playback data volume per second during operation on the [Storage Server] tab in RM Manager
(P. 56).

*2 The data size of recorded audio is calculated using a frame rate of 10 fps per camera.

*3 Number of cameras selected in [Detect Motion Using] > [Storage Server] for motion detection recording.

*4 Total number of all types of events.

*5 Assumes a standard resolution ([Video Quality] setting is [3]) and that the receive size and display size are the same. If the
receive size and display size are different, performance may decrease due to an increase in processing load.

*6 When multiple video sizes are combined, they will be equivalent to the following: 1920 x 1080 will be equivalent to 14 320 x
240 size videos, 1280 x 720 will be equivalent to 8 320 x 240 size videos, 1280 x 960 will be equivalent to 8 320 x 240 size
videos, 960 x 540 will be equivalent to 7 320 x 240 size videos, 640 x 360 will be equivalent to 5 320 x 240 size videos, 640 x
480 will be equivalent to 5 320 x 240 size videos, 480 x 270 will be equivalent to 2 320 x 240 size videos, 320 x 180 will be
equivalent to 1 320 x 240 size videos.

For example, the following combinations will result in a total equivalent of 320 x 240 at 320 fps.
1920 x 1080, 5 fps — 320 x 240, 5 fps x 14 = 70 fps equivalent
1280 x 960, 5 fps — 320 x 240, 5 fps x 8 = 40 fps equivalent

960 x 540, 8 fps — 320 x 240, 8 fps x 7 = 56 fps equivalent
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640 x 480, 8 fps
480 x 270, 25 fps
320 x 240, 64 fps

— 320 x 240, 8 fps x 5 = 40 fps equivalent
— 320 x 240, 25 fps x 2 = 50 fps equivalent

Total: 320 x 240, 320 fps equivalent (70 + 40 + 56 + 40 + 50 + 64)

*7 The number of videos you can display at once depends on the amount of memory available. If there is not enough memory,
you will not be able to display videos.

¢ In a system environment with a large number of cameras and connected viewers and where the number of events that
may occur is also likely to be high, the Storage Server must come with the specifications that meet the needs of that
environment for stable operation.

e |f you need to operate a high-reliability system (such as for 24hour operation) in a system environment, we recommend
that you use a server operating system on the computer that is used for the Storage Server.

e When high-reliability operation is required (such as for 24-hour operation, and high frequency disk access) we strongly
recommend that you use a high-reliability SAS hard disk. Using a low-reliability SATA hard disk may result in a disk error
in a one to two year period. Therefore, you may need to check the disk for errors on a regular basis, using features such
as scan disk. In such a case, recording performance may suffer during checking, due to the increased load on the disk.

e With systems intended for users requiring high-reliability/H.264, when operating both the Storage Server and the Viewer
on one computer, the operating environment must satisfy the requirements for both the Storage Server and the Viewer.
However, to help ensure stable operation, we recommend that you use separate computers for the Storage Server and

for the Viewer.

¢ Do not use RM Manager and the Viewer simultaneously.

For Small-scale Systems (Storage Server, Viewer, and RM Manager

Installed)
Storage Server/Viewer/RM Manager
CPU Intel Pentium G6950 2.80 GHz or higher,
or an Intel CPU of equivalent class that meets the following requirements:
Clock: 2.4 GHz or higher
L2 cache: 512 KB or greater
L3 cache: 3 MB or greater (only required if the L2 cache is less than 3 MB)
Number of cores: 2 or more
Memory 2 GB or greater
Hard disk Interface: SAS / SATA

Cache: 16 MB or greater

Spindle speed: 7200 rpm or faster

200 MB is required for installation (an additional 500 MB is required if .NET Framework 3.5 SP1 or .NET
Framework 4.5 is not installed)

Additional space for recording files and other files (the actual space required depends on the number of
cameras and the recording settings)

Additional space for saving extracted video files, as required.

The hard disk drive for the recording data should have a capacity of 1GB or greater.

Network controller

100 BASE-TX or similar, 100 Mbps transfer speed

Display 1280 x 1024 resolution or higher

16-bit colors or greater

Required to display all user interfaces of the Viewer
Others Audio support is required for audio playback (P. 108).

Operating system

Windows Vista Ultimate/Business/Enterprise SP2 32/64-bit

Windows Vista Ultimate/Business/Enterprise/Home Premium SP2 32/64-bit
Windows 7 Ultimate/Professional/Enterprise SP1 32/64-bit

(H®) Windows 7 Ultimate/Professional/Enterprise/Home Premium SP1 32/64-bit
Windows 8/Windows 8 Pro/Windows 8 Enterprise 32/64-bit

Windows 8.1/Windows 8.1 Pro/Windows 8.1 Enterprise 32/64-bit

Windows 10 Pro/Windows 10 Enterprise/Windows 10 Home 32/64-bit

Windows Server 2008 Standard SP2 32/64-bit

Windows Server 2008 R2 Standard SP1 64-bit

Windows Server 2012 Standard 64-bit

Windows Server 2012 R2 Standard 64-bit

The tablet mode for Windows 10 is not supported.
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Storage Server/Viewer/RM Manager

Operating system language | English, German, Spanish, French, Italian, Turkish, Russian, Thai, and Japanese

Environment languages switched using language-packs are not supported. o
¢ The system requirements described above are the minimum configuration, assuming the following operating é
environment: 2
Storage Server Maximum recording/playback data rate 16 Mbps *
Overall recording frame rate 256 fps or slower *2

Maximum number of cameras with motion detection 0 units

Maximum events processed *3 10,000 events per day

Viewer Estimated display frame rate ** 1920 x 1080: 1 fps

1280 x 960: 2 fps

960 x 540: 5 fps

640 x 480: 10 fps

480 x 270: 15 fps

320 x 240: 30 fps

Total number of simultaneously displayable MPEG-4 | 6 or less*®
videos

*1 Do not use H.264 in small-scale systems, as this can have a negative effect on Viewer use.
*2 The data size of recorded audio is calculated using a frame rate of 10 fps per camera.
*3 Total number of all types of events.

*4 Assumes a standard resolution ([Video Quality] setting is [3]) and that the receive size and display size are the same. If the
receive size and display size are different, performance may decrease due to an increase in processing load.

*5 The number of videos you can display at once depends on the amount of memory available. If there is not enough memory,
you will not be able to display videos.

e The following are guidelines for implementing a system for a small-scale user.

System components Guideline
Number of cameras Approx. 9 cameras (assuming RM-9 is used for operation)
Recording frame rate 5 fps x 9 cameras with 320 x 240 standard resolution (approx. 8 Mbps in terms of data rate)
Display frame rate When displaying only live video:

3 fps x 9 cameras (= 27 fps) with 320 x 240 standard resolution
When displaying only playback video:
5 fps x 6 cameras (= 30 fps) with 320 x 240 standard resolution
When displaying live video and playback video simultaneously:
3 fps x 8 for live display + 5 fps x 1 for playback with 320 x 240 standard resolution

Others H.264 is not used

o The Viewer computer specifications on P. 16 are required even for small scale systems (up to four cameras) using
RM-Lite, if you want to display H.264 video.
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For Large-scale Systems (with Multiple Storage Servers)

Storage Server

Viewer/RM Manager

CPU

3.4 GHz or higher

following requirements:

Clock speed: 2.4 GHz or greater
L2 cache 4 MB or greater

No. of cores: 2 or more

or an Intel CPU of equivalent class that meets the

Intel Xeon E3-1245 v3 or Intel Core i7 4770 Intel Core i7 4770 3.4 GHz or higher

Memory

6 GB or greater

4 GB or greater

Hard disk

Interface: SAS / SATA
Cache: 16 MB or greater
Spindle speed: 7200 rpm or faster

recording settings

Itis recommended that you use separate hard disk
drives for the OS and the recording data.

100 MB is required for installation (an additional
500 MB is required if .NET Framework 3.5 SP1 or
.NET Framework 4.5 is not installed)

100 MB is required for installation (an additional Additional space for saving extracted video files,
500 MB is required if NET Framework 3.5 SP1 or as required.

.NET Framework 4.5 is not installed)

Additional space for recording files and other files
depends on the number of cameras and the

Network controller

1000 BASE-T or similar, supporting 1 Gbps transfer speed

Display - 1280x1024 resolution or higher

16-bit colors or greater

Required to display all user interfaces of the Viewer
Graphics - NVIDIA GeForce GTX 660 or higher
Others - Audio support is required for audio playback

(P. 108).

Operating system

systems are recommended.

Windows Vista Ultimate/Business/Enterprise SP2 32/64-bit

Windows 7 Ultimate/Professional/Enterprise SP1 32/64-bit

Windows 8/Windows 8 Pro/Windows 8 Enterprise 32/64-bit

Windows 8.1/Windows 8.1 Pro/Windows 8.1 Enterprise 32/64-bit

Windows 10 Pro/Windows 10 Enterprise/Windows 10 Home 32/64-bit

Windows Server 2008 Standard SP2 32/64-bit

Windows Server 2008 R2 Standard SP1 64-bit

Windows Server 2012 Standard 64-bit

Windows Server 2012 R2 Standard 64-bit

When a highly reliable system (such as 24 hours of uninterrupted use) is required, server operating

The tablet mode for Windows 10 is not supported.

Operating system language | English, German, Spanish, French

, Italian, Turkish, Russian, Thai, and Japanese
Environment languages switched using language-packs are not supported.

e The system requirements described above are the minimum configuration, assuming the following operating

environment:

Storage
Server

Maximum recording/playback data rate

80 Mbps *'

Overall recording frame rate

1280 fps or slower *2

Maximum number of cameras with motion
detection*3

10 units

Maximum events processed *4

20,000 events per day
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Viewer Estimated display frame rate *5 When using Intel i7 + GTX 660

For 1920 x 1080 display size: 30 fps (15 fps for H.264)*6
For 1280 x 720 display size: 40 fps

For 1280 x 960 display size: 40 fps

For 960 x 540 display size: 45 fps

For 640 x 360 display size: 80 fps

For 640 x 480 display size: 80 fps

For 480 x 270 display size: 160 fps

For 320 x 180 display size: 320 fps

For 320 x 240 display size: 320 fps

osM aiojog

Number of video windows available to 32 or less per layout *7
display simultaneously. (12 or less for H.264 video windows. 6 or less for displaying MPEG-4
or H.264 and MPEG-4 simultaneously.)

*1 If the volume per second of recording and playback data handled by one Storage Server is 80 Mbps or greater, you should
review your recording requirements to ensure system stability. The following shows an estimate of the recording and playback
data volume per second for various video formats.

320 x 240 640 x 480 1920 x 1080

JPEG 810 fps 280 fps 50 fps
MPEG-4

80 Mbps
H.264

For standard resolution ([Video Quality] set to [3]), the JPEG video frame rates will result in an estimated data rate of 80 Mbps.
Audio data requires a Storage Server of 64 Kbps, regardless of the type of camera.
You can check the recording/playback data volume per second during operation on the [Storage Server] tab in RM Manager
(P. 56).

*2 The data size of recorded audio is calculated using a frame rate of 10 fps per camera.

*3 Number of cameras selected in [Detect Motion Using] > [Storage Server] for motion detection recording.

*4 Total number of all types of events.

*5 Assumes a standard resolution ([Video Quality] setting is [3]) and that the receive size and display size are the same. If the
receive size and display size are different, performance may decrease due to an increase in processing load.

*6 When multiple video sizes are combined, they will be equivalent to the following: 1920 x 1080 will be equivalent to 14 320 x
240 size videos, 1280 x 720 will be equivalent to 8 320 x 240 size videos, 1280 x 960 will be equivalent to 8 320 x 240 size
videos, 960 x 540 will be equivalent to 7 320 x 240 size videos, 640 x 360 will be equivalent to 5 320 x 240 size videos, 640 x
480 will be equivalent to 5 320 x 240 size videos, 480 x 270 will be equivalent to 2 320 x 240 size videos, 320 x 180 will be
equivalent to 1 320 x 240 size videos.

For example, the following combinations will result in a total equivalent of 320 x 240 at 320 fps.

1920 x 1080, 5 fps — 320 x 240, 5 fps x 14 = 70 fps equivalent
1280 x 960, 5 fps — 320 x 240, 5 fps x 8 = 40 fps equivalent
960 x 540, 8 fps — 320 x 240, 8 fps x 7 = 56 fps equivalent
640 x 480, 8 fps — 320 x 240, 8 fps x 5 = 40 fps equivalent
480 x 270, 25 fps — 320 x 240, 25 fps x 2 = 50 fps equivalent

320 x 240, 64 fps

Total: 320 x 240, 320 fps equivalent (70 + 40 + 56 + 40 + 50 + 64)

*7 The number of videos you can display at once depends on the amount of memory available. If there is not enough memory,
you will not be able to display videos.

¢ |n a system environment with a large number of cameras and connected viewers and where the number of events that
may occur is also likely to be high, the Storage Server must come with the specifications that meet the needs of that
environment for stable operation.

e |f you need to operate a high-reliability system (such as for 24hour operation) in a system environment, we recommend
that you use a server operating system on the computer that is used for the Storage Server.

e \When high-reliability operation is required (such as for 24-hour operation, and high frequency disk access) we strongly
recommend that you use a high-reliability SAS hard disk. Using a low-reliability SATA hard disk may result in a disk error
in a one to two year period. Therefore, you may need to check the disk for errors on a regular basis, using features such
as scan disk. In such a case, recording performance may suffer during checking, due to the increased load on the disk.
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e To help ensure stable operation, we recommend that you use separate computers for the Storage Server and for the

Viewer.

¢ Do not use RM Manager and the Viewer simultaneously.

Important Notes Concerning System Requirements

The drive you install the software on and the drive for saving recorded video must be in NTFS format.

This software does not support external storage, such as USB hard disks and NAS.

This software does not support virtual computer environments, such as Hyper-V.

It is recommended that you operate this software in its own dedicated LAN environment.

The software may not be able to record video if you use an environment where the IP addresses of the cameras change.

Please use fixed IP addresses to ensure proper operation.

Use the same network address (either IPv4 or IPv6) for cameras, Storage Server computers, and the Viewer/RM

Manager computer.

For details on the operating system, please refer to “Additional Considerations” in “Operating Environment” (P. 23).

Audio cannot be transmitted from a Viewer to the camera, if you use the Viewer on a computer running

Windows 10, Windows 7, Windows 8, Windows 8.1, Windows Server 2008 R2, Windows Server 2012 or Windows Server

2012 R2.

Before applying a service pack or updating the operating system, please refer to the Canon website.

Do not use Windows Update while the system is in operation. Doing so may cause the system operation to become

unstable, the operating system to restart, or the recording to stop.

Using anti-virus software or a firewall may affect the performance of the Storage Server and Viewer.

Running software other than this product or compatible camera management software may cause system operation to

become unstable.

When there is a high load on the CPU or hard disk, video may not be recorded or displayed at the specified frame rate,

recording may be interrupted, or the Viewer operation speed may decrease. In addition, recording may be interrupted

when the available hard disk space is low.

Operation may slow down if the amount of stored data (number of recording files) becomes large.

Depending on the performance of the computer and the network environment, changes in the recording environment

(such as the time of day and the weather) may result in it not being possible to display recorded or live video according

to the specified settings.

Using IPsec may degrade the performance for recording and displaying video.

You can use the camera audio feature (except for the VB-C50Fi, which does not support the function). Review the

following items before using the feature.

— The Viewer supports transmission and reception of audio data.

— Audio data cannot be recorded separately, and is always recorded together with the video.

— Synchronization is enabled only when playing back recorded video (JPEG) and recorded audio. However, the audio
and video may not be synchronized, depending on the operating environment (P. 78).

— The audio stream may be interrupted, depending on the performance of your computer and network environment.

— Audio may be interrupted when using anti-virus software.

The software cannot be used with cameras on which only HTTPS encrypted communication is allowed (i.e., cameras on

which settings are configured to prohibit all other types of communication).

Be sure to test the system under your operating environment before starting regular operation.

(=] Note

The system environment of the Storage Server will depend on your operating conditions (number of cameras, recording frame rate
settings, etc.), as well as the pre-event recording settings. For details, please contact your local supplier.

Microsoft .NET Framework 3.5 SP1 or .NET Framework 4.5 is required for this software to operate. .NET Framework 3.5 SP1 is
automatically installed when installing RM-64/25/9. For RM-Lite, refer to the “Installation Procedures” (p. 38). Enable .NET Framework 4.5
if it is currently disabled.

The following runtime module is installed automatically with RM-64/25/9 and RM-Lite. Do not uninstall this module.
— Microsoft Visual C++ 2008 Redistributable

Microsoft .NET Framework 4.0 is not supported.



Additional Considerations

¢ Do not specify the Windows folder or the Program Files folder on the system drive as the destination for snapshots or

recording files. You cannot save images or videos to those folders.
e You cannot use the OS's shadow backup feature. For example, once you delete the configuration file for this software,

the file cannot be restored with the OS’s shadow backup feature.

i
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Supported Cameras

Camera Firmware Version
VB-H45 Ver. 1.0.0 or later
VB-M44 Ver. 1.0.0 or later
VB-H730F Mk Il Ver. 1.0.0 or later
VB-S30D Mk I Ver. 1.0.0 or later
VB-S31D Mk Il Ver. 1.0.0 or later
VB-S800D Mk Il Ver. 1.0.0 or later
VB-S900F Mk II Ver. 1.0.0 or later
VB-S805D Mk Il Ver. 1.0.0 or later
VB-S905F Mk Il Ver. 1.0.0 or later
VB-H761LVE-H Ver. 1.1.0 or later
VB-H751LE-H Ver. 1.1.0 or later
VB-M741LE-H Ver. 1.1.0 or later
VB-S30VE Ver. 1.0.0 or later
VB-S800VE Ver. 1.0.0 or later
VB-S910F Ver. 1.0.0 or later
VB-R13VE Ver. 1.0.0 or later
VB-R13 Ver. 1.0.0 or later
VB-R12VE Ver. 1.0.0 or later
VB-M50B Ver. 1.0.0 or later
VB-H652LVE Ver. 1.0.0 or later
VB-H651VE Ver. 1.0.0 or later
VB-H651V Ver. 1.0.0 or later
VB-H761LVE Ver. 1.0.0 or later
VB-H760VE Ver. 1.0.0 or later
VB-H751LE Ver. 1.0.0 or later
VB-R11VE Ver. 1.0.2 or later
VB-R11 Ver. 1.0.2 or later
VB-R10VE Ver. 1.0.2 or later
VB-M641VE Ver. 1.0.2 or later
VB-M641V Ver. 1.0.2 or later
VB-M640VE Ver. 1.0.2 or later
VB-M640V Ver. 1.0.2 or later
VB-M741LE Ver. 1.0.2 or later
VB-M740E Ver. 1.0.2 or later
VB-S30D Ver. 1.3.0 or later
VB-S31D Ver. 1.3.0 or later
VB-S800D Ver. 1.3.0 or later
VB-S900F Ver. 1.3.0 or later
VB-S805D Ver. 1.3.0 or later
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Camera Firmware Version
VB-S905F Ver. 1.3.0 or later
VB-H43 Ver. 1.2.0 or later g
VB-H630VE Ver. 1.2.0 or later ;
VB-H630D Ver. 1.2.0 or later °
VB-H730F Ver. 1.2.0 or later
VB-H41 Ver. 1.3.0 or later
VB-H610VE Ver. 1.3.0 or later
VB-H610D Ver. 1.3.0 or later
VB-H710F Ver. 1.3.0 or later
VB-M42 Ver. 1.2.0 or later
VB-M620VE Ver. 1.2.0 or later
VB-M620D Ver. 1.2.0 or later
VB-M720F Ver. 1.2.0 or later
VB-M40 Ver. 1.2.0 or later
VB-M600VE Ver. 1.1.2 or later
VB-M600D Ver. 1.1.2 or later
VB-M700F Ver. 1.1.2 or later
VB-C500VD/VB-C500D Ver. 1.1.2 or later
VB-C60 Ver. 1.1.3 or later
VB-C300 Ver. 1.1 Rev. 5 or later
VB-C50i/VB-C50iR Ver. 1.2 Rev. 77 or later
VB-C50FSi/VB-C50Fi Ver. 1.0 Rev. 77 or later

[E] Note

Please refer to “Using the AXIS Q7404/Q7401” (P. 170) for details on limitations when using the AXIS Q7404/Q7401.

H652 [ H651 [H761 [H760 [H751 M640[M741]M740

Even if the camera’s video image has been set to rotate in the Viewer’s display using [Rotate Video Display] in the setting page, the video
displayed by and recorded in this software will not be rotated.

M741

The VB-H761LVE-H, VB-H751LE-H, and VB-M741LE-H models are displayed in this software as VB-H761LVE, VB-H751LE, and VB-
M741LE respectively.

About the Latest Camera Firmware

You can find the latest firmware for cameras that are supported by this program at the Canon website.

Camera Video Sizes

Camera Category*! Video Size
VB-H45/VB-H730F Mk I1/VB-S30D Mk II/ 1080p - 480x270 960x540 1920%1080
VB-S31D Mk II/VB-S800D Mk I1/VB-S900F Mk 11/
VB-S30VE/VB-S800VE/VB-S910F/VB-R13VE/ 720p - 320x180 640%360 1280x720
VB-R13/VB-R12VE/VB-HE52LVE/VB-HB51VE/ 43 - 320240 6402480 1280%960

VB-H651V/VB-H761LVE-H/VB-H761LVE/
VB-H760VE/VB-H751LE-H/VB-H751LE/VB-S30D/
VB-S31D/VB-S800D/VB-S900F/VB-H43/
VB-H630VE/VB-H630D/VB-H730F
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Camera Category*’ Video Size
VB-M44/VB-5805D Mk 11/VB-S905F Mk I/ 720p - 320x180 640x360 1280x720
VB-M50B/VB-R11/VB-R11VE/VB-R10VE/
VB-M641VE/VB-M641V/VB-MB40VE/VB-M640V/ 43 - 320x240 640x480 1280x960
VB-M741LE-H/VB-M741LE/VB-M740E/VB-S805D/
VB-S905F/VB-M42/VB-M620VE/VB-M620D/
VB-M720F
VB-H41/VB-H6 10VE/VB-H610D/VB-H710F 320x240 480x270 960x540 1920x1080
VB-M40/VB-M60O0VE/VB-M600D/VB-M700F 160x120 320x240 640x480 1280x960
VB-C500VD/VB-C500D/VB-C60/VB-C300/VB-C50i/VB-C50iR/ 160x120 320x240 640x480 -
VB-C50FSi/VB-C50Fi

*1 Categories are switched on the camera’s Setting Page.
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Product Type and Number of Licenses

The number of cameras that can be added to a Storage Server Group depends on the specific software product.
The following table describes the number of licenses required for Storage Servers, Viewers, and RM Managers, as well as
the number of Storage Servers that can be configured as a Storage Server Group, for each product.

osM aiojog

Software No. of Storage Max. no. of cameras that can be added AUTILTIC Number of . ML)
Storage Server - ) licenses for RM
product Server groups to the Storage Server Group . Viewer licenses
licenses Manager
RM-64 1 64 1 1 1
RM-25 1 25 1 1 1
RM-Lite 1 4 1 1 1

About Licenses

Each software product includes one license key for the Storage Server and one license key for the Viewer. The number of
Storage Servers, Viewers, and RM Managers that can be installed with each license key is as follows.

Storage Server License Key

Allows you to install one Storage Server on one computer.

Viewer License Key

Each Viewer license key includes a single Viewer license and a single RM Manager license. Viewer and RM Manager
can be installed on the same computer or separately on different computers.

B Optional Licenses (Not Supplied)

Purchase additional licenses if necessary.

RM-V/RM-Lite-V

RM-V and RM-Lite-V are licenses for adding Viewers for RM-64/25/9 and RM-Lite, respectively.
These are required if you want to install Viewer on more computers than the number of Viewer licenses you currently
own.

Upgrade Licenses

The “Upgrade License 25 for RM-9” is a license for upgrading RM-9 to RM-25.
This upgrade allows you to increase the number of cameras that can be added to a Storage Server to 25.
The “Upgrade License 64 for RM-9” and “Upgrade License 64 for RM-25” are also available.
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Compatibility with Network Video Recorder VK-64/16/Lite

Notes on Installation

This software cannot exist with VK-64/16/Lite on the same computer. Do not install this software onto a computer

where VK-64/16/Lite is installed. You can install this software after uninstalling VK-64/16/Lite. However, please be

aware of the following:

e You cannot use the cameras and recording schedule settings you added with VK-64/16/Lite. You must add and
configure the cameras and schedules again.

e You cannot use the recording files and event information associated with VK-64/16/Lite.

e You cannot play back recordings made with VK-64/16/Lite.

e This software requires a computer with specifications that are higher than those required for VK-64/16/Lite. The
computer used for VK-64/16/Lite may not meet the operation requirements for this software.

Notes on Protocol Compatibility

This software is not compatible with VK-64/16/Lite protocols, because the protocol used between the Viewer and the
Storage Server has been significantly changed. Therefore, you cannot connect to a VK-64/16/Lite Storage Server
from the Viewer in this software. Similarly, you cannot connect to this software’s Storage Server from the Viewer in VK-
64/16/Lite.

Notes on Recording Data and Event Data Compatibility

This software uses event data and recording file formats that are different from VK-64/16/Lite. VK-64/16/Lite
recordings were able to be played back using QuickTime, however, the recordings for this software are not
supported by QuickTime.
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System Configuration Example

This software records video from cameras using an IP network, such as a LAN.

m Important

e The load on the Storage Server may increase depending on the number of cameras connected and the recording settings. Please refer
to “Determining the Capacity of the Storage Server” (P. 31) to consider your configuration.
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e Accessing one camera or Storage Server from many Viewers at the same time may affect system performance.

e Regularly check that the time setting is correct on the computers that are running the Storage Server, RM Manager, and the Viewer.
Also, before changing the time setting on the computers, be sure to first stop the Storage Server and Viewer. Please refer to “Stopping

the Storage Server” (P. 144) for details about how to stop the Storage Server.

Configuration Example 1: Install All on a Single Computer

This example shows the simplest system configuration, where the Storage Server, RM Manager, and Viewer are installed on
one computer. Video from the cameras is displayed or recorded using the same computer.

Storage Server Group

Storage Server/RM Manager/Viewer

[FE— 2=\

————  Network

& | —— % Video from the cameras
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Configuration Example 2: Storage Server and Viewers Installed
Separately on Multiple Networked Computers

You can separately install Storage Servers and Viewers on multiple computers on the network.

Storage Server Group

RM Manager/Viewer

o Network

Video from the cameras

......... » Recorded video

Configuration Example 3: Multiple Storage Servers and Viewers Installed

By setting up more than one Viewer, you can simultaneously view a video at more than one location.

RM Manager /

Viewer 1 Viewer 2 Viewer 10 Storage Server Group 1 Storage Server Group 5
iI m iI = =
(ST I (RS (ST I (RS (ST
A A A : :
S R I ) [ :
Network

— I I —L — —1l Video from the cameras
S — ~— g —
2 T g &

........ » Recorded video

It is possible to set up a monitoring system with a maximum of 512 cameras when using multiple Storage Servers.



System Design

Maximum System Configuration

The following table describes the maximum system configuration supported by this software.

Number of Storage Server Groups 16
Number of Storage Servers 16 (1 for each Storage Server Group)
Number of cameras 512 units (Maximum number of cameras that can be added to one Storage

Server Group is 64 when using RM-64)

Number of simultaneously connected Viewers 12 units
Number of cameras that can be used by a Viewer 512 units (same as the max. number of cameras)
Number of camera video that can be simultaneously 64 units

displayed by a Viewer

RM Manager 1

Determining the Capacity of the Storage Server

Refer to “Operating Environment” (P. 16), and configure a system that meets the requirements. Determine the capacity of
the storage server based on factors such as the number of recording cameras, video size, video quality, and recording
times.

B Hard disk capacity requirements

It is assumed that you use continuous recording at a fixed frame rate (number of frames per second), video size and
quality. The size of the recording data varies depending on the camera configuration (video quality and video size
settings). Also, the video data size used for calculating the recording data size may vary from the actual video.

You can determine hard disk capacity requirements using the Required Disk Space Calculator available on the
Canon website.

Determine the following factors beforehand when calculating the hard disk capacity.

e Number of cameras

e Video size, video quality, and frame rate of each camera

e Daily duration of recording

=] Note

* You can also use the Data Size and Bit Rate Estimates table found on the RM-64/25/9’s CD-ROM to perform calculations.
Instructions on how to perform the calculations are also included in the table.

e The Data Size and Bit Rate Estimates table can also be found on the Canon website.

Calculating Network Bandwidth

You need to consider the network bandwidth if you want to use a network camera for both recording and live view.

You must calculate the network bandwidth both for the Storage Server and the Viewer.

For example, calculate the bandwidth as follows if you use one Storage Server (320 x 240 1 fps) and two Viewers (320 x 240
5 fps): (When usingVB-H41)

¢ Bandwidth for recording
10.8 (KB/frame) x 1 (frames/sec.) x 8 (bits) = 86.4 Kbps

* Bandwidth for live view (per Viewer)
10.8 (KB/frame) x 5 (frames/sec.) x 8 (bits) = 432 Kbps

i
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Therefore, the required network bandwidth is calculated as follows:
86.4 Kbps x 1 + 432 Kbps x 2 = 950.4 Kbps (approx. 0.9 Mbps)

Notes on Storage Server Operation

We recommend that you dedicate the Storage Server computer exclusively to running this software.
Be sure to avoid the following on the Storage Server computer:

Running web server software on the computer

Operating the Storage Server on the same computer as a web server, such as Windows standard IS (Internet
Information Server) or Apache, may result in operational conflicts.

If coexistence of the Storage Server with another web service application on the same computer is unavoidable, be sure
to use different port numbers. The HTTP port number used by this software is 80 by default.

Running database server software (e.g., SQL Server, Oracle) on the computer
Database processing can place a load on the hard disk that may affect recording performance. Conversely, this
software may affect database server performance when it performs tasks that place a load on the hard disk.

Using the computer as a file server

The hard disk is frequently accessed when the computer is used as a file server, and this may affect recording
performance. In addition, the Storage Server is more likely to run out of disk capacity if the computer is operated as a file
server.

Running other applications on the computer

The additional processing load from running applications other than this software may affect recording performance.
This software uses TCP port numbers 80 (default) and 11080. Do not use the port number of the software for other
applications.



About RM-Lite

RM-Lite provides the same basic features as the RM-64/25/9 product versions, but some of the functionality is limited, as
described below:

m Important

¢ Files recorded using RM-Lite can be played back when an upgrade is made to RM-64/25/9. However, files recorded with RM-64/25/9
cannot be played back with RM-Lite.

¢ An RM-Lite viewer cannot connect to an RM-64/25/9 Storage Server. Similarly, an RM-64/25/9 viewer cannot connect to an RM-Lite
Storage Server.

Functional Limitations for RM-Lite

® You can add a maximum of four cameras.
* You can display a maximum of eight video windows in the Viewer. A warning message is displayed if you display nine or
more video windows.
e The maximum frame rate is as follows:
Recording: 5 fps (JPEG)
Record Now: 5 fps
e The frame rate adjustment feature is always enabled under high load. You cannot disable it.
e The maximum file size is fixed at 1 GB (max. 24 hours) and cannot be changed.
e You cannot change the [Background] property in [Layout Properties], and live view is the only playback option.
e You cannot configure [Each Tag], [All Cameras] and [Recording Cameras] in [Organize Layouts].
e AXIS Q7404/Q7401 is not supported.

Features that Cannot Be Used in RM-Lite

Storage Server

e MPEG-4 and H.264 recording

* Motion detection recording

e Sensor recording

¢ |Intelligent function recording

¢ Volume detection recording

e Special day schedule recording
e Scream detection recording

* Linked event recording

RM Manager

e Simultaneous connection to multiple Storage Servers

e Sending e-mail when an event occurs

e Customizing event priority

e Adding user groups and configuring access permissions
e Importing and exporting of recording schedules

e (Camera search when setting the recording schedule

e Backup and restore of the settings

e Changing the IP address of the recording server

e Changing the license

e Time refresh of the recording server

e Setting the camera tag

e Setting the pre-event recording and the post-event recording

i
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Viewer

e Simultaneous connection to multiple storage servers
e Multiple display support

e | ayout sequences

e Display of multiple main windows
e Display of multiple tabs

e Custom grid

e Dynamic layouts

e Searching using camera tags

e Advanced search feature of event search

e Event Notification - Operator Notification, Acknowledge Event
e Display of a video window when an event occurs.
e Callout Window function

Comparison of Main Specifications for RM-64/25/9 and RM-Lite

Features

RM-64/25/9

RM-Lite

Connection to
camera

Max. number of cameras for each
Storage Server

64/25/9 units

4 units

Supported cameras

Based on “Supported Cameras”

Based on “Supported Cameras”

Storage Server

(P. 24) (P. 24)
AXIS Q7404/Q7401
Automatic camera search Available
Recording formats JPEG, MPEG-4, H.264 JPEG only
Max. recording frame rate 30 fps *' 5 fps

Recording schedule

Weekly schedule recording
Special Day schedule recording

Weekly schedule recording

Recording mode

Continuous recording

Sensor recording

Motion detection recording
Intelligent Function recording
Volume detection recording
Scream detection recording
Linked event recording

Record Now (Manual recording)

Continuous recording
Record Now (Manual recording)

Max. file size setting

Configurable 512 or 1024 MB, 1 to
24 hours (default: 1024 MB)

Fixed 1 GB (1024 MB), 24 hours

Max. storage period 99 weeks 90 days (12 weeks)
Viewer Supported live view formats JPEG, MPEG-4, H.264

Max. display frame rate 30 fps *!

Multiple display support Available -

Number of simultaneous video
windows

32 or fewer per Iayou’[*2

(of these up to 12 can be H.264 video
windows and up to 6 can be MPEG-4
video windows or simultaneous
H.264/MPEG-4 video windows)

8 or fewer is recommended.

Audio recording/playback

Available

Layout sequence feature *3

Available

*1  The operational limits depend on factors, such as the number of cameras, Storage Server performance, hard disk
capacity, and network load.

*2  The maximum number of dynamic layout video windows that can be displayed is 25.

*3 The layout sequence feature is a function for changing Viewer layouts at a specified interval.




The process from preparation before introducing the system, to operation is shown below.

osM aiojog

Step 1 Prepare for Introducing the System

Consider the video storage period and recording conditions, determine the hard disk capacity required for recording and
prepare the equipment.

Please refer to “Chapter 1 Before Use” for system design.

Step 2 Install the Camera

Set up your cameras for live video display or recording.

Please refer to your camera manuals.

Step 3 Installation

Install this software product on your computer.

Please refer to “Chapter 2 Installation”.

Step 4 Set Up the Storage Server

Add cameras to the Storage Server, configure disk space management settings for operation, and add users.

Please refer to “Chapter 3 Storage Server Setup” and “Chapter 4 System Management With RM Manager”.

Step 5 Check Video in the Viewer

Connect the Viewer to the Storage Server Group and check video.

Please refer to “Chapter 6 Monitor Video with the Viewer”.

Step 6 Configure the Viewer

Customize the Viewer. You can save a layout to monitor video in a customized Viewer for subsequent sessions.

Please refer to “Chapter 7 Viewer Settings”.

Step 7 Set a Recording Schedule

Configure automatic recording settings such as recording conditions and schedules.

Please refer to “Chapter 5 Setting a Recording Schedule”.
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Day-to-Day Operation

e Monitor video in the Viewer, check events, and play back recorded video.
Please refer to “Chapter 6 Monitor Video with the Viewer”.

e (Check system status.

Please refer to “Chapter 4 System Management With RM Manager”.

e Back up recorded files.

Please refer to “Chapter 8 Backup”.

e FError messages and problems.

Please refer to “Chapter 9 Troubleshooting”.



Chapter

Installation

This chapter explains how to install this software. Precautions for updating and uninstallation are also
explained.
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How to Install the Software

Follow the steps below to install this software.

Installation Procedures

™ Important

* You must log on to the computer as a computer administrator to install this software.

e Stop other applications that are running on the computer, such as anti-virus software, before installing the software.
1 Insert the installation CD-ROM into the CD drive.

This starts the installer automatically. If the installer does not automatically start, open the CD-ROM directory
using Windows Explorer and double-click RM45setup.exe.

=] Note

e When the [User Account Control] dialog box appears, click [Yes] or [Continue].

e On computers running Windows 7, Windows Vista or Windows Server 2008, if .NET Framework 3.5 is not installed, a dialog box is
displayed asking you to install .NET Framework 3.5. Click [Install] to install .NET Framework 3.5.

e Obtain the installer from the Canon website, and double-click RMLitelnstall.exe.

e NET Framework 3.5 SP1 is not automatically installed. If a window requesting installation appears, first download and install it
from the Microsoft website.

.NET Framework 3.5 SP1 can also be installed from the software installer included with the Canon network camera.

2 Click [Next].

#) Canon Network Video Recording Software RM Series =i - Install... EX

Welcome to the InstallShield Wizard for Canon

Network Video Recording Software RM Series
=i N

The Installshield(R) Wizard will install Canon Network Video
Recording Software RM Series « § I on your computer, To
continue, dick MNext.

WARNING: This program is protected by copyright law and
international treaties.




3 Read the license agreement carefully. Click [| accept the terms in the license agreement], and then click [Next] to

continue.

N

1) Canon Network Video Recording Software RM Series =i - Install... “

License Agreement

Please read the following license agreement carefully.

uonejeisu]

Please be sure to read this Software Usage Agreement before using the ~
software.

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT: PLEASE READ THIS DOCUMENT BEFORE INSTALLING
THE SOFTWARE.

Y. I o RERL, (AP CR SV S—_p-

()1 do not accept the terms in the license agreement

Installshield

| <gak | dext> || Cancel

4 Enter your license key(s) and click [Next].

Enter the license key(s) for installing the software (Storage Server and Viewer. The Viewer also includes RM
Manager). To install just one of these programs, enter the license key for the corresponding software only, and

click [Next].

1) Canon Network Video Recording Software RM Series =i - Install... “

Customer Information

Flease enter your information.

Storage Server License Key @

Viewer License Key :

Installshield
- I
Instead of a screen for license key entry, a screen appears for entering the user name and department. Click
[Next].
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5 Select the program to install and click [Next].

ﬁ! Canon Network Video Recording Software RM Series i+ - Install... “

Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description
= ~ | Storage Server
= ~ | RM Manager

This feature requires 71MB on
your hard drive.

Install to:
C:\Program Files (x88)\Canon\Webview\MVR30Y Change...
Installshield
Help Space < Back . Mext = Cancel

You can configure the software so that only certain parts of programs are installed. Select which programs not to
install. Click the application that you do not want to install and select [This feature will not be available].

If you entered the license key for Storage Server in step 4 proceed to step 6. If you entered the license key for a
Viewer only, proceed to step 7.

A dialog box for specifying the software to be installed is displayed. If you click [Complete], proceed to step 6. If
you click [Custom], the same dialog box as above appears.

=] Note

¢ You can click [Change] to change the destination folder. However, we recommend that you do not change the destination.

* To check the available disk space on each drive of the computer and the disk space required for installation, click [Space].

If you have configured settings so the Storage Server is not installed, click [Next] and proceed to step 7.

6 Select the [Add storage server programs to the Windows Firewall exception list.] check box and click [Next].

| B
1) Canon Network Video Recording Software RM Series = - Install... .~

1P Selection and Firewall Settings

Select the network adapter and IP address to be used by the storage

Metwork adapter:

Ethernet W
IP address: Port :
1192.168.100.11 W a0

To construct systems using multiple computers, the Windows Firewall exception list must be
changed.

[ Add storage server programs to the Windows Firewall exception list,

* If your computer is protected by programs other than Windows Firewall, those settings must
be changed individually.

Installshield

< Back

Cancel

=] Note

e When installing on a computer that has multiple network interfaces, select the network interface to use in the [Network adapter]
list and the assigned IP address in the [IP address] list.

e The IP address selected here is the IP address specified for connecting to the Storage Server Group with the Viewer.

¢ When changing the port number, make sure that the new port number is not being used by another application.



7 Click [Install].

8 Canon Network Video Recording Software RM Series s - Install. Il |

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back, Click Cancel to
exit the wizard.

Installshield

| <pak || sl | cancel

g Click(Finish].

8 Canon Network Video Recording Software RM Series s - Install. Il |

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Canon
Metwork Video Recording Software RM Series « B B, Click Finish
to exit the wizard.

Cancel

9 Click [Yes] to restart the computer.

5 Canon Network Video Recording Software R IRl |

changes made to RM Series = | to take effect. Click

@ ‘You must restart your system for the configuration
‘Yes to restart now or Mo if you plan to restart later.

o |

The Viewer and RM Manager launch icon appears on your desktop when the installation is complete.

(=] Note

A launch icon for the Storage Server will not appear. This Storage Server starts automatically.

Upgrade from an Earlier Version

When upgrading, use the installer of the new version to install the new version on top of the earlier version without
uninstalling the earlier version. This preserves the settings such as the added camera information and recording schedule,

and recorded data.
Note that if you uninstall the earlier version before installing the new version, you will need to redo all of your camera and

recording settings.

N

uonejeisu]
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m Important

e Before upgrading or reinstalling the software, be sure to create backups of the recording settings and recorded data. For details on
backup, please refer to “Chapter 8 Backup”.

e Before upgrading the software, verify that RM Manager and Viewer are not connected to the Storage Server.

(=] Note

* The license key included with the earlier version must be entered when upgrading.
e Some functions from Viewer v3.2 and earlier have been moved to RM Manager.

e Both v3.2 and earlier and v4.5 cannot be installed on the same computer.

Upgrade from RM-Lite to RM-64/25/9

Installing RM-64/25/9 on a computer where RM-Lite is installed will upgrade it to RM-64/25/9. This preserves the settings
such as the camera information, recording schedule, and recorded data.

E Note

RM-Lite cannot co-exist with RM-64/25/9 on the same computer.



N

Settings After Installation .

Configure the following settings after installing this software according to the operating system you are using.

uonejeisu]

Windows Firewall Settings

If you install the Storage Server and the Viewer on different computers, you must change the Windows Firewall settings on
the computer used for the Storage Server.

During installation, select [Add storage server programs to the Windows Firewall exception list. ] to complete settings. If you
did not select the above check box during installation, perform the following procedure to change the Windows Firewall
settings.

The following settings are not required if you install the Storage Server and Viewer onto the same computer.

B When using Windows 7, Windows 8, Windows 10, Windows Server 2008
R2, or Windows Server 2012

1 Click [System and Security] in the [Control Panel], and then click [Windows Firewall].

2 Click [Advanced Settings] to display the [Windows Firewall with Advanced Security] window.

3 Click [Inbound Rules] and select [New Rule] from the [Action] menu to start the [New Inbound Rule Wizard].
4 Click [Port], and then click [Next].

5 Click [TCP] and [Specific local ports], enter the port number configured during installation (default: 80), and then
click [Next].

Click [Allow the connection], and then click [Next].
Click [Next].

Enter a name (such as the Storage Server or Storage Server Group name) in [Name] and click [Finish].

© 00 N O

The added inbound rule should be displayed in the [Windows Firewall with Advanced Security] window, with a
checkmark icon displayed next to the rule.

B When using Windows Vista or Windows Server 2008

1 Click [Start] > [Control Panel] to open the [Control Panel].

2 Click [System Security] > [Windows Firewall].

If the [Control Panel] is set to [Classic View], double click [Windows Firewall].
3 Click [Change settings].

If the [User Account Control] dialog box is displayed, click [Continue].

Click the [Exceptions] tab and click [Add Port].

5 In the [Add a Port] dialog box, enter the name of the Storage Server and the port number configured during
installation (default: 80). Make sure that [TCP] is selected before clicking [OK].
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Confirm that the added Storage Server is now displayed in the [Windows Firewall] dialog box and that the check
box is selected. Then, click [OK].

Security Level Setting

When the security levels for internet sites and intranet sites are set to [High], settings in the top page of the camera or the
Setting Page cannot be configured. Follow these steps to register the page as a trusted site.

1 Click [Network and Internet] > [Internet Options] in the [Control Panel].

2 Click the [Security] tab.

3 Click [Trusted Sites] and click [Sites].

4 Clear the [Require server verification (https:) for all sites in this zone] check box.

5 Enter the IP address of your camera in [Add this website to the zone] and click [Add].

=] Note

JavaScript may be disabled in the standard security setting, even if a content block dialog box is not displayed. This may limit the
operation of the setting page or the camera’s Viewer. The JavaScript setting is enabled automatically once trusted site registration
is complete.

Sound Settings for Using the Audio Feature

The sound feature is disabled by default in Windows Server 2012, and 2008. To receive audio with the camera’s Viewer,
follow these steps to enable the sound feature.

1 Click [Hardware and Sound] in the [Control Panel] and then click [Sound].

If the [Control Panel] in Windows Server 2008 is set to [Classic View], double-click [Sound] and proceed to step
3.

2 If the [Audio Service Not Running] dialog box is displayed, click [Yes].

3 The [Sound] dialog box is displayed. Select the [Playback] tab and confirm that an appropriate audio device is
installed.

If no audio device is installed, refer to the manual for your computer on how to install an audio device.



Chapter

Storage Server Setup

This chapter explains Storage Server setup and how to add cameras using RM Manager.
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Connect RM Manager to the Storage Server

Launch RM Manager to connect to the Storage Server Group.

[ Important

* You must log on to the computer as a computer administrator to launch RM Manager.

e |tis strongly recommended that only one administrator configure the Storage Servers.

¢ Before configuring settings for the Storage Server, check to make sure that other users are not connected to the Storage Server with

Viewer or RM Manager.

1 Double-click the [RM Manager] icon on your desktop.

RM Manager starts.

RM Manager

=] Note

When the [User Account Control] dialog box appears, click [Yes] or [Continue].

Right-click the [Storage Server Search Results] tab (P. 57) in the Storage Server, and then click [Connect to

Storage Server Group].
Or Click [File] > [Connect to Storage Server Group].

e

- - Canon Network Video Recording Software RM Manager
File Settings Tools Help

Storage Server Search Results

Hast Name (Storage Server)

4645
nect to Storage Server Group. 3

Disconnect from Storage Sen

Change IP Address...

[tatus ~ [cPUUsage () Memory Usage (MB) Desired Frame Rate (fps) |Actual Frame Rate (fps) |Available Disk Spad

= I

The [Connect to Storage Server Group] dialog box appears.



3 Enter the password in [Password] and click [Connect].

Leave the user name as “administrator”. The default administrator password is “NVR”.
For the port number, enter the port number configured during installation (default: 80).

= Connect to Storage Server Group

W

Please enter the connection settings for the storage server group you
want to connect to.

Storage Server Group

2]

Host Name: | 192.168.100.11 Port: |80 15
o

User Name: |administrator (8
%)

Password : (‘2D
Remember user name ]

2]

@

c

Use Group Name Connect ©

Connect to the Storage Server. Information for the connected Storage Server Group appears in the [Tree View]
tab.

B - 5501 - Canon Network Video Recording Software RM Manager = =

File Settings Tools Help

cpu Usage (35) Memory Usage (MB) Desired Frame Rate (fps)  |Actual Frame Rate (fps) |Available Disk Spad

B! 5501 (administrator} Running

Storage Server Search Results

192.168.100.11 RM6455 Connected
192.168.100.12 RM64SS

™ Important
e You should change the password for the default user (administrator) as a security measure. For details on how to change the
password, please refer to “Change the User Information” (P. 61).

® Be sure to remember your password.

E Note

When there is a time difference of five seconds or longer between the Storage Server and the RM Manager computer, a message
prompting you to synchronize them will appear. Adjust the system time of the RM Manager computer to the time of the Storage
Server. You can disable the message display in [RM Manager Settings].
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Start Recording Immediately After Registering a Camera

By configuring settings before registering a camera, you can start recording with the following settings immediately after the
camera is registered.

Recording conditions | Description

Recording time Continuous recording 24 hours per day
Video format JPEG
Maximum frame rate |3 fps

320x240, 320x180, 480x270
(configured automatically based on camera'’s [Video Size Set] setting)

Video size

Audio recording None

1 Click [Settings] > [RM Manager], and display the [General] tab in the [RM Manager Settings] dialog box.

2 Select the [Start recording when the camera is registered] check box.

i RM Manager Settings

General Event Notification Event Display
| Time Out-of-Sync Warning
Send notification when time is out-of-sync with the storage server group

Automatic recording settings
Start recording when the camera is registered

g Click[OK].



Add a Camera

You can add a camera to be used for displaying video or recording to a Storage Server.

=] Note

The number of cameras you can add to a Storage Server depends on the version of this software product.

You can add a maximum of four cameras.

W

Display the [Cameras] Tab

dnias Janiag abelols

Click [Settings] >[Cameras], and display the [Cameras] tab in the [Settings] dialog box.

Settings [~ |
Storage Server Group : issm -|
 Cameras | Servers | Users |

Camera Name = Camera Type Host Name Port Tags

Find. |[ Add.. || Edit. |[ Remove |

=] Note

When connected to multiple Storage Server Groups, select the Storage Server Group to add a camera to. The Storage Server Group to add
cameras to can be changed in the [Cameras] tab’s [Storage Server Group] option.

Add Cameras One at a Time

Add cameras one at a time to the list of cameras on the [Cameras] tab.
1 Click [Add].

The [Add Camera] dialog box appears.
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2 Enter the information required to add the camera.

I B Add Camera
(1) —— Host Name: Port: |80 (2
(3) ——— User Name:
(4) ——— Password :
(5) — Storage Server Group: | 5501 “
(6) — Tags:

(1) [Host Name]
Enter the host name or IP address of the camera.
(2) [Port]
Enter the port number for the camera. Typically, leave [80] unchanged.

(8) [User Name]
Enter the user name for the camera.

(4) [Password]
Enter the password for the user specified in (3).

(5) [Storage Server Group]
Display the appropriate Storage Server Group name.

(6) [Tags]
Add camera tags. Click the [Edit] button to open the [Edit Tags] dialog box, and select tags from [Tags].
Adding camera tags ahead of time lets you search for and specify cameras by their tags.
Click the [Edit] button to create new camera tags. Created tags can also be used for other cameras
connected to the same Storage Server.

g Click [OK]

Close the [Add Camera] dialog and the cameras are added to the camera list in the [Cameras] tab.

C50F

Video from a camera connected to a multi-terminal VB-EX50 cannot be displayed live or recorded by this software.

m Important

e Enter the camera’s user name and password in [User Name] and [Password].

e |f the host name or IP address of the camera is changed after registration, you must also change the Storage Server setting. For
details, please refer to “Change Camera Information” (P. 51).



Search For and Add Cameras

You can search for cameras that are on the same network as the Storage Server.

{ Click[Find]
The cameras on the subnet are displayed in the [Camera Search Results] dialog box. 3
3 Camera Search Results S
2]
Camera Name Host Name Type Register o
D i Canon VE- g
O Canon VEB- g
O §. Canon VB-I ]
[ Camera L Canon VB- IS 5
[ camera Canon VB- 2]
| Cancn VB-= g
[ camera u Canon VB- ©
[ camera & Canon VB-=4
[ Camera Canon VB-& 5K
[ camera Canon VEB-#
[ camera Canon VB-

2 Select the check boxes for cameras to add.

You can add more than one camera by selecting multiple check boxes.
To select all the cameras, click [Select All].

3 Click [Add].

The [Add Camera] dialog boxes for the cameras selected in step 2 are displayed in the order of the [Camera
Search Results] list (from top to bottom).

Enter the information required to add the camera, referring to step 2 in “Add Cameras One at a Time” (P. 49).

Click [OK] to close the dialog box.

o o1 &

Repeat steps 4 and 5.

7 When you finish adding cameras, click [Cancel].

=] Note

® You can only connect to cameras that are located on the same subnet as the computer on which RM Manager is installed. For
details on how to add cameras on a different subnet, please refer to “Add Cameras One at a Time” (P. 49).

e The names of the cameras (stored on the camera) are displayed in the list in the [Camera Search Results] dialog box. However,
the VB-C300 camera name is not displayed.

Cameras that have already been added are also found. However, a check box is not displayed next to the camera.
e |f you cannot find the camera you are searching for, please refer to “Add Cameras One at a Time” (P. 49) and add the camera.

e Host names or IPv4 addresses are displayed in the [Host Name] column of the [Camera Search Results] dialog box. (IPv6
addresses are not supported.)

Change Camera Information

You can change the camera registration information,
1 Select the appropriate camera and click the [Edit] button.

Camera properties are displayed.
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2 Change the camera Information.

[General] tab

Set the camera name. The camera name is only used by this software. The camera name stored on the camera is
not changed.

Click the [Update] button to change thumbnail images.

Click the [Edit] button to specify camera tags.

[Advanced] tab
Click [Disable Camera] and change the [Connection Settings] as necessary. To enable the camera after
changing settings, click [Enable Cameral].

3 Click the [Apply] button to apply changes to registered information, and then click the [OK] button.

Remove a Camera

This action removes a camera added to the Storage Server.

™ Important

If you remove a camera, you will no longer be able to play back recordings made with the camera. If you need to play back the
recordings, use [Disable Camera] instead of removing the camera.

1 Select a camera in the list of cameras on the [Cameras] tab.

2 Click [Remove].
A message appears, asking if you want to remove the camera.

3 Click [Yes].



Chapter

System Management With RM Manager

RM Manager is used for system management of this software. With it, you can manage users, cameras, disk
space, and add recording schedules.
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RM Manager Functions

RM Manager consists of four upper tabs ([Tree View], [Cameras], [Storage Server], [Users]), three lower tabs ([Storage
Server Search Results], [Activity Log], [Live Events]), and menus.

[Tree View] Tab (P. 55)

[Cameras] Tab (P. 55)

[Storage Server] Tab (P. 56)
Menus (P. 58) [Users] Tab (P. 56)

2 J - 5501 - Canon Network Video Recording Software RM Manager = =
Help

File Settings Tools

status |CPU Usage (%) Memory Usage (MB) Desired Frame Rate (fps)  |Actual Frame Rate (fps) | Available Disk Spal
00 000

5501 (administrator) Running
8.100.11 Running 0.00 18027 X 0.00
0.00
Idle 000
Camera Idle X 0.00
Camera Idle X 0.00

Camera Idle X 0.00

e e

RM64SS Connected
RMB455

[Storage Server Search Results] Tab (P. 57)
[Activity Logs] Tab (P. 57)
[Live Events Log] Tab (P. 58)



[Tree View] Tab

This tab displays in a tree the Storage Servers connected to RM Manager, the destination drive for recording files, and

registered cameras.

-

B 5501 (administrator)

2.168.100.11

Camera

Camera

Running

Running

0.00

- 5501 - Canon Network Video Recording Software RM Manager

179.69

T = [T

|

e ot
00 0.00

00
00

0.00
000
0.00
0.00

126.64

126.64

AN

Camera

Camera

Cameras appear under the storage drive. You can check Storage Server and camera status.
Red: Error

Jabeue INH YUM Juswabeuely walsAs

File [set]i Tools

Trei| Vils

Help

Tree 'liey] Tags Status

Green: Normal

[Cameras] Tab

Displays cameras registered to Storage Servers connected to RM Manager in a list. Information such as the camera model
name, host name (or IP address), registered Storage Server Group, and camera status are displayed. Display items can be
rearranged and filtered.

3 - 5501 - Canon Network Video Recording Software RM Manager = =

|
0

Canon VB-R11 192.168.100.141 5501 Idie 0. 0.00 0.00 0.00
Canon VB-M641VE 192.168.100.143 5501 Idle 00 0.00 0.00 0.00

Canon VB-M640V 192.168.100.146 5501 Idle 00 0.00 0.00

lIlCamem Canon VB-M741LE 192.168.100.147 5501 Idie 00 0.00 0.00
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The following items appear in [Status], showing the current connection status between the camera and the recording

server.
[Status] display Meaning

Recording Recording video

Monitoring Due to motion detection or pre event recording schedule, the Storage Server is monitoring a

camera.

Connecting Establishing a connection between the Storage Server and camera.

Idle The Storage Sever is connected to the camera.

Disabled The Camera is disabled.

Error The Storage Server is failing to connect to the camera.

Unlicensed g;?vr;mber of connected cameras exceeds the number of licenses for the installed Storage

[Storage Server] Tab

You can check the operating status and available disk space of Storage Servers connected to RM Manager. Display items
can be rearranged and filtered.

|

&l - 5501, 5502 - Canon Network Video Recording Software RM Manager

RIS ES e Toas ek
Host Name (Storage Server) [+ | | Storage Server Group [*] CPU Usage (%) [*] | Recording Bitrate (kbps) [+] | Playback Bitr.. [v] | Registered Cameras ] | Memory Usage
0.00 4

192.168.100.11:80 Running 0.00 0.00
192.168.100.12:80 Running 0.00 0.00

179.99
0.00 4 17275

[Users] Tab

Users connected to the Storage Server appear here. You can check who is connected to a Storage Server and from what
location. By default, names are displayed by user name order. You can make it easier to check Storage Server access
status by rearranging names by Storage Server and filtering which Storage Servers are displayed.

3 - 5501, 5502 - Canon Network Video Recording Software RM Manager
File Settings Tools Hel

User Name [ | User Group [*] | ciient Version [¥| | Host Name (Storage Server [*] | storsge Server Group [~]

5501 Connected  RM Vi
5502 Connected  RM Manager

administrator

5501 Connected  RM Manager

administrator Administrator

Total: 3




[Storage Server Search Results] Tab

Regardless of whether or not they are connected to RM Manager, active Storage Servers in the same subnet are displayed
in a list. Right-click to connect/disconnect Storage Servers from RM Manager. When connected, the Storage Server also
appears in the upper section.

Storage Server Search Resul

192.168.100.11 6. Connected

192.168.100.12 Rl Connected

AN
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[Activity Logs] Tab

Logs of user operations for Storage Servers from RM Manager or the Viewer are displayed here. You can filter the display
by Storage Server Group or type of operation. Activity logs can be exported as files by clicking [File] > [Export Activity Log].

L L S N
User Operation Viewer has been connected: RM Manager 192.168.100.11
User Operation Viewer has been connected: RM Manager 192.168.100.11
User Operation User has been added: addministrator
User Operation Viewer has been connected: RM Viewer 192.168.100.11
User Operation Shared layout has been added: 10
User Operation Shared layout has been added: 11
User Operation S| ut has been added: 12
User Operation has been added: 13
User Operation Shared layout has been added: 14

User Operation Shared layout has been added: 15
User Operation Shared layout has been added: 16
User Operation Shared layout has been added: 17
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[Live Events Log] Tab

Events are displayed here. Display items can be rearranged and filtered. Event information is similarly displayed in the
Viewer's [Live Events Log]. You can configure the event levels and types in the [RM Manager Settings] dialog box by
clicking [Settings] > [RM Manager].

5 | Live Events Log

e N T ) S 1
est 1 PM

Menus

The following menus are available in the RM Manager menu bar.

M [File] menu

[Connect to Storage Server Group]
Connects to the Storage Server Group.

[Disconnect From Storage Server Group]
Disconnects from the Storage Server Group.

[Export Activity Log]
Logs displayed in the [Activity Logs] tab are saved as files.

[Exit]
Shut down RM Manager.

B [Settings] menu

Opens various dialog boxes and lets you configure various settings for Storage Server Groups connected to RM
Manager.

[Cameras]
Displays the [Cameras] tab in the [Settings] dialog box. You can add cameras to the Storage Server (P. 49).

[Storage Server]
Displays the [Storage Server] tab in the [Settings] dialog box. You can configure settings for recording file destination
drive and storage period (P. 67, P. 68).

[Users]
Displays the [Users] tab in the [Settings] dialog box. You can add users to the Storage Server Group and change
passwords (P. 60).

[Storage Server Group]
Displays the [Storage Server Group Settings] dialog box. You can configure the priority level for each event and
configure the e-mail notification function for when events occur.

[RM Manager]
Displays the [RM Manager Settings] dialog box. You can configure the event level that appears in the [Live Events
Log] tab and the level and method of notification for notifying operators of events.



[Tools] menu

[Recording Schedules]
Displays the [Recording Schedules] window. You can configure recording schedules (P. 74).

[Tags] (RM-64/25/9

Displays the [Tag Settings] dialog box. You can add, change names, and delete tags here.

[Backup/Restore Configuration]

Backs up or restores settings data for Storage Servers, registered cameras, recording schedules, etc. By backing up
settings before editing them, you can restore to a previous state even after changing the settings.

To back up settings, select the backup destination folder in the [Backup] tab, and click [Start Backup]. A folder with
a name that starts with “NVR30” will be created in the specified folder, and the backup files and folders will be stored
in the folder.

To restore settings, select the folder with the name that starts with “NVR30” that was created during backup in the
[Restore] tab, and click [Start Restore].

[ Important

* Recorded video, event data, and server log data will not be backed up. For details on preparing for system or equipment
failures, please refer to “Chapter 8 Backup” (P. 141).

¢ Restoring backed up settings data returns the state of camera registration and various settings to that at the time of backup. Be
aware that recorded video and events for cameras added after the backup procedure will not be viewable. We recommend
performing backup again after registering new cameras.

[Change IP Address] (RM-64/25/9
Changes the IP address set in the Storage Server. If the IP address of the Storage Server computer changes, the IP
address settings must also be updated (P. 165).

[Change License] [RM-64/25/9
If, for example, you upgrade from RM-9 to RM-25 or from RM-25 to RM-64, you can change the license when a new
one has been obtained (P. 167).

[Reset Servers Reference Time]

Synchronizes the Storage Server service time and the Storage Server computer time. Because this is adjusted
periodically under normal circumstances, there is no need to use this option. Please only use this option if the
Storage Server computer time is significantly affected, such as when changing time zones.
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Add a User

In addition to the registered administrator, new users can be added, and operation can be split between administrators and
guest users.

About User Groups

This software provides the following two user groups, each with different user permissions.

Administrator

All Viewer and RM Manager operations are available.

Operator (Guest user)

Users in this group have limited access to the features of the Viewer. They cannot configure RM Manager or set a
recording schedule.

You can specify the group to which the added user belongs by selecting from [User Group].
You can create a new user group and specify permissions for users that belong to the group.

[ Important

e Only a default user called “administrator” is created in the Administrator user group.
The password for this user is “NVR”. We recommend that you change the password for this user after installation.
We strongly recommend that, for normal surveillance operation, you create individual users with access permissions for only the
minimum required functionality.

* Please be sure to remember your password.

You cannot add user groups.

E Note

Administrator for this software program does not refer to the Windows administrator.

Display the [Users] Tab

Select the appropriate Storage Server, click [Settings] > [Users], and display the [Users] tab in the [Settings] dialog box.

Add a User

Specify user groups and add new users. Up to 24 users can be added.

{ Click [Add].

The [Add User] dialog box appears.



2 Enter the information required to add the user.

B Add User B
User Name : I 1)
Password : (2)
Confirm Password : (3)
User Group: Administrator (4)

oK Cancel

(1) [User Name]
Enter the name of the user to be added.

(2) [Password]
Enter the password used to log into the Viewer.

(8) [Confirm Password]
Enter the password in (2) for confirmation.

(4) [User Group]
Select the user group (“Administrator” or “Operator”).
You can also select an added user group. For details, please refer to P. 62.

g Click [OK]

The [Add User] dialog box closes and added users appear in the user list on the [Users] tab.

Change the User Information

You can change settings for registered users. Passwords can be changed here.

1 Select a user in the list.

2 Click [Edit].
The [Edit User] dialog box appears.

3 Change the user information.

=] Note

The “administrator” user name and user groups cannot be changed.

Remove a User

You can remove registered users.

E Note

You cannot delete the default “administrator” user.

1 Select a user in the list.

2 Click [Remove].
A message appears, asking if you want to remove the user.

3 Click [Yes].

AN
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Add a User Group and Specify lts Access Permissions RM-64/25/9

You can create additional user groups and specify access permissions for the group.
In the [Settings] dialog box, click the [User] tab and click [User Group Settings] to display the [User Group Settings] dialog
box.

G | User Group Settings
User Groups:

Administrator

Operator

| Add... Remove I (2)

Permissions for Administrator:

® Full Control (3)
Partial Control

RM Manager
| View Recording Schedules All Cameras
+/| Edit Recording Schedules
/| View Storage Server Group Settings = (4)

+| Edit Storage Server Group Settings
| Edit Cameras
+| Edit Users and Groups

Close

(1) List of user groups
Displays a list of existing user groups.

(2) [Add], [Edit], and [Remove]
Add, edit or remove a user group.

E Note

® You cannot edit or remove the “Administrator” and “Operator” user groups.
e Up to 12 groups can be added.

(8) [Full Control]
Assign all access permissions for the selected user group.

(4) [Partial Control]
Specify individual access permissions for the selected user group.

B Specify Individual Access Permissions

Click [Partial Control] and select the check boxes next to the desired access permissions for each feature.

RM Manager
| View Recording Schedules All Camerss ——— Selected camera tags

+/| Edit Recording Schedulel:

| View Storage Server Group Settings
+/| Edit Storage Server Group Settings
| Edit Cameras
+| Edit Users and Groups

Viewer

+| View Live Video Ali Cameras
/| Control Cameras
/| Send and Receive Audio|
/| Record Now

/| Playback Recorded Video All Cameras

/| Extract Video
/| Play Recorded Audio

/| Use Shared Layouts

] Edit Shared Layouts Access permissions for each feature

| View Viewer Settings

| Edit Viewer Settings
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Select the check box next to a feature to enable operation of the feature.

Camera tags are only displayed for [View Recording Schedules], [View Live Video], and [Playback Recorded Video]. Click
a tag to display a dialog box for specifying camera tags to narrow down the cameras to which the access permissions will
be assigned.
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Notification of Events by E-mail

You can configure settings so that an e-mail notification is set when an event occurs. You can set event priority levels ahead
of time and change e-mail destinations according to the priority.

=] Note

For details on e-mail notification content when an even occurs, please refer to “Appendix: Check Event Notification E-mail” (P. 163).

Display the [Event] Tab

Select the appropriate Storage Server, click [Settings] > [Storage Server Group], and display the [Storage Server Group
Settings] dialog box. Click the [Event] tab.

Configure Event Priorities and E-mail Notifications

Configure event priority levels, e-mail destinations, and e-mail server settings.

B Storage Server Group Settings “

Storage Server Group @

5501

| .F{ecurding Seﬂ[ngsi Event |

]

Delete recorded files (when disk space is low) . High
Recording Faulted or Restarted

{amera Communicatinn Frror

E-mail Notification : (1 )
E-mail Address  Priority

| @)

Edit.. 1| Remove | | @ (3)

Event Priorities : (4)
. Manual Recording W Highest

Recording Started or Stopped W Lowest C

Recording Frame Rate Changed W Highest
Low Disk Space Waming [ Medium

W Highest

Bl Highest

[ ok -|I| Cancel |

(1) [E-mail Notification]
Display a list of e-mail addresses for sending notification messages when an event is triggered, and the priority of the

event.

(2) [Add], [Edit], and [Remove]

Add, edit or remove an e-mail notification recipient.

(3) [Mail Server Settings]
Configure the mail server used for notifications.

(4) [Event Priorities]

Configure the event priorities. You can configure priorities in five levels: Highest, High, Medium, Low, Lowest.
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B Configure the Mail Server

1 Click [Mail Server Settings].

The [Mail Server Settings] dialog box is displayed.

2 Configure the mail server settings.

3 Mail Server Settings _
Mail Server
| SMTP Server: [Smip Port: 23 I"— (1)
| Authentication : | None . I___ (2)
| User Name : ]"_ (3)
| Password : I"— (4)
| POP Server: Port : I"— (5)
| OK || Cancel |
(1) [SMTP Server] and [Port]
Enter an SMTP server name and change the port number, as required.
(2) [Authentication]
Specify an SMTP server authentication method ([None], [POP before SMTP], [SMTP-AUTH]).
(8) [User Name]
If [POP before SMTP] or [SMTP-AUTH] is selected in [Authentication], enter a user name to be used for
authentication.
(4) [Password]
Enter a password to be used for authentication with the user name entered in (3).
(5) [POP Server] and [Port]
If [POP before SMTP] is selected in [Authentication], enter the name of the POP server to be used for
authentication and the port number, as required.
3 Click [OK].

The [Mail Server Settings] dialog box closes and settings are saved.

E Note

If [POP before SMTP] is selected in [Authentication], the Storage Server performs POP authentication before sending an e-mail
message.

Set an E-mail Notification Destination

{ Click [Add].

The [E-mail Notification Settings] dialog box appears.
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2 Configure the e-mail notification settings.

i B E-mail Notification Settings
E-mail Settings
To: — (1 )
From : — (2)
Subject : RM Series Event Notification (3)
Event
Min. Priority : | High v |_ (4)
(1) [To]
Enter an e-mail address as the destination.
(2) [From]

Enter the e-mail address of the sender.

(3) [Subject]
Enter the subject of the e-mail.

(4) [Min. Priority]
Specify the minimum event priority level which will generate an e-mail notification.

g Click [OK]

The [E-mail Notification Settings] dialog box closes and the e-mail address for the specified destination and the
event priority are added to the [E-mail Notification] list.



Manage Disk Space

You can configure various settings in order to manage Storage Server disk space.

Change the Destination of the Recording File and the Maximum Disk
Usage

AN

Specify a drive for recording or change the maximum disk usage. By default, the maximum disk usage is set to [Do not
limit].

1 Select the appropriate Storage Server, click [Settings] > [Storage Server], and display the [Storage Server] tab in
the [Settings] dialog box.

9 Click [Edit]

The [Storage Server Settings] dialog box is displayed.

B Storage Server Settings “
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e Sewers |192.163,100.11 |

Drive Settings :

Drive Maximum Disk Space Used

[ € Drive not used

Volume (D:) Do not limit

[ ok || cance |

3 Clear the check boxes next to the drives that should not be used for recording.

4 Specify the maximum disk usage.

Click [Do not limit] for each drive to display the maximum disk usage.
Select [Maximum Disk Space Used] and specify a maximum disk usage that does not exceed the total disk
capacity.

m Important

* |tis recommended that you do not specify the system drive (typically the C drive) as the destination for the recording file.

e You cannot specify a drive that has a capacity of less than 1GB.

| Click[OK].

The [Storage Server Settings] dialog box closes and settings are saved.
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Specify the Storage Period for Recorded Video

You can specify the storage period for video recorded on the Storage Server. Select the appropriate Storage Server, click
[Settings] > [Storage Server], and display the [Storage Server] tab in the [Settings] dialog box. You can specify the storage
period for video recorded on the Storage Server in [Recorded Video Settings].

°B Settings
Storage Server Group: | 5501 -

Cameras | Servers | Users

Storage Server Maximurm Disk Space Used
192.168.100.11 132 GB

Recorded Video Settings
[] Ensure video is kept for at least

Minimum: | Days

Ensure video is kept for upto

Maximum: |1 Weeks

Close

(1) [Ensure video is kept for at least]
Check this option when to specify a minimum storage period. Select the units (day or week) of the storage period and
enter the number of days or weeks, up to a maximum of 99 weeks. Recorded video is usually stored for the minimum
storage period unless this is unavoidable.

(2) [Ensure video is kept for up to]
Check this option when to specify a maximum storage period. Select the units (day or week) of the storage period and
enter the number of days or weeks, up to a maximum of 99 weeks. Recorded video is automatically deleted when it
exceeds the maximum storage period.
Specify a minimum storage period that is within the maximum storage period. For example, if the maximum storage period
is ten days, specify a minimum storage period of two days.
Specify the the number of days (1 to 90) or weeks (1 to 12) for the minimum and maximum storage periods. [Ensure video is
kept for up to] is always enabled.

The Storage Sever monitors available disk space for recording video. When disk space falls below “(Number of cameras +
1) x 64MB” (threshold level), recorded video will be deleted starting with the oldest video, including video still within the
maximum storage period, until enough disk space above the threshold level has been freed (P. 70). When this happens, a
“Delete recorded files (when disk space is low)” event occurs.

Video within the minimum storage period will be deleted if enough disk space above the threshold level cannot be freed,
even if all the recorded video that has exceeded the minimum storage period is deleted. When this happens, a “Delete
recorded files (when disk space is insufficient)” event occurs, which indicates insufficient disk space for the video
recording settings. Changes to the system configuration, such as disk space, or video quality and frame rates for recorded
video, are recommended.

< > (1)

=P (2)
T [ TTTTITTT e
» >le >le—p

(1) Maximum storage period (ten days here)
(2) Minimum storage period (two days here)

(8) Delete recorded data



(4)

(%)

When the disk capacity reaches the threshold level, the data for that period is deleted and a “Delete recorded files
(when disk space is low)” event occurs.

If the disk capacity stays at the threshold level after executing (4), the data for that period is deleted and a “Delete
recorded files (when disk space is insufficient)” event occurs.

m Important

Depending on the maximum disk usage setting for the Storage Server (P. 67), recordings may not be stored for the full storage period
specified in this setting.

Low Remaining Disk Space Level and Solutions

The Storage Server monitors the disk space and responds according to the amount of available space.

Disk Space Status Description

Low remaining disk space You can specify a reference value using [Low Disk Space Warning Level] on the
notification level [Recording Settings] tab in the [Storage Server Group Settings] dialog box.
Threshold level The Storage Server calculates a reference value based on various conditions and
Limit level settings.

B Action When the Low Remaining Disk Space Notification Level is Reached

The Storage Server issues an event when the disk space available for recording (i.e. available space relative to the
maximum disk space used) goes below a certain level.

If [Maximum Disk Space Used] (P. 67) is not set, the drive capacity of the disk that stores the recording file is
considered to be the maximum disk space.

Drive letter
drive has low free disk
space: Notification

4

Notification

Notification IE

Set [Maximum Disk
Space Used]

level

m Important

An event e-mail notification is sent when the priority level of [Low Disk Space Warning] in the [Event] tab (P. 64) of the [Storage
Server Group Settings] dialog box meets or exceeds the level specified in the [E-mail Notification Settings] dialog box (P. 65).

=] Note

On receiving an event e-mail notification, an administrator can act promptly (for example, by removing unnecessary recording
schedules) before a problem occurs due to low disk space.

Low Remaining Disk Space Notification Level Conditions and Calculation Method

If one of the following conditions is met, a low remaining disk space notification level is indicated.

Condition 1: If the Storage Server disk space usage exceeds the following values:
M x (100 - A)/100
(M: Value specified in [Maximum Disk Space Used], A: Value specified in [Low Disk Space Warning Level])

AN

Jabeue INH YUM Juswabeuely walsAs

69



70

For example, if the value for [Maximum Disk Space Used] is 100 GB and the value for [Low Disk Space Warning
Level] is 10%, the Storage Server reaches the low remaining disk space notification level when the Storage Server
disk space usage becomes 90 GB or more.

Condition 2: If the free disk space falls below the following values:

Disk space x A/100

(A: Value specified in [Low Disk Space Warning Level])

For example, if the disk space is 80 GB and the value for [Low Disk Space Warning Level] is 10%, the Storage Server
reaches the low remaining disk space notification level when the remaining free disk space becomes 8 GB or less.

[=] Note

If other applications use the same hard disk, you need to consider condition 2. Even if the Storage Server uses a small amount of
disk space, it may reach the low remaining disk space notification level according to condition 2 because other applications have
consumed a portion of the disk space.

Calculation Example

Disk Drive D Drive E Drive
Disk Space 100 GB 200 GB
Free Disk Space 50 GB 200 GB

Value for [Maximum

Disk Space Used] 40GB 200 GB
Condition 1: Condition 1:
Value for Low 40 GB x (100-10)/100 = 36 GB used 200 GB x (100-10)/100 = 180 GB used
Remaining Disk Space — —
Notification Level Condition 2: . Condition 2: N
100 GB x 10/100 = 10 GB remaining 200 GB x 10/100 = 20 GB remaining

B Action When the Threshold Level is Reached

Recording continues, however, the Storage Server starts deleting recording files, beginning with old files, and issues
an event.

Low disk space
<drive letter>
drive file
delete: Begin

Remove from \]
the oldest Notification

Threshold level @ —I_ M

=] Note

e Recording files are deleted, even if they have not reached the [Maximum Storage Period]. However, if the oldest file is currently in
use by the Viewer (for example, for playback of recorded video), it will not be deleted and the next oldest file will be deleted
instead. Deletion continues sequentially until the free disk space meets or exceeds the threshold again. For details on saving
files, please refer to Chapter 8.

e Normally, a recording file for which the minimum storage period has not elapsed is excluded from deletion. Note that such files
are also deleted if the free disk space cannot meet and exceed the threshold value by deleting all the other files.

Threshold Level Conditions and Calculation Method
The threshold level is considered reached when the amount of free disk space drops below the following level.
(Number of cameras + 1) x 64 MB




B Action When the Limit Level is Reached

The Storage Server stops recording and issues an event when the free disk space drops to this level.
The Storage Server resumes recording and issues an event when the free disk space increases above this level after
deleting recording files.

Low disk space
<drive letter>
drive file
delete: Begin

AN

Recording \)
stopped Remove from
notification the oldest  Notification

A+

e
=k

Limit Level Conditions and Calculation Method
The limit level is considered reached when the amount of free disk space drops below 64 MB. This value is fixed.
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m Important

e The threshold level is to protect against reaching the limit level. We recommend that you take appropriate measures, such as
deleting unnecessary recording data, when the event for the low remaining disk space notification level occurs.

e Storing recordings that cause the threshold level to be exceeded increases the load on the Storage Server and may cause
recording to be interrupted, resulting in incomplete recordings. We strongly recommend that you operate the Storage Server at
below the threshold level.

¢ |f e-mail notification is specified, an e-mail message is sent for the event that occurs at each level (P. 64).

¢ Note that the threshold level conditions may be met before the low remaining disk space notification level conditions are
satisfied, depending on the circumstances. For example, a large number of cameras with limited disk capacity may cause a
value for (Numbers of cameras +1) x 64 MB to be larger than the value of disk capacity x low free disk space notification setting/
100.
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Chapter

Setting a Recording Schedule

You can record automatically by the schedule set in RM Manager. You can also configure settings to record
periodically each day using a repeating weekly schedule, or specific days only using special day recording
schedules.
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Record on a Regular Basis (Repeating Weekly Schedules)

You can configure a recording schedule for each day of the week.

[ Important

The configuration items and values that are available will vary depending on the camera and settings used for recording. For details,
please refer to the camera manual.

Display the [Recording Schedules] window

1 Launch RM Manager to connect to the Storage Server Group (P. 46).

2 Click [Tools] > [Recording Schedules] to display the [Recording Schedules] window.

File Settings | Tools | Help

I Tree View | | Recording Schedul |!

Tree View Manage Tags...

Backup/Restore Configuration...
Change IP Address...

Change License...

Update Time on Storage Server

The [Repeating Weekly Schedules] tab is selected whenever the [Recording Schedules] window is displayed.

B Recording Schedules S

Repeating Weekly Schedules | Special Day Schedules (1 )

Server Group: | $501 -

:

(1) [Add Schedule Item], [Edit], [Delete], [Import], and [Export]
Add, edit, remove, import, and export recording schedules.

(2) [Zoom] slider
Zoom in and zoom out the time line of the schedule area.

(3) [Search for] box
Search for the camera to be used for display.

(4) Schedule area
Displays the currently registered cameras and their corresponding weekly schedules, arranged by day of
the week.



[Import], [Export], and [Search for] boxes are not available.

Display the [Edit Schedule Item] dialog box

Displays all cameras registered to the Storage Server Group in the schedule area. Select a camera to add to the recording
schedule.
When adding multiple cameras, you can use [Search for] to filter the camera display (P. 103).

1 Select a camera you want to configure a recording schedule for.

Un

2 Click the [Add Schedule ltem] button.

w
The [Edit Schedule Item] dialog box appears. o
=
Bl «Q
3 Edit Schedule ltem - Camera ®
s
Start Time: 00: 00 Curation: 24 : 00 All Day (1) 8
- o
End Time: [00: 00 | Repeat On: [ Mon [] Tue [ Wed []Thu []Fri []Sat (] Sun Select Al s
= «Q
Continuous Recording Continuous Recording g)
[[] Sensor Recording (:D-
[[] Motion Detection Recording Recording Settings g—
[ Intelligent Function Recardi . @
ntelligen unc. ion ecor. ing e Not Specified =
[[] Volume Detection Recording
| [ Scream Detection Recording Video Format: JPEG ¥
[[] Linked Event Recording
Maximum Frame Rate: | 3 ¥ | frames / sec.
[C] Record audio if available
[] Use the recording-mode stream
OK | | Cancel

(2) 3)
(1) Recording time settings area
Specify the day of the week and the time period for recording.

(2) Recording mode list
Select the recording mode.

(3) Recording settings area
Configure the settings for the recording mode selected in (2).

Specify the Recording Period and Day of the Week

Configure the recording time and day in the recording time settings area.

1 Specify the recording period.
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e To record for the entire day without specifying a start and end time, click [All Day].

e To specify a recording period, enter the start time in [Start Time] and the end time in [End Time]. Use these
items when you want to specify a recording time that goes past midnight, such as when recording late into the
night. Alternatively, select a duration for the recording (minimum of 15 min.) in the [Duration] field.

2 Select the check boxes for the days of the week on which to repeat the recording in [Repeat On].

If you click [Select All], you can select check boxes for all days. To clear all selections, click [Clear All].

1 Important

To use one Storage Server with more than 32 cameras connected to it, set the start time of the recording schedule leaving 15-
minute intervals or longer so that the recording schedules of 33 or more cameras do not start at the same time. If recording
schedules for 33 or more cameras start at the same time, recording may be delayed for some cameras.

=] Note

® You cannot specify overlapping recording schedules on the same camera.

e The time of the recording schedules is based on the Storage Server clock. We recommend that you synchronize the clocks on all
the Storage Server you are using.

¢ |f you set the operating system to automatically handle daylight saving time, the time will be automatically adjusted on the first
and last days of the daylight saving time period.

Specify the Recording Mode

Specify the recording mode. Recording begins based on conditions met within the set day and time.
1 Select the check box next to the recording mode you want to use.

For example, if you want continuously record for the entire duration of the recording schedule, select the check
box next to [Continuous Recording].

2 Configure the recording mode settings in the recording settings area.

The settings are different for each recording mode.
e Continuous recording (P. 78)
Records continuously for the specified recording period.
e Sensor recording (P. 79)
Starts recording when there is a signal from a sensor connected to the camera.
e Motion detection recording (P. 80)
Starts recording when motion is detected.
¢ |Intelligent Function recording (P. 83)
Starts recording when motion that meets the Intelligent Function detection criteria is detected.
e Volume detection recording (P. 84)
Starts recording when the volume detection criteria are met.
e Scream detection recording (P. 84)
Starts recording when a scream is detected.
e |inked event recording (P. 85)
Recording begins when a linked event occurs.

E Note

e The available recording modes depend on the camera model.

® You can specify the priority of the events generated by any recording operation other than continuous recording. For details,
please refer to P. 79, 80, 83, and 84. When two events occur simultaneously, the event with the higher priority takes precedence.

® You can specify more than one recording mode at the same time. For example, you can select motion detection recording and
specify a frame rate that is higher than continuous recording. This way, a high frame rate is used only when motion is detected.

® The motion detection feature notifies you there is motion in an area when motion is not ordinarily expected. Do not use this feature
for busy areas where motion detection may be triggered frequently.

¢ On models on which both motion detection recording and intelligent function recording can be configured, please use intelligent
function recording.



e \When an event occurs, data is saved in the Storage Server as an operation record. As the number of operation records
increases, operation during event detection and the search and Viewer response speeds may be affected. Use “Maximum
events processed” (P. 17), described in “Operating Environment” > “For High-reliability/H.264 Video Format Systems,” as a
guide.

* The volume detection recording and scream detection recording are not available on cameras on which audio input from a
microphone is not supported.

e The sensor recording function is not available on cameras on which a sensor cannot be connected.

Only continuous recording can be used.

Specify Advanced Settings

Advanced settings are available when the [Advanced] button is displayed in the recording settings area. For details, please
refer to “Configure the Advanced Recording Settings” (P. 86).

Check the Recording Schedule

When you click [OK] to close the [Edit Schedule Item] dialog box, the set recording schedule appears in the schedule area.
The schedule becomes active as soon as it is displayed in the schedule area. Check the recording schedule in the
schedule area.

e The camera supports sensor recording and schedule recording to internal memory (picture recording function). If these
features on the camera are enabled, they take precedence over the Storage Server recording schedule. You must
disable the feature on the camera before using the recording schedule on the Storage Server.

e |f [Restrict Service Time] is enabled on the camera, recording will take place only during the service time, irrespective of
the recording schedule.

m Important

Be sure to test recording schedules before using them.

Un
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Configure the Recording Mode

B Continuous Recording Settings

Recording Settings

| Resolution : Not Specified |_ (1 )
|Video Format : JPEG v |—(2)
| Maximum Frame Rate: |3 ~ | frames / sec. |_(3)
[] Record audio if availabl (4)
Advanced.. 77— (5)

[[] Use the recording-mode stream (6)

1

@)

@)

(4)

(6)

(6)

[Resolution]
Specify the resolution.
If you select [Not Specified], the camera’s resolution setting is used for recording.

[Video Format]
Specify the video format ([JPEG], [MPEG-4] or [H.264], etc.).
The available formats depend on the camera model.

[Maximum Frame Rate]
Specify the maximum frame rate (number of frames recorded in one second) in the range from 0.1 to 30 frames
per second (fps).

[Record audio if available]
Select this check box if you want to record audio together with the video.

[Advanced]
Displays the [Advanced Recording Settings] dialog box (P. 86).

[Use the recording-mode stream]

Enable the recording stream function. With this function, the camera temporarily stores the video in its own
memory before sending it to the Storage Server. This can help reduce the effects of non-uniform network traffic
(jitter).

m Important

* You can save JPEG video of the recorded stream to a memory card in the camera using [Use the recording mode stream] if the

stream could not be distributed due to a network failure. Video is saved at a frame rate of 1 fps. For details, please refer to the
camera manual.

¢ The size of the recording data increases as the resolution and frame rate become higher. Make sure there is sufficient hard disk

space available before specifying a higher resolution and frame rate.

¢ |f you select [MPEG-4] or [H.264], the [Storage Server] option in [Detect Motion Using] cannot be selected.

¢ Even if the [Record audio if available] check box is selected, audio will not be recorded if the audio sending function has not
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been activated on the camera. If you schedule a recording, make sure the audio sending function on the camera has been set
to [Enable].



E Note

e |f you select [MPEG-4] or [H.264] for the [Video Format] setting, the [Maximum Frame Rate] setting cannot be changed. The
settings on the camera are used for recording.

* |t may not be possible to record at the specified frame rate depending on the load on the Storage Server CPU or the hard disk.
Recording may also pause intermittently.

e Recording may be performed at lower than the specified frame rate, depending on the number of Viewers that are accessing the
camera, the load on the camera and Storage Server, variation in network traffic, and the environment at the time of recording.

¢ Audio recording is enabled when the recording mode is selected. You cannot schedule audio-only recording.

e |f MPEG-4 or H.264 recording format is used, the recorded audio will not be in sync with the recorded video. If JPEG recording
format is used, the recorded audio will be in sync with the recorded video for the most part, however it is not guaranteed that it will
be completely in sync.

Un

Recording mode stream operates only with cameras that support the recording mode stream function and if a stream has been
acquired.

e To use recording mode stream, select [Video Format] > [JPEG] or [Digital PTZ (JPEG)], and set [Maximum Frame Rate] to “10” or
less.

¢ When the recording-mode stream function is used, the streamed video has a higher priority than the live video. Depending on the
load on the camera, such as the number of Viewers that are simultaneously connected to the camera, display of the live video
may stop.

H730MKkIIf S30MKII | S31MKII [ S80xMkIl [S90xMKII H630H610]H730
H710 M620]M600 M720IM700] C500

If an upload function is already being used on the camera, you cannot use the recording-mode stream function. To use the
recording-mode stream function, select [Upload] > [Upload Disabled] on the Setting Page of the camera.

S30MKII ] S31MKIl

[Digital PTZ (JPEG)] cannot be selected for [Video Format].

e Only supports [JPEG] for the [Video Format].
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e The maximum frame rate is five fps.

Sensor Recording Settings

Sensor 1 Sensor 2

Sensor Name :

When an event is triggered on this sensor:

(® Do not record (1 )
() Start Recording (2)
Priority : Medium |_ (3)
Resolution : Not Specified
Video Format : IPEG
Maximum Frame Rate: |3 frames / sec.
Record audio if available
Invert this event (4)
Advanced

[] Use the recording-mode stream

(1) [Do not record]
Select to not record even when there is a signal from this sensor.
You can individually enable or disable recording for each sensor. For example, you may not want to record
when there is door sensor signal, but to start recording when there is a window sensor signal.

(2) [Start Recording]
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Start recording when there is a signal from the sensor. After selecting the item, configure the recording settings
below the item.

(3) [Priority]
Select the event priority. For details, please refer to “Check Events” (P. 117).

(4) [Invert this event]
Select this checkbox to start recording when the input from the sensor disappears.
For example, start recording when there is no signal from the sensor, and stop recording when a signal is
present.

The other settings are the same as those for continuous recording (P. 78).

™ Important

e When you select the [Sensor Recording] check box in the recording mode list in step 1, [Do not record] is selected for all of the
sensors. You must select [Start Recording] for at least one sensor to be able to start sensor recording.

* The sensor inputs can generate a large number of events for the Storage Server, thereby increasing the load on the server. For
reference, if the Storage Server is continuously receiving more than ten events per minute, we recommend that you use
continuous recording mode.

¢ |f the recording period for a schedule ends while sensor recording is in progress, recording will stop.

=] Note

e The number of tabs depends on the number of compatible external devices (sensors) that are connected to the camera.
e The name of the external device that is registered in the camera is displayed in the [Sensor Name] box.

e |f a sensor recording is triggered with the same priority as one that is currently recording, the second sensor will be given priority
and begin recording. The remainder of the first recording sensor, if any, will continue recording after the second sensor ends.

Motion Detection Recording Settings RVF64/25/9

m Important

The motion detection feature is not suitable for applications where high reliability is required. We recommend that you do not use
the motion detection feature in applications such as surveillance, which require high reliability. Canon cannot take responsibility
for any accidents or damages associated with using the motion detection feature.

Using the Camera for Motion Detection

Motion Detection Recording

|Detect Motion Using : | Cameras \-|_ (1)

Area1 |Area 2 | Area 3 | Aread

Area Name: ~1=2

When motion is detected in this area :

® Do not record (2)
() Start Recording (3)
Priority : Medium |_ (4)
Resolution : Not Specified
Video Format : IPEG
Maximum Frame Rate: |3 frames / sec.

Record audio if available

A
T

[] Use the recording-mode stream



(1) [Detect Motion Using]
Select [Cameras] to detect motion using a camera.
(2) [Do not record]
Select this item if you do not want recording to start when motion is detected.
You can use this to individually enable or disable recording for each area. For example, you may want to record
when motion is detected around a vault, but not record when motion is detected around an entrance.

(3) [Start Recording]
Start recording when motion is detected.
(4) [Priority]
Select the event priority. For details, please refer to “Check Events” (P. 117).

Un

The other settings are the same as those for continuous recording (P. 78).

C50F

To use motion detection, you must create a schedule with motion detection using the camera’s schedule setting tool.

E Note

e |f the camera supports four motion detection areas, tabs named [Area 1] through [Area 4] are displayed in the recording settings
area. You can specify settings individually for each motion detection area.

e The [Area Name] box displays the name of the area that is registered in the camera.

¢ To use a camera for motion detection, you must configure the motion detection settings on the camera. For details, please refer to
the camera manual.
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¢ When using the camera for motion detection with more than one motion detection area, you can specify the event priority for each
area.

¢ Motion detection is suspended when the camera is panning, tilting or zooming, irrespective of the motion detection settings.

¢ |f motion is detected in multiple motion detection areas that have the same priority, recording will start with the area having the
lowest number.

Using the Storage Server for Motion Detection

m Important

e The load on the Storage Server CPU increases when motion detection is performed on the Storage Server. We strongly
recommend that you use the motion detection on the camera, if it is available.

e |f you select [MPEG-4] or [H.264] in [Video Format] of the continuous recording settings, the [Storage Server] option in [Detect
Motion Using] cannot be selected.

=] Note

If you select [MPEG-4] or [H.264] in [Video Format], the [Storage Server] option in [Detect Motion Using] cannot be selected. Note

also that if you select [MPEG-4] or [H.264] in other recording modes besides motion detection recording, the [Storage Server]
option still cannot be selected.

[Recording Settings] tab [Settings] tab
IDEIEd Motion Using : | Storage Server - |— (1 ) Detect Motion Using : | Storage Server g

Recording Settings | Settings Recording Settings | Settings

| riority - Low —(2) Anslysis Frame Rate: |5 <] tramestsee. —(3)

Resolution : Not Specified ¥, Settings Mode : ® Simple ) Advanced — (4)

Video Format PEG . ] 220 L (5)

Maximum Frame Rste: | 5 “ | frames / sec. Area Ratio : 10 5 — (6)

[ Recard audio if available T o — I (7)
Active Region

—(8)

Detection Indiicator : | L (9)

[T] Use the recording-mode stream [T] Use the recording-mode stream

(1) [Detect Motion Using]
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)

@)

(4)

(6)

(6)

@)

®)

(©)

Select [Storage Server] to detect motion using a Storage Server.

[Priority]
Select the priority of the motion detection events. For details, please refer to “Check Events” (P. 117).

[Frame Rate]
Specify the motion detection frame rate (frames per second).

[Settings Mode]

If you select [Simple], [Sensitivity] and [Area Ratio] can only be set using the sliders. [Duration] is fixed at 0.2
seconds.

If you select [Advanced], the [Sensitivity], [Area Ratio] and [Duration] settings become available so that values
can be set.

[Sensitivity]
Specify the motion detection sensitivity within the range of 1 to 256. Increase the number to increase the
sensitivity.

[Area Ratio]
Specify the area of the preview video that the Storage Server uses for motion detection. The range is 0 to 100%.
The size marker inside the Detection Indicator changes position depending on the value of this setting.

[Duration]

Specify the length of time the motion signal must be present to decide that there is motion. The range is 0.0 to
5.0 seconds.

[Active Region]

Displays a preview video from the camera used for motion detection.

Displays a dotted-line frame representing the active region on top of the preview video. Drag the frame handles
to make it larger or smaller.

[Detection Indicator]

Size marker

Notification Indicator J_

Colored bar

The size marker changes position depending on the value of the [Area Ratio] setting. Adjust the motion
detection settings while viewing the preview video and the Detection Indicator.
The colored bar changes depending on the value of the [Sensitivity] and the [Area Ratio] settings.

Color of the Meanin
Colored Bar 9

The detected motion does not reach the values specified in [Sensitivity] and [Area Ratio].
Green ) ) ;

In this case, the colored bar remains to the left of the size marker.

The detected motion exceeds the values specified in [Sensitivity] and [Area Ratio]. In this
Red . . )

case, the colored bar remains to the right of the size marker.

The other settings are the same as those for continuous recording (P. 78).

m Important

If the recording period for a schedule ends while motion detection recording is in progress, recording will stop.

The detection indicator is not affected by the [Duration] setting. Be sure to take the detection time into account when adjusting
the motion detection settings.

To perform motion detection on the Storage Server, you must specify [JPEG] for the [Video Format]. Also, if you simultaneously

use more than one recording mode, all the [Video Format] settings must be [JPEG]. An error message is displayed if you try to
use a format other than [JPEG] and motion detection on the Storage Server at the same time.

Make the [Priority] setting on the [Recording Settings] tab lower than the priority of any of the other recording settings.



Intelligent Function Recording Settings RVF64/25/9

Tabs named [Rule 1] through [Rule 15] are displayed, as shown. Each tab can be configured individually.

Intelligent Function Recording

Ruled | Rulel0 Rulell | Rulel2 | Rulel3 | Ruleld | Rulels
Rulel Rule2 Rule3 Ruled Rule5 Rulef Rule? Rule8
Rule Mame: |

When an event is triggered on this rule :

® Do not record (1 )
(O Start Recording (2)

Priority : Medium I_ (3)

Resolution : Not Specified

Video Format : IPEG

Maximum Frame Rate: |3 frames / sec.

Record audio if available
Advanced...

[] Use the recording-mode stream

(1) [Do not record]
Do not record even when the conditions for this rule are met.

(2) [Start Recording]
Start recording when the conditions for this rule are met. After selecting the item, configure the recording
settings below the item.

(3) [Priority]
Select the event priority. For details, please refer to “Check Events” (P. 117).

The other settings are the same as those for continuous recording (P. 78).

1 Important

e To use Intelligent Function recording, you must configure the Intelligent Function recording settings on the camera. For details,
please refer to the camera manual.

¢ |f the recording period for a schedule ends while Intelligent Function recording is in progress, recording will stop.

E Note

The Detection Settings Name configured on the camera is displayed in [Rule Name].

Un
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M Volume Detection Recording Settings RVF64/25/9

'olume Detection Recording

Rulel

When an event is triggered on this rule:

® Do not record (1 )
() Start Recording (2)
Priority : Medium |— (3)
Resolution : Not Specified
Video Format : IPEG
Maximum Frame Rate: |3 frames / sec.

Record audio if available

Advanced

[] Use the recording-mode stream
(1) [Do not record]
Do not record even when audio is detected.

(2) [Start Recording]
Start recording when audio is detected. After selecting the item, configure the recording settings below the item.

(3) [Priority]
Select the event priority. For details, please refer to “Check Events” (P. 117).

The other settings are the same as those for continuous recording (P. 78).

1 Important

¢ |f the recording period for a schedule ends while volume detection recording is in progress, recording will stop.

* To use volume detection recording, you must first configure the volume detection recording settings on the camera. For details,
please refer to the camera manual.

B Scream Detection Recording Settings RVF64725/9

cream Detection Recording

Rulel

When an event is triggered on this rule:

® Do not record (1 )
Start Recording (2)
Priority: Medium |_ (3)
Resolution: Not Specified
Video Format: JPEG
Maximum Frame Rate: |3 frames / sec.
Record audio if available
Advanced...

[] Use the recording-mode stream
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(1) [Do not record]
Do not record even when a scream is detected.

(2) [Start Recording]
Start recording when a scream is detected. After selecting the item, configure the recording settings below the
item.

(3) [Priority]
Select the event priority. For details, please refer to “Check Events” (P. 117).

The other settings are the same as those for continuous recording (P. 78).

m Important

e |f the recording period for a schedule ends while scream detection recording is in progress, recording will stop.

Un

e To use scream detection recording, you must first configure the scream detection recording settings on the camera. For details,
please refer to the camera manual.

H730MkI] S30MKkil T S31MKkil [S80xMKklI [S90xMkl

Scream detection recording is not available.

a|npayog Buipiooay e buies

Linked Event Recording Settings

Tabs named [Rule 1] through [Rule 4] are displayed as shown. Each tab can be configured individually.

Linked Event Recording

Rulel |Rule2 | Rule3  Ruled

When an event is triggered on this rule:

® Do not record (1 )
Start Recording (2)
Priority: Medium |_ (3)
Resolution: Not Specified
Video Format: IPEG

Maximum Frame Rate

Record audio if available

Advanced...

[] Use the recording-mode stream

(1) [Do not record]
Do not record even when linked events occur.

(2) [Start Recording]
Start recording when linked events occur. After selecting the item, configure the recording settings below the
item.

(3) [Priority]
Select the event priority. For details, please refer to “Check Events” (P. 117).

The other settings are the same as those for continuous recording (P. 78).
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m Important

e |f the recording period for a schedule ends while linked event recording is in progress, recording will stop.

e To use linked event recording, you must first configure the linked event recording settings on the camera. For details, please
refer to the camera manual.

H730MKI] S30MKkll T S31MKkil [S80xMKkll [S90xMKklI

Linked event recording is not available.

Configure the Advanced Recording Settings

Click [Advanced] in the recording settings area to display the [Advanced Recording Settings] dialog box and configure the
operation when recording starts.

(1 ) ®) (4)

B Advanced Recording Sejttings
Camera Position Image Adjustment e e Outputs
(®) Not Specified @ Not Specified
() Custom O Specify
() Presets Eposire

il Exposure: Not Specified
() Preset Tour
Settings Smart Shade Control
- Adjustment: Not Specified
Preview: )

Haze Compensation

Haze Compensation: = Mot Specified

Clear IR Mode
Clear IR Mode: Not Specified

Aperture Mode

Night Made: Not Specified
Infrared
Infrared: Not supported

White Balance

Recording Options White Balance: Not Specified
Record for |~ sec. before event R Gain: 0 0 1023
Record for |~ sec. after event B Gain: 0 0 1023
One Shot WE
OK | | Cancel
(6)

(1) [Camera Position]
Specify the camera angle for recording.

(2) [Image Adjustment] tab
Adjust the video quality.

(8) [Focus]tab
Adjust the focus.

(4) [External Outputs] tab
Enable or disable output to external devices registered on the camera.



(5) [Recording Options] (RM-64/25/9

Specify the duration of recording before and after an event.

B Specify the Camera Angle for Recording

Camera Position

@ Not Specifis sd (1)
) Custom (2)
() Presets (3)
Preset 01
() Preset Tour (4)
Settings.., 5
Preview :
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(1) [Not Specified]
Select this item when you do not want to specify the camera angle.

(2) [Custom]
Specify the camera angle using the [Preview] window.

Preview :

Drag the slider to change the camera zoom and click or drag inside the video to change the camera angle.
Digital zoom operations are possible when [Digital Zoom] and [Enhanced Digital Zoom] are set to [Enable] on
the camera. However, recording settings in which an area that exceeds the maximum telephoto of the optical
zoom (in the case where the extended digital zoom can be used, the maximum telephoto of the extended digital
zoom) is specified cannot be configured. For details, see “About Digital Zoom” (P. 107).

(3) [Presets]
Select the camera angle from the list of preset camera angles registered in the camera.

(4) [Preset Tour]
Move the camera through a series of preset camera angles while recording. Click [Settings] to display the
[Preset Tour Settings] dialog box, and then specify the order of the presets.

S30Mkll ] S31Mkil [C50F S30VE[S910F

[Preset Tour] is unavailable.

C300

If the digital zoom is used when setting the preset angle with the camera, the viewing angle seen when the setting is
made and the viewing angle that will be recorded may be different.

€300

If you initialize the head position (the camera points the head forward, reinitializes, and then returns the head to the
former position) during recording, the video during the movement of the head will also be recorded.
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When an external camera is connected and [Use External Video Input] is enabled, the settings on this dialog box are
unavailable.

(=] Note

e Clicking the [Settings] button alone does not perform a preset tour. You must first configure the settings in the [Preset Tour
Settings] dialog box.

e You are not able to specify camera angle settings when configuring the intelligent function, configuring motion detection settings
with [Detect Motion Using] > [Camera], or when configuring multiple cameras. You are not able to specify [Preset Tour] settings
when configuring motion detection settings with [Detect Motion Using] > [Storage Server].

¢ To be able to select [Presets] or [Preset Tour], you must first register camera angle presets on the camera. For details, please
refer to the camera manual. When digital PTZ positions are registered in the camera's presets, set the video format to [Digital PTZ
(JPEG)] in the [Edit Schedule Item] dialog box (P. 75).

Changing the preset name on the camera after making [Presets] or [Preset Tour] settings will disable those settings. If you want
to change the preset name, be sure to repeat the [Presets] or [Preset Tour] settings after you change the preset name.

Configure a Preset Tour

Select [Preset Tour] in [Camera Position] settings and specify the order of the presets that are registered in the
camera.

1 Click [Settings] to display the [Preset Tour Settings] dialog box.

2 Click [Add] to open the [Edit Preset Tour] dialog box.

3 Preset Tour Settings

Preset Speed (PT) Speed (Z) Pause (sec) Add...

[] Return to default focus when the camera is operated

3 Select a preset from the [Preset] list.

3 Edit Preset Tour _
Preset: Preset 01
Speed (PT): 1 1 8
Speed (Z) : 8 1 8
Pause (sec): 10 0 120
oK || Cancel

4 Configure the speed and pause settings using the sliders ([Speed (PT)], [Speed (Z)], and [Pause (sec)]).

| Click[OK].



6 Repeat steps 2 to 5 for additional presets.

G | Preset Tour Settings
Preset Speed (PT) Speed (Z) Pause (sec) i i
Preset 01 1 8 10
Preset 02 1 g 10 Move Down
[] Return to default focus when the camera is operated
| Start Test | [ ok ][ cancel |

Selecting [Return to default focus when the camera is operated] enables you to restore the focus settings to the
default (“Auto”) during the preset tour.

7 Specify the order of the presets.

The tour starts with the first preset and proceeds down the list. Change the order by selecting a preset,

and then clicking [Move Up] or [Move Downl].

To remove a preset, select the preset and click [Remove]. To edit a preset in the list, select the preset and click
[Edit].

8 Click [OK] to close the dialog box.

[ Important

e Using preset tour with MPEG-4 or H.264 format will consume a large amount of disk space.

* The preset tour settings can effect the durability of the camera’s pan/tilt mechanism.

E Note

e The camera returns to the first preset position after reaching the last preset position.

e Click [Start Test] to run through the preset tour once to confirm your settings.

About the Warning Message Displayed During the Preset Tour

Depending on the preset tour settings, a warning message about the camera’s pan/tilt mechanism may be displayed
when you click [OK] to close the [Preset Tour Settings] dialog box. If this happens, consider changing the settings.
A warning will appear when the pan/tilt mechanisms reach their estimated lifetime of 100,000 round trips over the full
range of motion.

Specify the Option for Recording Before and/or After an Event RM-64/25/9
You can record a number of seconds before and/or after an event, such as sensor input or Intelligent Function, using
the [Recording Options] setting.

Recording Options

|Record for: |0 sec. before event Ii (1)
|Record for: |1 sec. after event'* (2)

(1) [sec. before event]
Number of seconds to record before an event (max. 30 seconds).

(2) [sec. after event]
Number of seconds to record after an event (max. 999 seconds).

=] Note

e [Recording Options] cannot be specified when setting continuous recording.

Un
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e Even if [sec. before event] is set to 0, recording will continue when events are continuously generated.

¢ The higher the value for [sec. before event], the greater the memory usage is for the Storage Server. If the Storage Server has
insufficient memory and the duration to record before an event is set high, the server will run out of virtual memory, which
consumes hard disk space, significantly reducing processing performance.

* |f you specify a preset camera angle for sensor recording, the camera angle will change to the preset angle when sensor
recording starts. Therefore, the camera angle of the recording before the sensor recording event will be different from the one
after the event. If [Recording Options] is set to record a short time after an event and the sensor input is very short, recording may
stop before the camera reaches the preset camera angle.

Adjust Video Quality ([Image Adjustment] Tab)

Image Adjustment | Focus | External Outputs

(® Not Specified (1 )
() Specify
Exposure
- — (2
Exposure: Not Specified
Smart Shade Control
= — @)
Adjustment: Not Specified
Haze Compensation
. — (4)
Haze Compensation: = Mot Specified
Clear IR Mode
- L (5)
Clear IR Mode Not Specified
Aperture Mode
= L (6)
Night Mode: Not Specified
Infrared
Infrared: Not supported (7)
White Balance
White Balance: Not Specified
o e —(8)
B Gain: | 023

| OK | | Cancel

(1) [Not Specified] / [Specify]
When [Not Specified] is selected, all items in this tab are locked to [Not Specified]. In this case, video quality is
determined by camera settings.
To activate tab settings, select [Specify].

(2) [Exposure]
The settings change according to the selected exposure setting.
e [Exposure]

Exposure Description

[Auto] Automatically control the exposure.

Reduce flicker from light sources, such as fluorescent lighting. The shutter

[Auto (Flickerless)] speed is automatically adjusted according to the lighting conditions.

Select this when flicker reduction with [Auto (Flickerless)] is not sufficient.
As the auto adjustment range for the shutter speed is suppressed to
remain below 1/100 s, overexposure may occur.

[Auto (Flickerless 2)]

90

[Auto (Shutter Priority)]

Specify the shutter speed.

[Auto (Aperture-priority AE)]

Specify the aperture value.




@)

(4)

(6)

Exposure Description

[Manual] Compensate for the exposure manually.
H730MKII

[Auto (Aperture-priority AE)] in [Exposure] is not available.
e [Compensation]
Specify exposure compensation. Select negative values to darken the video and positive values to lighten the
video.
This can be configured when an option other than [Manual] is selected in [Exposure].
Set the exposure compensation value to [Off], [Low], [Medium], or [High].
e [Metering Mode]
Specify the metering mode.
This can be configured when an option other than [Manual] is selected in [Exposure].

Metering mode | Description

Meters the entire scene, with an emphasis on the center.

[Center- Correct exposure is obtained for a subject near the center of the scene, even though the
weighted] periphery may be slightly darker or lighter.

Use for subjects that are in the center of the scene.

Meters an average of the entire scene.

A uniform exposure is obtained even when the scene has significant differences in
[Average] brightness.

Use for scenes where, for example, cars are passing through or people are entering and
exiting.

Meters the center of the scene.

The correct exposure is obtained for a subject near the center of the scene, irrespective of
[Spot] the brightness of the periphery.

Use if the subject is lit by a spotlight or is backlit, where the exposure should be adjusted
to the center of the scene.

o [lris]
Specify the iris setting. Drag the slider to the left to close down the iris and make the video darker or to the
right to open up the iris and make the video brighter.
This can be configured when [Auto (Aperture-priority AE)] or [Manual] is selected in [Exposure].
e [Shutter]
Specify the shutter speed.
This can be configured when [Auto (Shutter Priority)] or [Manual] is selected in [Exposure].
e [Gain]
Specify the gain (sensitivity to brightness). Drag the slider to the left to decrease the gain and make the video
darker or to the right to increase the gain and make the video brighter.
This can be configured when [Manual] is selected in [Exposure].

[Smart Shade Control]

Specify a value to use for the camera’s smart shade control feature when recording.

[Off]: Record with the smart shade control disabled.

[Auto]: Set smart shade control to automatic.

[1] to [7]: Select one of seven strength levels when setting the smart shade control function manually.

[Haze Compensation]

Specify a value to use for the camera’s haze compensation feature when recording.

[Off]: Record with haze compensation disabled.

[Auto]: Set haze compensation to automatic.

[1] to [7]: Select one of seven strength levels when setting the haze compensation function manually.

[Clear IR Mode]

Specify whether to record while using Clear IR mode or not.
[On]: Record with Clear IR mode enabled.

[Off]: Record with Clear IR mode disabled.

Un
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[ Important

When [Clear IR Mode] is set to [On] for cameras equipped with both the Clear IR mode and infrared lighting functions, the
configurations on the camera will determine whether the infrared lighting is enabled.

E Note

When [Clear IR Mode] is set to [On], both the displayed and recorded video will be black and white.

(6) [Aperture Mode]

Specify the camera aperture mode.

[Night Mode]

e [Disabled]
Disable the Night Mode function.

e [Enabled]
Record in Night Mode.

e [Auto]
The camera automatically decides when to switch to Night Mode. When recording ends, the Night Mode
setting returns to the value before recording started.

Em Important
When [Clear IR Mode] is set to [On], [Night Mode] cannot be specified.

=] Note

When [Night Mode] is enabled in [Aperture Mode], both the recorded and displayed video is in black and white.

(7) [Infrared]
Specify whether or not to use infrared lighting during night mode. Cameras without the infrared lighting feature
will always be set to [Not supported].
[Off]: Record with infrared lighting disabled.
[Day/Night Operation]: Use infrared lighting together with night mode. Infrared lighting will be irradiated during
night mode.
[1] to [5]: Select one of five strength levels for the infrared lighting used during night mode when [Exposure] is
set to [Manual].

1 Important
When [Clear IR Mode] is set to [On], [Infrared] cannot be specified.

(8) [White Balance]
Specify the white balance to be applied during recording.
If [Manual] is selected, use one of the following two methods to adjust the white balance.
¢ [R Gain] and [B Gain]
Specify the white balance parameters by dragging the sliders. Drag to the right to increase the gain (the
sensitivity to brightness).
e [One Shot WB]
Force white balance adjustment to a light source. Using a white object (such as a piece of white paper) as a
standard, fill the shot with the object and click this button.
It may take approximately 30 sec. for [Exposure], [Night Mode] and [White Balance] settings to be reflected in the
view after recording starts.

[ Important

When [Clear IR Mode] is set to [On] or when [Night Mode] is set to [Enabled], the white balance cannot be specified.
If you select [Auto] for Night Mode, however, you will be able to set the white balance, but the settings will be cleared when the
camera switches to Night Mode.



B Setthe Focus ([Focus] Tab)

Image Adjustment | Focus | External Outputs

Focus

Auto (for domes)
O Fixed at infinity (
O Manual (4)

Far Near:

Un
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(1) [Not Specified]
Record using the existing focal position of the camera.

(2) [Auto], [Auto (for domes)]
Automatically focus the video.
Use [Auto (for domes)] for cameras equipped with an indoor dome housing. The setting prevents the camera
from focusing onto the dome surface.

(3) [Fixed at infinity]
Fix the focal point at infinity.

(4) [Manual]
Adjust the focus manually by clicking the [Far] or [Near] button.
Click [One Shot AF] to focus once on the current subject and then return to manual focus.
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B Configure External Device Outputs ([External Outputs] tab)

Image Adjustment | Focus | External Outputs

(1)

Output 1: I:' 'l!' Not Specified I Cn (2)

Output 2: ® Not Specified () On

Enable or disable output to external devices registered on the camera when the recording schedule starts.

This feature can be used with sensor recording, motion detection recording, intelligent function recording or volume
detection recording. For example, by connecting a buzzer as an external device and linking it to motion detection,
the buzzer will sound when motion is detected.

(1) [Not Specified]
Disable the external output.

(2) [On]
Enable the external output.

=] Note

* You must first specify the external device settings on the camera. For details, please refer to the camera manual.
e The number of external outputs is different for different camera models.

e The external outputs are enabled only during recording. This will not turn on during standby.

Copy a Weekly Schedule to Another Camera RM-64/25/9

Copy the weekly schedule by exporting it from one camera and importing it to another.

m Important

When a weekly schedule is imported to a camera that already has a specified weekly schedule, the original schedule will be deleted.

B Export a Weekly Schedule

1 In the schedule area, select the recording schedule to export, and then click [Export].



2 Specify the location to save the recording schedule and the file name, and then click [Save As].

B Import from a Weekly Schedule

1 Select a camera to import a recording schedule to, and then click [Import].
2 Select the exported recording schedule file, and then click [Open].

g Click [OK]

Un

m Important

* |n some cases, not all settings can be imported. Check the [Activity Log] for event results.

e The settings may not be properly imported, if the camera’s firmware has not been updated to the latest version.
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Record at Specific Times (Special Day Schedule Settings)

RM-64/25/9

Set a special day schedule when you want to record on days that differ from public holidays and repeating weekly

schedules.

m Important

When you as

sign a special day schedule to a certain number of the registered cameras, the weekly schedules assigned to the remaining

cameras for the special day are disabled. For cameras where you want to continue to record using a repeating weekly schedule without
a special day schedule, you must re-import the repeating weekly schedule. For details, please refer to “Import from a Weekly Schedule”

(P. 95).

Display the [Special Day Schedules] Tab

1Di
2CI

splay the [Recording Schedules] window (P. 74)

ick the [Special Day Schedules] tab.

(1) ) @) (4)

B

Recording Schedules = e

Repeating Week | Schedules | Special Dify Schedules

Storage Server Gloup: [S501

Add...

Schedule Type

Select the type of schedule to use:

Days to use this schedule :

Add...

Days

(1 S

(5) (6) @) (8)

pecial day schedule type area

Add, edit or delete a special day schedule type.

(2) [Storage Server Group]
Display the Storage Server Group name.

@) s

pecial day schedule settings
[Add], [Edit], and [Delete]
Add, edit or delete a special day schedule.
[Use Repeating Weekly Schedule]/[Not Use Repeating Weekly Schedules]
Enable or disable the special day schedule for the applicable day of the weekly schedule registered on the
selected camera.
[Copy from Repeating Weekly Schedule]
Specify a day of an existing weekly schedule registered on the selected camera, and import it as a special
day schedule.



(4) [Zoom] slider
Zoom in and zoom out the timeline of the schedule area.

(5) Days area
Specify the day for the special day schedule selected in (1).

(6) Camera search
Search for the camera to be used for display.

(7) Schedule area
Displays the currently registered cameras and their corresponding recording schedules by day.
This area also has a search function for finding cameras using search criteria, such as the camera name or tags.
(P. 103)

(8) [Close]
Closes this window.

(=] Note

A special day schedule takes precedence over a weekly schedule.

Un

Name the Special Day Recording Schedule

Special day recording schedules are set by the day.

a|npayog Buipiooay e buies

1 Click [Add] in the schedule type area.

2 Enter the name of a special day schedule and click [OK].

B Edit Schedule Type

Schedule Name : | |

Cancel

The name is added to the schedule type area.

E Note

Before deleting a schedule name from the schedule type area, first delete the applicable day from the days area.

Specify the Day

1 Click the schedule name you want to use in the schedule type area.
2 Click [Add] in the days area.

3 Specify the date for the special day schedule on the calendar and click [OK].

°B Select Date

4 MNovember 2014 L3
Sun Mon Tue Wed Thu Fri Sat

26 27 28 29 30 37
2 3 A1[E55 4 T 8
LT TV - s S

% 17 18 19 20 21 2
23 24 25 2% 271 2B 29
3 2 3 4 5 &

Today: 11/5/2014

ok | [ Cancel
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E Note

e Special day schedules can only be set for a one-day time period (00:00 to 24:00). For example, for a three-day long weekend
(Saturday, Sunday and Monday) you will need to set a separate schedule for each of the three days.

* You cannot apply different special day schedules to the same day.

Specify the Schedule for Each Camera

The days for the special day schedule will disable the weekly schedule for all cameras registered to the Storage Server
Group and record using the special day schedule. You can configure a recording schedule for each camera.

1 Click the [Add] button to display the [Edit Schedule ltem] dialog box.

2 Set a recording schedule in the same way as a weekly schedule.

=] Note

e To apply a weekly schedule with the same days as the special day schedule, select a camera, and then click [Use Repeating
Weekly Schedule].

e To apply a weekly schedule with different days from the special day schedule, select a camera, click [Copy from Repeating
Weekly Schedule], and then specify the days from the original schedule.

3 Check the set schedule in the schedule area.



Chapter

Monitor Video with the Viewer

This chapter describes how to view live video with the Viewer. It also describes how to play back recorded
video and how to check events.
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Launch the Viewer

Launch the Viewer and connect to the Storage Server Group. You can view video from cameras connected to the Storage
Server Group.

1 Double-click the [RM Viewer] icon on your desktop.

@

RM Viewer

Double-click the [RM-Lite Viewer v4.5] icon on your desktop.

m Important

If the [User Account Control] dialog box appears, click [Yes] (or [Continue]).

2 Specify the information required to connect to the Storage Server Group.

= Connect to Storage Server Group

Please select the storage server group you want to connect to.

Storage Server Group

Group Mame : | 5501 |} (1)

User Name: |administrator

Password :
Remember user name
Use Host Name Connect| | Cancel

(1) [Group Name]

Select the name of Storage Server Group you want to connect to.

(2) [User Name], [Password]

Enter your user name and password.

3 Click [Connect].

=] Note

The first time you connect to the Storage Server Group, you must enter the host name and port number. However, from the
second time onward, you can simply specify the Storage Server Group name.

When there is a time difference of five seconds or longer between the Storage Server and the Viewer computers, a message
prompting you to synchronize them will appear. Adjust the system time of the Viewer computer to the time of the Storage Server.
You can disable the message display in [Viewer Settings]. For details, please refer to “Configure the Viewer Display and
Operation Settings” (P. 122).

You can configure the Viewer to launch without displaying the launching screen or the [Connect to Storage Server Group] dialog
box. For details, please refer to “Create a Shortcut Icon for Launching the Viewer” (P. 162).

You can launch the Viewer using a Storage Server host name instead of the Storage Server Group name. Enter the host name or
the IP address of the Storage Server Group in [Host Name]. If the Viewer and the Storage Server are installed on the same
computer, enter “localhost”. For the port number, enter the port number configured during installation (default: 80).

If there are no cameras added, a message is displayed asking if you want to add a camera. Launch RM Manager and then add
cameras.

If you want to connect to another Storage Server Group after launching the Viewer, click [File] > [Connect to Storage Server
Group].



Viewer Features

B Toolbar H Tabs

Displays buttons for executing often- Switch between multiple layout displays using tabs. Tabs can be added
used functions. via [New Tab] in the [File] menu. (Tab display is not available in
RM-Lite)

=] Untitled1 - SS01 - Canon Network Video Recording Software RM ! [iewer

- omm

B Video window
Display live video from a camera or
playback from a recording.

Camera.. — =
B  Camera Contro,

Camera Control
Operate the camera (P. 105).

[¥]camera 001

Camera Selector

Specify conditions to search for cameras
and select a camera to view video
(P.103).

Audio

Lo uive % 8 [ Camera 004 Send and receive camera audio and play
back recorded audio (P. 108).

Live Events Log
Check events that occurred one hour or
less after Viewer startup (P. 117).

I—F—' W Viewing Area
| . .
W Timeline W Playhead Place a Video Window
Events are displayed here. Click Drag to change the playback position
an event to play back the in the video window (P. 112).

recording (P. 111).

Toolbar

| [E=] Layouts F Grids Zoom : (©) | ; &7 Viewer PTZ | @), Search

[Back]
When multiple layouts are open, click n to display to the previous layout, and click u to display the next layout.

[Layouts]
Select and switch layouts in the video window.

[Grids]
Display a grid in the background of the video window.

[Zoom]
Zooms in and out on the viewing area. Each click zooms in or out on the viewing area.

™ Important

The quality of the video in the video window decreases when you zoom in. To increase the video quality, change the resolution (P. 126).

(=] Note

e Select [Actual Size] from the [View] menu to return the view to the actual size.
® You cannot zoom out further than the actual size.

[Control Cameras]
Opens camera control panel.

JOMBIA BU} UM OBPIA JOHUOI
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[Record Now]
Starts video recording. Recording is stored in JPEG format.

[Capture]
Save a still image of the displayed video.

[Viewer PTZ]
You can zoom a region of the camera video in the video window using Viewer PTZ (pan/tilt/zoom).

[Search]
You can search for past events that have occurred. You can search for and play back video of recorded events

102



View Live Video

Display live video in the Viewer.

Select a Camera to View Live Video

Select a camera for which you want to view video.

1 Click [Window] > [Camera Selector].

= Untit
File Edit View Layouts Settings | Window | Help B
i [E¥ tayouts [ Grids Camera Selector Ctrl+M |
Camera Control Ctrl+0
Viewer PTZ
Panorama
Audio Panel Ctrl+L
Live Events Log Ctrl+E

The [Camera Selector] dialog box is displayed. This action displays all cameras added to the Storage Server.
In [Search for], you can filter displayed cameras as necessary.

JOMBIA BU} UM OBPIA JOHUOI

(1) Button
In the menu, you can specify the conditions for displaying cameras. Only cameras that meet the conditions
will be displayed.
You can specify more conditions to further filter the cameras displayed. The specified conditions appear on
the camera list.

Button
Deletes search conditions added to the camera list.

& Button
Save the search conditions. You can save up to five conditions.

Button
The saved search conditions or search history appears. Up to five search history items are automatically

saved. You can search using the same search conditions.

(2) Search field
When you click and then select [Camera Name/Host Name], enter the camera name or host name you
want to search for.

103



(3) List of cameras
Cameras matching the search conditions appear. If you have not used filters when searching for a camera,
all cameras registered to a Storage Server Group will appear.

(=] Note

The Camera Selector panel can be turned off, by selecting [Window] > [Camera Selector] and toggling the on/off dialog box.

2 Double-click the camera in camera list to display the video window.

ECamefa 003

Select a Layout to View Live Video

If a layout is already specified, you can click the [Layout] button on the toolbar to view the desired layout. The video
windows set in the layout will appear and you can view the live video.
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Operate the Camera

You can get control of the camera and change the camera angle or adjust the video quality while viewing live video.

Set the Camera Angle

B Use the Pan/Tilt/Zoom Feature in the [Camera Control] Dialog Box

Click the [Camera Control] button on the toolbar to open the camera control dialog box.

1 Click the video window for the camera you want to control.
2 Click [Window] > [Camera Control] to display the [Camera Control] dialog box.

3 Click the [Control]/[Release] button to get control of the camera and then operate the camera.

B Pan (horizontal) / Tilt (vertical)
Move the camera in the direction of the arrow for cameras that can be panned and titled. Click in the center to
point the camera to the front.

| Camera Control

B Control / Release button
Obtain camera control privileges. All camera control buttons are activated when
camera control privileges are obtained.

JOMBIA BU} UM OBPIA JOHUOI

Zoom slider
Drag to zoom.

Area Zoom / Drag to Move switching button
Click to switch between options.

B [Advanced] button
You can adjust camera image quality settings using Smart Shade Control and Night
Mode (P. 135).

B [Select Preset] button
Select from angles preset on the camera.

W Viewer PTZ button
Displays a region of the camera video, zoomed in to fill the video window.

B Panorama display button
Change the camera angle by specifying a position on the camera’s panorama image.

=] Note

e |f the camera is idle for one minute, camera control is released automatically. A count down message is displayed 10 seconds
before the release. If you want to keep control of the camera, operate the camera or click [Advanced] before the countdown ends.

¢ |f you want to move the video window while you are in control of the camera, drag the title bar.

® You can also control the camera while recording. If the camera angle to be used during recording has been set, the camera
returns to the set position when the Viewer releases camera control.

e You must first configure the presets on the camera before using this feature. For details, please refer to the camera manual. When
digital PTZ positions are registered in the camera's presets, set the video format to [Digital PTZ (JPEG)] (P. 125).

Zoom In/Out Using Area Zoom

1 Click the Area Zoom/Drag to Move button to set it to .
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2 Drag in the video window.

Drag left to right to display a rectangle and the video window zooms in on the area inside the rectangle.

ECamera 002 ECamera 002

Adjust the Angle Using Drag to Move

1 Click the Area Zoom/Drag to Move button to set it to .

2 Drag in the video window.

Drag the camera in the direction you want to point it in. An arrow appears and the camera direction changes, and
you can release the mouse button to stop. The longer the arrow, the faster the camera moves.

ECamera 002

B Use Pan/Tilt/Zoom from the Video Window

You can also use the pan/tilt/zoom feature from the video window.

Centering operation using Drag the slider or click [+] or [-]
[+] to operate the zoom

E|Camera 001
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If the view does not center on the desired location the first time, keep clicking the location until it centers.

C500

Zoom is unavailable when the camera’s digital zoom is set to [Disable].

C50F

Pan/tilt/zoom is unavailable if a fixed camera or an external camera, such as the VC-C50i, is used.

About Digital Zoom

When [Digital Zoom] is set to [Enable] on the camera’s Setting Page, digital zoom operations are made possible and
the maximum telephoto for the optical zoom is displayed on the zoom slider.

Similarly, when [Enhanced Digital Zoom] is set to [Enable] in the camera's Setting Page, enhanced digital zoom
operations are made possible and the maximum telephoto for the optical zoom and the enhanced digital zoom are
displayed on the zoom slider.

Maximum telephoto of enhanced digital zoom

Maximum telephoto of optical zoom

™ Important

The maximum telephoto for the enhanced digital zoom will be displayed even when [Digital Zoom] is set to [Disable] and
[Enhanced Digital Zoom] is set to [Enable] in the camera settings, and zooming until the image becomes distorted will be
possible.

(=] Note

¢ When using digital zoom, the picture quality decreases as the zoom ratio increases.

e Enhanced digital zoom is digital zoom that can be used without drops in picture quality. The range for enhanced digital zoom will
vary depending on the video size configured in [Video Receive Size].

The maximum telephoto of enhanced digital zoom is not displayed on the zoom slider.

Change the Camera Angle Using a Panorama Image
Change the camera angle by specifying a position on a panorama image.

1 Click m in the [Camera Control] dialog box to display the [Panorama] window.

2 Change the camera angle and zoom using the frame displayed on the panorama image.

- Panorama “

The frame is yellow when you have control of the camera. Drag the frame to change its size and zoom the camera
infout.

JOMBIA BU} UM OBPIA JOHUOI
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Drag the center of the frame to move the frame and change the camera angle.

If you draw a rectangle anywhere on the panorama image, the frame is redrawn at that location and the camera
angle and zoom change correspondingly.
The frame is blue when you do not have control of the camera.

S80xMKII §S90xMKII H630]H610 I M7201H710 JM620 M600 {M720 § M700 § C500 | C50F JS800VEFS910F

[Panorama] is unavailable.

=] Note

You must first register a panorama image on the camera before using this feature. For details, please refer to the camera manual.

Play Back Audio

If the audio feature on the camera is used, you can play audio or send audio using a microphone. Select [Window] > [Audio

Panel] to open the audio panel.

™ Important

® You cannot send and receive audio from multiple Viewers simultaneously.

¢ The sending and receiving of audio is set to 10 minutes by default. The set time can be modified in [Viewer Settings]. For details,
please refer to “Configure the Viewer Display and Operation Settings” (P. 122).

Audio “

(] ,' Listen to Audio

/'. Use Microphone

M

)

@)

(4)

(5)

(6)

7)

[Listen to Audio]
Starts audio playback.

[Use Microphone]
Starts audio transmission.

Show options button

Displays the options for the [Audio] panel.

[Play audio also while using microphone]

- Audio

(] ,' Listen to Audio

/'. Use Microphone

M Play audio also while using
microphone

M Use silence detection to reduce
network traffic

Select if you want to play audio even when using a microphone.

[Use silence detection to reduce network traffic]
Select if you want to detect silent segments when sending audio. Decreases the amount of data transmitted during
silent segments to decrease the load on network bandwidth.

[Settings]

Displays the [Silence Detection Settings] dialog box.

Hide options button

Hides the options of the [Audio] panel.

Silence Detection Settings

Select the [Use silence detection to reduce network traffic] check box on the [Audio] panel to set the silence

detection sensitivity.

Click [Settings] to display the [Silence Detection Settings] dialog box and adjust the silence detection sensitivity.



- Silence Detection Settings

(@) Use the default sensitivity setting (1)

() Set the sensitivity manually

Low High

(1) [Use the default sensitivity settings]
Uses the default sensitivity for silence detection.

(2) [Set the sensitivity manually]
Drag the slider to set the detection sensitivity.

Compensate for Dark Regions in the Video

Use the viewer shade control to compensate for any dark regions in the video.

1 Click the video window menu button to display the menu.

2 Click [Viewer Shade Control] and select the amount of shade compensation from the submenu.

JOMBIA BU} UIM OBPIA JONUO

Video window menu button

Release

Presets 3

Audio Panel

Viewer Shade Control v @ | O

Video Display Size » Low
Video Format 3 Medium
Video Receive Size ’ High
Properties Very High
Callout Window

Close

o [Off]
Disable the shade control.

e [Low]/[Medium]/[High]/[Very High]
Enable the shade control. View the video window and select a compensation value that gives the appropriate
brightness.

E Note

e You cannot apply this feature to more than one video window.

® The viewer shade control is a feature of the Viewer, not the camera. Therefore, it can be used for both live and recorded video
playback.
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Start recording while watching the live video. You can use this to immediately record during a period where there is no
recording schedule set. The recording format is always set to JPEG.

1 Click the video window displaying the video to be recorded.
A light blue frame is displayed surrounding the selected video window.

2 Click [Record Now] on the toolbar.

p Untitled1 - SS01 - Canon Network Video Recording Software RM Viewer
File Edit View Layouts Settings Window Help

|EtaynuL< B Grds  Zoom: (<) |-Evc:-n:m\-:amem [ Capture 57 Viewer PTZ | @, Search

‘
l

Camera 001

Recording starts. The upper part of the window is red when recording. Recording stops automatically after the
set time period has passed.

The maximum frame rate is five fps.

m Important

e [Record Now] records at the maximum frame rate. Be sure to take into account how much hard disk space is used.

e The recording duration can be specified, however, the actual duration may depend on various settings and on network delay.

(=] Note

e Audio is also recorded if audio is available from the camera.

e The [Record Now] duration can be changed. For details, please refer to “Configure the Viewer Display and Operation
Settings”(P. 122).
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View Recorded Video

Search for a Recording

You can search for recorded video using the timeline or the search function.

B Search by Changing the Timeline

Video is displayed on the timeline by the recorded period or event. You can search for and play back video using the
timeline.

1 Click the video window.

2 Drag the timeline to display the time and date for the recording.

N P | Camera 001 2] Search Tump

o T
Scroll Backwards Scroll Forwards
Back 1 day Move the displayed time by dragging this section left or right. Forward 1 day
Back 1 week Forward 1 week

=
9
3.
=
5]
]
<
I
)
S
g
=
0
=
=
]
<
9]
=
)
)
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3 Click an event in the event display area.

- # Search Tomp

Events associated with the selected camera
Recorded Video
Events not associated with the selected camera.

Events displayed as film icons are videos recorded for that period. Click the event to play the recording.
Events associated with the selected camera are also displayed in the event display area. (The color of these
events represents their priority.) Click the event to play the recording.

=] Note

e Events in the display area that are not associated with the selected camera (secondary events) are displayed as transparent. If
you do not select a camera, all events are displayed as primary events (not transparent).

e Click [View] > [Timeline] to display/hide the timeline.

B Search by Specifying the Time and Date

To view recorded video from a specific time, specify the time to play back the video.

1 Click the video window.

2 Click [Jump] on the timeline to display the [Jump to Time] dialog box.



3 Specify the date and time and click [OK].

- Jump to Time “

Enter a date and time to display

4 October 2014 »

Sun Mon Tue Wed Thu Fri  Sat
23 29 30 ? 2 4
5 6 7 8 9 10 T
2,13 14 15 1@ I B
0 20 25 2 2B 24 25
% 21 28 @ 30 3N 1
2 3 4 5

Today: 11/5/2014

Time: |16:51:48

| CK || Cancel |

The playhead moves to the specified date and time and the recorded video starts playing in the video window.

M Search by Event

Click [Search] on the toolbar or [Search] on the timeline toolbar to search for an event. Click the event in the search
results to play the associated recording. For details, please refer to “Play Back an Event” (P. 120).

Play a Recording

Use the playback controls on the timeline to control the video displayed in the video window.

Play/pause

Fast reverse Fast forward

Go to previous frame  Go to next

Jump to previous frame Jump to next event

Click an event to move the playhead to the playback position.

S

Drag the playhead to change the playback position.

Fast reverse (each click changes the speed in sequence: 1x, 2x, 5x, 10x)
Fast forward (each click changes the speed in sequence: 2x, 5x, 10x)

B Video Window Display for Playback

[¥]Camera 001 14:41:35 | —(2)

(1) Playback indicator
Displays the playback status.
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(2) Title bar
Displays the camera name and the time and date of the recording.

m Important

e You cannot use [Fast Reverse], [Previous Frame], and [Next Frame] for recordings in MPEG-4 or H.264 format.

* Because video data is being sent from the Storage Server to the Viewer during playback, playback response and smoothness
depends on factors such as the amount of network traffic.

* The time displayed on the timeline corresponds to the clock on the computer where the Viewer is running.

e To play back a recorded video, set a time earlier than the current time that will allow recording 10 frames. Although you can play back
images that are currently being recorded, playing back from a point that is less than the duration it takes to record 10 frames (e.g.,
100 sec. when the recording frame rate is 0.1 fps and 10 sec. when it is 1 fps) from the current time may result in temporary skipping.

[E] Note

e You can play video from multiple cameras simultaneously.

e You can display recordings from one camera in multiple video windows. You can also play video recorded at different times
simultaneously.

e Click [Live] on the timeline toolbar during playback to return to the live video.

Zoom a Region of the Video (Viewer PTZ)

You can zoom a region of the camera video in the video window using Viewer PTZ.

When the actual camera is fixed in position, you can use this function to control PTZ in the viewer to zoom in on a region of
the video.

This function is available for live video and for recorded video during playback.

B Start Viewer PTZ

1 Click the [Viewer PTZ] button on the toolbar or on the camera control panel.
The Viewer PTZ panel appears.
2 Click the video window in which to use Viewer PTZ.
A light blue frame is displayed surrounding the selected video window.
3 Specify the region you want to zoom by clicking or dragging in the Viewer PTZ panel.

A preview frame (yellow) appears around the specified region, and the video within the frame is zoomed in and
displayed in the video window.
When the video is displayed zoomed in, a zoom icon appears in the bottom right corner of the video window.

E| Camera 001

Zoom icon

=] Note

e Viewer PTZ uses the digital zoom function, hence the quality of the video decreases as the zoom ratio increases.
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e Saving a snapshot image of the recorded video saves a snapshot of the whole video, not the zoomed in region.

e Viewer PTZ can be used in up to five video windows simultaneously. Using Viewer PTZ in additional windows after reaching this
limit will cause Viewer PTZ to be released from other windows in sequence from oldest to most recent, according to the PTZ
history.

® The preview frame can be moved or resized by clicking or dragging the frame.

W Exit Viewer PTZ

Double-click anywhere within the Viewer PTZ panel.

The preview frame is cleared, and the display returns to the original video.

To exit Viewer PTZ from all video windows at the same time, right-click the Viewer PTZ panel and select [End Viewer
PTZ (all video windows)].

E Note

Even when the Viewer PTZ panel closes, Viewer PTZ operation continues.

Save Part of a Recording

You can save a part of a recording with a length of up to one hour to a file.
Extracted video is saved in .mov format. For playback, a media player compatible with .mov files can be used. However,
playback using media players is not guaranteed.

1 Select a recording on the timeline.
2 Click [Extract] on the timeline to display the [Extract Video] dialog box.

3 Specify the time range for the video to be extracted.

I a8 Extract Video n |
From: [11/ 5/2014 G- l17:01:00 (1)
S 1V I B ||17:01:00

Include audio if availabl (2)
| OK || Cancel |

(1) [From]and [To]
Specify the date and time of the start and end positions.

(2) [Include audio if available] check box
Clear the check box if you do not want to include audio in the file.

4 Click [OK].
The [Save As] dialog box appears.

5 Specify the file name and storage location and click [Save].
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m Important

L]

You can extract a video from only one video window at a time.

Do not specify the Windows folder or the Program Files folder on the system drive as the destination. Video cannot be saved to
these folders.

You cannot save only audio data.

When extracting a time range that contains different video formats (such as JPEG and H.264), divide the range by format and
save each video segment individually.

When the data size of video being extracted reaches 2 GB, extraction will stop and the video extracted to that point will be
saved, even if the specified end time has not been reached.

Play back the .mov file to check if the specified length of video was saved.

Video that exceeds 2 GB in size cannot be saved. Adjust the video extraction range so that the data size does not exceed 2 GB.
You can calculate the data size using the Required Disk Space Calculator or Data Size and Bit Rate Estimates table found on
the Canon website.

Block noise may appear when an extracted H.264 video is paused during playback.

Initially, noise may be present when playing back extracted video recordings that include audio.

Save a Snapshot of the Displayed Video

You can take a snapshot of the displayed video and save a still image.

1

Click [Capture] on the toolbar to display the [Capture Still Frame] dialog box.

2 Set the still image to be saved.

- Capture Still Frame

¢

Camera 003 - 11/5/2014 5:02:47 PM

[¥/] Display camera name [/] Display timestamp

‘ Save As... | | Cancel

(1) 2 O

(1) [Display camera name] check box
Select this check box if you want to add the camera name to the still image.

(2) [Display timestamp] check box
Select this check box if you want to add the time and date to the lower right side of the saved still image.
(You cannot specify the position, font, size or color.)

(8) [Save As]
Save the preview video.

3 Click [Save As].

The [Save As] dialog box appears.

4 Specify the file name and storage location and click [Save].

The file is saved in the specified location and the focus is placed on the [Capture Still Frame] dialog box again.
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5 Click [Cancel] to close the dialog box.

[ Important

¢ |fthe camera is disabled on the [Advanced] tab of the camera properties, or even if the power of the camera is off, a still image
of the recorded video during playback can be saved.

¢ Do not specify the Windows folder or the Program Files folder on the system drive as the destination. Video cannot be saved to
these folders.

E Note

® You cannot operate the preview when displaying the [Capture Still Frame] dialog box. You must operate the camera in advance
to set its angle. For details on operating the camera, please refer to “Operate the Camera” (P. 105).

* The .bmp file format is used for still images.

e The camera clock is used for the date and time of the on-screen display function, but the clock on the computer running the
Viewer is used for the date and time of snapshots.

¢ |f the text display position for the camera's on-screen display function is too low, it may overlap with the snapshot display. We
recommend displaying text for the camera's on-screen display function in the top-right or top-left corner.



Check Events

View a Live Event

You can display past events in the [Live Events Log] window.

) Live Events Log - O R

(1) | Event Camera Name / Host Nam... |E| Priority |E|
Manual Recording Started (...
Manual Recording Started (...
Manual Recording Started (...

Manual Recording Started (...

When the Viewer launches, you can open the [Live Events Log] window to show all events that occurred within the last hour.
The top row in the list shows item names. You can sort events in the list by clicking in a column to specify the item to sort by
and the sorting order.
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9 Important

A maximum of 200 events can be displayed in the [Live Events Log] window.

(=] Note

e Click [Window] > [Live Events Log] to display the [Live Events Log] window

® You can change the display priority for the [Live Events Log] window. For details, please refer to “Configure Event Notification and
Priorities” (P. 123).

B Eventlcon Colors

Different colored icons are displayed for events, depending on the priority.

Icon color Priority
Red Highest
Orange High
Yellow Medium
Light Green Low
Green Lowest

=] Note

® You can change the event priority.

e Motion detection recording, sensor detection recording, intelligent function recording, and volume detection recording priorities
can be specified when setting the recording mode of a recording schedule (P. 78).

e Other event priorities can be specified when setting the Storage Server Group. (P. 64)
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B Acknowledging an Event

By default, when a [Highest] priority event is displayed in the [Live Events Log] window, an icon is displayed
indicating that you should acknowledge the event.

) Live Events Log S
Priority |E|

(1) | Event Camera Name / Host Nam... |E|
Manual Recording Started (.
Manual Recording Started (...
Manual Recording Started (...
Manual Recording Started (...

When this icon appears, the event flashes until acknowledged by a user for the time period set in [Viewer Settings]
dialog box’s [Flash event indicator for:]. To stop the blinking, follow these steps to acknowledge the event.

1 Click the event to be acknowledged in the [Live Events Log] window.

2 Click [Edit] > [Acknowledge Event].

™ Important

If [Show Video Window on Event] is enabled in [Viewer Settings], the corresponding video window is brought to the front
automatically. The size of the video window is always [320x240] pixels.

=] Note

You can disable event acknowledgement in [Viewer Settings]. You can also change the priority of events that need to be
acknowledged. For details, please refer to “Configure Event Notification and Priorities” (P. 123).

Search for Events

You can search for past events that have occurred. You can play back video of searched events.

1 Click [Search] on the toolbar to display the [Event Search] dialog box.

2 Specify the search criteria.

=] Event Search = =l 7
To search for events, enter the search citera below and ciick Search, [ (M
IDEKn-pm: Event, Camera, Priority or Tag I |whg,.; Today o l (2)
sion | [Advanced Search >} (4)
Sesrch Restilis= L (3)

) Event [¥] storage Server Group [] cameraName/HostName Servens  [¥] Priority [¥] Date&Time |

(5)
[ (6)
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(1) [Description]
Enter the search criteria (event, camera, priority, camera tag, or host name).

(2) [When]
Specify the period in which the target event occurred ([Today], [Last 2 Days], [This Week], [This Month],
[This Year], and [All Dates]).

(3) [Search] and [Stop]
Start searching or stop a search in progress using these buttons.

(4) [Advanced Search]
Click to specify detailed search criteria.

(5) [Search Results]
Displays the search results.

(6) [Play Back Video]
Plays back the recording associated with the search results.

3 Click [Search] to start searching.

E Note

To display the [Event Search] dialog box when the toolbar is hidden, click [Search] on the timeline or click [Edit] > [Event Search].

JOMBIA BU} UIM OBPIA JONUO

Advanced Search RVI-64/25/9
Click [Advanced Search] in the [Event Search] dialog box to specify detailed search criteria.
=3 Event Search = = 7

To search for events, enter the search criteria below and dlick Search.

Description: | Event, Camera, Priority or Tag When; | Today = (1)

o 12/ Y2014 00: 00: 0O Tor 127 3/2014 23: 50 59 ———(2)
—Event: All Events v | Status: | All Statuses - Priority: | All Priorities -

Search Target: [Not Specified -

Search Results:

@  Event || Stofage Server Group [=] camera Name/ Host Name (server) | [=]  priority [¥] Date&Time |[¥] Tags d

2

3) (4) (5) (6)

(1) [When]

Select [Specify Date Range] to specify the search period.

(2) [From]and [To]
Select [Specify Date Range] in [When] to specify the start and end times and dates for the search period.

(8) [Event]
Select the type of events to be searched.

(4) [Search Target]
Specify an active filter type (storage server group name, camera name, camera tag), and select the target of the
search in each submenu.

(5) [Status]
Specify the status of the events ([All Statuses], [On], [Off]).

(6) [Priority]
Specify the priority of the events to be searched.
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M Play Back an Event

If a recording is associated with an event in the search results, right-click the event and click [Play Back Video] to
play back the recording in the video window of the corresponding camera.

If the video window is not displayed, clicking [Play Back Video] will automatically display the window and start
playback.

m Important

When a dynamic layout is displayed, the video window is not automatically displayed.

E Note

Click [Live] in the timeline toolbar after playing in the video window to display the live view.
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Chapter

Viewer Settings

This section describes the Viewer layout, event notification settings, and settings for the Viewer.
Once the settings in this chapter are configured by an administrator, the Viewer can be used to monitor video.
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Configure the Viewer

Launch the Viewer and configure it for day-to-day operations.
For details on how to launch the Viewer, please refer to “Launch the Viewer” (P. 100).

Display

the [Viewer Settings] Dialog Box

Click [Setting

s] > [Viewer] to display the [Viewer Settings] dialog box.

Configure the Viewer Display and Operation Settings

1 Click the [General] tab.

2 Configure each item.

= Viewer Settings “
General . .évent.i.l.(;ti.'l.'l.cat.i;n i:_;.'ent Dlspla_'.cI
| - Video Viewing Settings
Maximum Live Frame Rate : : 5 % | frames / sec. (1)
Manual Recording Duration : . 60 | seconds (2)
Auto adjust frame rate under heavy load (3)
Use large captions for video window title bars (4)
Confirm when changing to full screen mode (5)
| - Layout Settings
Prompt to save changes when layouts are closed (6)
| Audio Sending and Receiving Settings
Timeout Before Ending : 10 minutes (7)
Time Qut-of-Sync Warning
Send notification when time is out-of-sync with the storage server group (8)
| OK | | Cancel
(1) [Maximum Live Frame Rate]
Specify the maximum live view frame rate.
(2) [Manual Recording Duration]
Specify the [Record Now] recording time, from 30 to 300 seconds.
(3) [Auto adjust frame rate under heavy load]
Automatically adjust the display frame rate.
(4) [Use large captions for video window title bars]
Increase the title bar text size of the video window.
(5) [Confirm when changing to full screen mode]
Display a confirmation message when switching to full screen mode.
(6) [Prompt to save changes when layouts are closed]
Display a confirmation message when a layout in the Viewer is closed. The message is not displayed if the
layout is not changed.
(7) [Timeout Before Ending]

Automatically stop two-way audio communication after the specified period, from 1 to 60 minutes.



You can also specify 0 minutes. However, two-way audio communication will not stop automatically in such
cases, so you must stop it manually. We recommend setting an arbitrary timeout duration to avoid
unintentional continuation of audio communication.

(8) [Send notification when time is out-of-sync with the storage server group]
Display a message if there is a time difference of five seconds or longer between the Storage Server and the
Viewer computer when connected to a Storage Server Group.

Configure Event Notification and Priorities

1 Click the [Event Notification] tab.

2 Configure each item.

- Viewer Settings

N

General Event Notification Event Display

Show Events in Live Events Log

Equal to or higher than: Lowest “

Show Events in Timeline

Equal to or higher than: Lowest v

I
|
S
sBbumes Jemaip

Show Video Window on Event
Equal to or higher than: Highest u

Operator Notification
Equal to or higher than: Lowest v
Flash event indicator for: 10 seconds

Play audio alert
Display event indicator during playback

Acknowledge Event

Equal to or higher than: Highest v

| OK || Cancel |

(1) [Show Events in Live Events Log]
Display an event in the [Live Events Log] dialog box.
[Equal to or higher than]
Specify the priority of events to be displayed.
Event priorities are configured in RM Manager (P. 64).

(2) [Show Events in Timeline]
Display an event on the timeline.
[Equal to or higher than]
Specify the priority of events to be displayed.

(8) [Show Video Window on Event]
Automatically display the camera’s video window when an event occurs.
[Equal to or higher than]
Specify the priority of events for which a video window is displayed.

(4) [Operator Notification]
Notify the Operator (guest user) that an event occurred.
[Equal to or higher than]
Specify the priority of events to be notified.
[Flash event indicator for]
Specify the time the event indicator flashes right after the event occurs, from 1 to 99 seconds.
[Play audio alert]
Beep when an event occurs.
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[Display event indicator during playback]
Display an event during playback.

(5) [Acknowledge Event]
Prompt the Operator (guest user) to acknowledge an event.
[Equal to or higher than]
Specify the priority of events to be acknowledged.

You cannot change the [Show Video Window on Event], [Operator Notification], and [Acknowledge Event]
settings.
Configure the Display/Hide Mode for Each Event RM-64/25/9

Specify the types of events displayed in the [Live Events Log] dialog box and on the timeline.

1 Click the [Event Display] tab.

2 Specify whether or not to display each type of event.

- Viewer Settings

General Event Netification . Event Display

Show the following events in the Live Events Log and Timeline:
Recording Events

Motion Detection

Sensor

Manual Recording

Intelligent Function Triggered
Volume Detection

Scream Detection

Linked Event

[C] "OFF* Events for above events
[] Recording Started or Stopped

Other Events

Recording Frame Rate Changed

Low Disk Space Waming

Delete recorded files (when disk space is insufficient)
Delete recorded files (when disk space is low)
Recording Faulted or Restarted

Camera Communication Ermor

Storage Server Started or Stopped

Storage Server Communication Error

| OK || Cancel |

Events from and higher than the level set in the [Event Notification] tab will appear on the [Live Events Log] or
timeline, however, if this check box is not selected, those events will not appear.

Events that do not reach the level specified in the [Event Notification] tab will not appear even if this check box is
selected. To make sure events of that level appear, set a higher priority level.



Configure the Video Window

You can configure the video window settings, including the window size, video format (JPEG or MPEG-4) and video
resolution.

Change the Video Window Size

1 Select a camera and open the video window (P. 103).

2 Click the video window menu button to display the menu.

N

Video window menu button

sbupag 1amaipn

Get Camera Control

Presets

Audio Panel

Viewer Shade Control 3
Video Display Size 3
Video Format 3
Video Receive Size 3
Properties

Callout Window

Close

3 Click [Video Display Size] and select the video window size from the submenu.

Switches the size of the video window to the specified video size.
Uses the [Video Receive Size] when that option is selected.
Video is displayed full screen when [Full Screen] is selected. To return to the normal screen, press the Esc key.

=] Note

e Drag any corner of the video window to resize it.

e |f the video window size selected in the [Video Receive Size] submenu is greater than [640 x 480], the load on the CPU will
increase and the Viewer may operate more slowly.

e Depending on the grid type that is selected for grid display, some of the [Video Display Size] submenus are grayed out and
cannot be selected.

If the video receive size and video display size have a different aspect ratio, black bands may be displayed along the left/right
edges or top/bottom edges of the video.

Change the Video Window Format

1 Click the video window menu button to display the menu.

2 Click [Video Format] and select the video format from the submenu.

125



126

m Important

e The available formats depend on the camera selected in the submenu.

e |ive video and audio are not synchronized for [MPEG-4], [H.264], or [H.264(2)].

S30MKII | S3TMKII

[Digital PTZ (JPEG)] cannot be selected for [Video Format].

Change the Video Window Resolution

1 Click the video window menu button to display the menu.

2 Click [Video Receive Size] and select the resolution from the submenu.

Select [Default] to use the camera’s resolution.

m Important

When you display more than one video window for the same camera, changes to the resolution of one of these windows are
applied to all of the other windows.

E Note

e |f you save the layout (P. 129), the [Video Receive Size] setting is also saved.

¢ The size used for [Default] is determined the first time you display a video from the camera. The size on the Viewer will not
change, even if you change the size setting on the camera.

Configure the Callout Window Mode RM-64/25/9

The video window can be viewed as a pop-out video in the Callout Window mode. By displaying the pop-out video above
the background image of a map or floor plan it can be viewed as a map display for the video layout.
Callout Window mode can be used with grid (P. 129) set to [None] or [Alignment].

1 Right-click on the video window and select [Callout Window].

Get Camera Control

Presets
Audio Panel
Viewer Shade Control

Video Display Size

Video Format

Video Receive Size

Properties
Callout Window

Close

The video window changes to Callout Window mode.



By clicking the edges of the video callout window or the anchor, you can switch between two video window sizes.

Main Office - S501 - Canon Network Video Recording Software RM Viewer

51 Viewer PTZ \ @ Search

Anchor

N

E Camera 003

sbupag 1amaipn

2 Drag the anchor to move the callout window.

Operation During an Event

If an event occurs when using Callout Window mode, the display will change as follows.
e The callout window switches to the larger size if the video window is currently at the smaller size. The callout

window returns to the normal size after a certain amount of time passes post-event.

e The anchor flashes.
e The callout window moves to the front if multiple overlapping video windows are being used.
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Configure the Video Window Layout

You can place a video window anywhere in the viewing area by dragging it to the desired location.

You can save the size and position of a video window in the Viewer as a layout.
The following special layouts are also provided:

¢ Dynamic layouts [RM-64/25/9

Specify criteria, such as camera tags and events, to only display video windows that meet the criteria. You can also

select a pre-defined dynamic layout.

e | ayout Sequences RM-64/25/9

Sequence through multiple layouts you have created at a certain time interval.

E Note

When the Viewer launches, it displays the layout that was being displayed when the program last ended. A new layout with the name
“Untitled” is opened the first time the Viewer is launched. You can save the layout with a name after you place a video window.

Apply the Layout

When you select a pre-installed layout or a layout you saved yourself from the [Layouts] menu, the video windows will be

displayed in the selected layout.

= Tag: checkout - S501 - Canon Network Video Recording
File Edit View | Layouts | Settings Window Help

Mew Layous &7 Viewer PTZ |

New Dynamic Layout...
New Layout Sequence...

Save Layout Ctrl+S
Save Layout As... Ctrl+Shift+S

Properties...
Crganize Layouts...
Layout Grids

Resume Layout Sequence

) ss01
3 User

-

Tag: carpark
Tag: checkout

(o=}
=
=]

All Cameras

Recording Cameras 3 Tag: entrance

Simple Layout Tag: exit

Tag: inside

Tag: outside

e [Simple Layout] is a layout that is automatically created based on the number of cameras registered on each recording

server group. The viewing area is split based on the number of registered cameras.

Number of registered cameras Viewing area split layout
1to 4 2x2
5t09 3x3
10to 16 4x4
171025 5x5
26 to 64 6x6

e The maximum number of video windows that can be displayed in a single layout is 32. Therefore, even when the viewing

area split layout is 6x6, video from only 32 cameras will be displayed.
e [Simple Layout] does not display video from cameras in different storage server groups.

e [Simple Layout] is created when you connect to the storage server group to which the cameras are registered for the first
time, and it splits the viewing area according to the number of registered cameras and the size of the Viewer window.
e |f you want to update the [Simple Layout] after adding cameras, for example, delete or rename [Simple Layout], connect

to the storage server group again, and then select [Simple Layout] again (P. 133).

RM-64/25/9
e When changing the size of the viewing area, reconfigure the grid size (P. 129).



Save the Layout

After configuring the display and position of the video windows, follow these steps to save the layout.

1 Click [Layouts] >[Save Layout].

2 Change the layout name as required, and click [OK].

E Note

In the storage destination there are two options: [Shared Layouts] and [User Layouts].
Only an administrator (or users with permission to edit shared layouts) can save in [Shared Layouts] (P. 62). However, all users can

use saved layouts.
Layouts saved in [User Layouts] are not available to other users.

Configure the Grid

You can display a grid consisting of dots or solid lines in the viewing area of the Viewer. The video window has a neat and
tidy appearance because it is displayed according to the grid. When a solid grid is displayed, the size of the video window
can be adjusted to the grid.

1 Click [Grids] on the toolbar.

2 Select the type of grid.

e [None]
Do not display a grid. You can put the video window where you like.
e [Alignment]
Display a dotted grid. You can put the video window adjusted to the position of the dots.
e [160x120] / [320x240] / [640x480] / [160x90] / [320x180] / [640x360]
Display a solid grid with the specified size.
e [Custom]
Displays the [Custom Grid] dialog box.

E Note

If the video receive size and video display size have a different aspect ratio, black bands may be displayed along the left/right
edges or top/bottom edges of the video. To set a video window with 16:9 aspect ratio, set a custom grid where [16:9] is specified for
[Aspect Ratio].

B Configure a Custom Grid RNF64/25/9
Selecting [Custom] as a grid type displays the [Custom Grid] dialog box, where you can configure the size of the
grid.

= Custom Grid “
Aspect Ratio : 4:3 _—(1)
Horizontal : 640
—
Vertical : 480
| OK | | Cancel |

(1) [Aspect Ratio]
Specify the aspect ratio of the grid frame ([4:3] or [16:9]).

(2) [Horizontal] and [Vertical]
Specify the number of horizontal and vertical pixels in the grid frame.
Changing the value for one of the items changes the value in the other box to maintain a constant aspect ratio.

N
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Configure a Dynamic Layout

RM-64/25/9

1 Click [Layouts] > [New Dynamic Layout] to display the [New Dynamic Layout] dialog box.

CFile Edit View | Layouts | Settings Window Help

5501

User

New Layout...

New Dynamic Layout... :
New Layout Sequence...

Save Layout Ctrl+S

Save Layout As... Ctrl+Shift+5

Properties
Crganize Layouts...
Layout Grids

Resume Layout Sequence

2 Specify the criteria for the video windows displayed in the dynamic layout.

Layout Name :

MNew Dynamic Layout

Display cameras that:

(® Any of the following are met

O
O
O
O
O

() All of the following are met

When conditions are not met, continue displaying cameras for | 30

seconds (3)

(1)

@)

[Layout Name]

Enter the name of the dynamic layout.

[Display cameras that]

Specify the display criteria for cameras.
Click a check box to make a set of display criteria available, and then click each criteria list to select the
criteria. You can specify up to five sets of criteria.
The criteria are (from left to right), the property, operator, and status.

Property Status
Status ¥l [ s * || Recording hd
Operator

Property Operator Status
= (is)

Tags : Camera tags
# (isn’t)

Status = (is) Camera status (such as [Recording], [Idle], or
# (isn’t) [Error])
= (is) Event Type

Event Type # (isn't) (“Motion detection”, “Sensor”, etc.)
= (is) o

. ' . Event Priorit

Event Priority > (is equal or higher than) (“Highest” “yHigh" “Medium”, “Low”, “Lowest”)

< (is equal or lower than) ' ' ' '




Property Operator Status

= (is) The name of Storage Server Group to which the
# (isn't) Viewer is connected.

Storage Server Group

Select [All of the following are met] to display only cameras that meet all the criteria. Select [Any of the
following are met] to display cameras that meet any of the criteria.

(3) [When conditions are not met, continue displaying cameras for]
Specify how long a video window in the layout will remain displayed when it does not match the criteria

specified here.

3 Click [OK] to close the dialog box.
4 Click [Layouts] > [Save Layout].

5 Change the layout name as required, and click [OK].

[E] Note

The maximum number of dynamic layout video windows that can be displayed is 25.

N

Configure a Layout Sequence RM-64/25/9
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1 Click [Layouts] > [New Layout Sequence] to display the [New Layout Sequence] dialog box.

@
File Edit View | Layouts | Settings Window Help
New Layout...

New Dynamic Layout...

New Layout Sequence...

Save Layout Ctrl+S

Save Layout As... Ctrl+Shift+5
Properties

Crganize Layouts...

Layout Grids 3

Resume Layout Sequence Ctrl+R

= sso1 ’
3 User

2 Specify the layouts to be displayed in the sequence.

= New Layout Sequence
(1 ) ——— Sequence Name: |
(2) — Type: Shared Layout Sequence -—-
Available Layouts : Sequence Layouts :
4 | ) Shared Layouts Layout Name Interval (sec)

I I Each Tag

I I All Cameras

I I Recording Cameras — Add Layout >>
®) —(7)

Interval : {10 w sec. - (8)
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(1) [Sequence Name]
Enter the name of layout sequence.

(2) [Type]
Specify the type of layout sequence.

(3) [Available Layouts]
Displays a list of available layouts.

(4) [Add Layout]
Add the selected layout to the [Sequence Layouts] list.

(5) [Move Up] and [Move Down]
Move the selected layout up or down in the list to change the sequence order.

(6) [Remove Layout]
Remove a layout from the list.

(7) [Sequence Layouts]
Displays a list of layouts in the order of the layout sequence.
You can set the display time for each layout in [Interval (sec)].

(8) [Interval]
When a layout is added to a sequence, the set display time will be added here. The display time can be
changed after being added to [Sequence Layouts]. Specify from 5 to 9999 (sec.).

3 Click [OK] to close the dialog box.

Resume Layout Sequence

In the following situations, the layout sequence automatically stops.
¢ When you click the layout area
¢ \When you obtain camera control privileges
e \When you click [Grids] on the toolbar and select a grid type from the displayed menu
¢ When you open a menu on the menu bar
* When you switch to another tab or open a new tab
* When a layout property is canceled, e.g., because it was deleted by a Viewer on another computer
When stopped, “Paused” appears in the title bar as shown below.
e M OfGce|(Papscty [Main Qitice =500 = G
File Edit View Layouts Settings Window Help

o Back | [E= Layouts B Grids Zoom : . @ |

To resume a stopped layout sequence, click [Layouts] menu > [Resume Layout Sequence].
e Main Office (Paused) : Main Office - 5501 - Carx
File Edit View | Layouts | Settings Window Help

Back | E= New Layout..
New Dynamic Layout...

New Layout Sequence...

Save Layout Ctrl+S

Save Layout As... Ctrl+Shift+S
Properties

Crganize Layouts...

Layout Grids 3

Resume Layout Sequence Ctrl+R

= ss01 4
3 User

During full screen display, right-click anywhere in the viewing area outside the video windows and click [Resume
Layout Sequence], or press Ctrl+R to resume the sequence.



Organize Layouts

You can change the display order of menus, classify and organize layouts in folders, and edit the layouts.

1 Click [Layouts] > [Organize Layouts] to display the [Organize Layouts and Layout Sequences] dialog box.

E# Organize Layouts and Layout Sequences
[

4 ) Shared Layouts New Folder.. -
I I Each Tag Mo P,
I I All Cameras = =
I I Recording Cameras
'fB Main Office
) User Layouts

wnN =

—~ e~~~ o~ o~~~
e D o= -

N O O

N

(1) Layout tree
Displays a list of available layouts.
The layout tree uses the following icons:

Icon Description

sBbumes Jemaip

m Custom layout, Simple Layout

m Dynamic layouts

iﬂ Layout Sequences

0 Folder

(2) [New Folder]
Create a new folder.

(8) [Move to Folder]
Move the selected layout to a folder.

(4) [Move Up] and [Move Down]
Move the selected layout up or down in the list.

(5) [Delete]
Delete the selected layout from the list.

(6) [Rename]
Change the name of the selected layout.

(7) [Properties]
Displays the properties of the selected layout.
The properties displayed will differ according to the type of layout, as described below.

(Normal) Layouts
[Background]: Specify an image (a .bmp file or JPEG file) to be used for the background.
[Playback Options]: Specify how the video windows are displayed when the layout is opened.

Dynamic Layouts
This is the same screen as in step 2. in “Configure a Dynamic Layout” (P. 130). You can specify the
conditions for displaying cameras.

Layout Sequences
This is the same screen as in step 2 in “Configure a Layout Sequence” (P. 131). You can specify the layouts
that will be automatically sequenced.

(8) [Copy to Folder]
Copy the selected layout to a folder.
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[ Important

® You cannot change the name of the [Shared Layouts] and [User Layouts] folders.

e Only an adminstrator (or users with permission to edit shared layouts) can manage shared layouts (P. 62).

E Note

The settings in the [Organize Layouts and Layout Sequences] dialog box, such as the order of the layout sequence and the folder
types are also displayed when you click the [Layouts] menu, or when you click the [Layouts] button on the toolbar.
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Configure the [Advanced Camera Settings]

You can configure advanced camera settings used in video window display such as video quality, focus, and external
device output.

1 Click [Window] > [Camera Control].

2 Click the video window of the camera you want to configure and click [Control] on the [Camera Control] dialog box
to get control of the camera.

3 Click [Advanced] on the [Camera Control] dialog box to display the [Advanced Camera Settings] dialog box.

4 Click the tab that you want to configure.

N

5 After configuring the settings, click [Close].

m Important

e |f camera control is lost while the [Advanced Camera Settings] dialog box is open, you cannot continue configuring the settings.
Click [Control] on the [Camera Control] dialog box again to get control and continue configuring the settings. For details on
camera control privileges, please refer to “Set the Camera Angle” (P. 105).

sbupag 1amaipn

* [Advanced Camera Settings] while recording a video is only available when you have camera control privileges. If camera
control is lost, settings will return to the recording schedule settings.

¢ |f Intelligent Function detection settings are enabled when the camera position is fixed, the software cannot obtain camera
control privileges in order to configure advanced camera settings. In this case, configure the camera on the Setting Page of the

camera.
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Adjust the Video Quality

You can adjust camera video quality in the [Image Adjustment] tab.

o] Advanced Camera Settings E3

Image Adjustment | Focus and Speed | External Outputs
Exposure

Exposure: Auto

Compensation: o

Metering Mode: ® Center-weighted _ (1 )

) Average
) Spot

Smart Shade Control

Adjustment: Off —(2)
Haze Compensation

Haze Compensation: Off T (3)
Clear IR Mode

Clear IR Mode: Not supported —(4)
Aperture Mode

Night Mode: Disabled —(5)
Infrared

Infrared Not supported TR (6)
White Balance

White Balance: Auto - (7)

R Gaim: 0 0

BGan: 0 0 1023

Close

(1) [Exposure]

The settings change according to the selected exposure setting.

e [Auto]
Automatically control the exposure.

e [Auto (Flickerless)]
Reduce flicker from light sources, such as fluorescent lighting. The shutter speed is automatically adjusted
according to the lighting conditions.

e [Auto (Flickerless 2)]
Select this when flicker reduction with [Auto (Flickerless)] is not sufficient. As the auto adjustment range for the
shutter speed is suppressed to remain below 1/100 s when using this function, overexposure may occur.

e [Auto (Shutter Priority)]
Specify the shutter speed.

e [Auto (Aperture-priority AE)]
Specify the aperture value.
When [Exposure] is set to a value other than [Manual], setting items for exposure correction are displayed.

Exposure
Exposure : Auto (Shutter Priority) ~
Compensation : ] v

Metering Mode: @) Center-weighted

) Average
) Spot
Shutter: 1/30sec. 1/2 1/16000

[Compensation]: Specify exposure compensation. Select negative values to darken the video and positive values to
lighten the video.
[Metering Mode]: Specify the metering mode setting: [Center-weighted], [Average], or [Spot].



Metering mode | Description

Meters the entire scene, with an emphasis on the center.

[Center- Correct exposure is obtained for a subject near the center of the scene, even though the
weighted] periphery may be slightly darker or lighter.

Use for subjects that are in the center of the scene.

Meters an average of the entire scene.
[Average] A uniform exposure is obtained even when the scene has significant differences in brightness.
Use for scenes where, for example, cars are passing through or people are entering and exiting.

Meters the center of the scene.

The correct exposure is obtained for a subject near the center of the scene, irrespective of the
[Spot] brightness of the periphery.

Use if the subject is lit by a spotlight or is backlit, where the exposure should be adjusted to the

center of the scene.

[Shutter]: Specify the shutter speed when [Exposure] is set to [Auto (Shutter Priority)].

e [Manual]
Exposure ;
Exposure : Manual V
Iris : 5 5 32 <
@
Shutter: 1sec. 1 1/16000 g
Gain : 0 0 39 n
@
Compensate for the exposure manually. The following exposure compensation settings are displayed. é

[Iris]: Specify the iris setting. Drag the slider to the left to close down the iris and make the video darker or to the
right to open up the iris and make the video brighter.

[Shutter]: Specify the shutter speed.

[Gain]: Specify the gain (sensitivity to brightness). Drag the slider to the left to decrease the gain and make the
video darker or to the right to increase the gain and make the video brighter.

[ M44 JH730MKIl

[Auto (Aperture-priority AE)] in [Exposure] is not available.

(2) [Smart Shade Control]
Specify a value to use for the camera’s Smart Shade Control feature for live video.
[Off]: Display live video using Smart Shade Control value configured on the camera.
[Auto]: Set Smart Shade Control to automatic.
[1] to [7]: Select one of seven strength levels when setting the Smart Shade Control function manually.

(3) [Haze Compensation]
Specify a value to use for the camera’s haze compensation feature when displaying live video.
[Off]: Disable haze compensation.
[Auto]: Set haze compensation to automatic.
[1] to [7]: Select one of seven strength levels when setting the haze compensation function manually.

(4) [Clear IR Mode]
Specify whether to display live video while using Clear IR mode or not.
[On]: Display video with Clear IR mode enabled.
[Off]: Display video with Clear IR mode disabled.

™ Important

When [Clear IR Mode] is set to [On] for cameras equipped with both the Clear IR mode and infrared lighting functions, the configurations
on the camera will determine whether the infrared lighting is enabled.

(=] Note

When [Clear IR Mode] is set to [On], video will be black and white.

(5) [Aperture Mode]
Specify the camera aperture mode.
[Night Mode]
e [Disabled]
Disable the night mode function.
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e [Enabled]
Display live video in night mode.
e [Auto]
The camera automatically switches to night mode.

[ Important
When [Clear IR Mode] is set to [On], [Night Mode] cannot be specified.

[E] Note

When [Night Mode] is enabled in [Aperture Mode], video will be black and white.

(6) [Infrared]
Specify whether or not to use infrared lighting during night mode. Cameras without the infrared lighting feature will
always be set to [Not Supported].
[Off]: Record with infrared lighting disabled.
[Day/Night Operation]: Use infrared lighting together with night mode. Infrared lighting will be irradiated during night
mode.
[1] to [5]: Select one of five strength levels for the infrared lighting used during night mode when [Exposure] is set to
[Manual].

m Important
When [Clear IR Mode] is set to [On], [Infrared] cannot be specified.

(7) [White Balance]

Specify the appropriate white balance by selecting one of the camera’s light source settings displayed in the list.

If [Manual] is selected, use one of the following two methods to adjust the white balance.

e [R Gain] and [B Gain]
Specify the white balance parameters by dragging the sliders. Drag to the right to increase the gain (the sensitivity
to brightness).

e [One Shot WB]
Force white balance adjustment to a light source. Using a white object (such as a piece of white paper) as a
standard, fill the shot with the object and click this button.

m Important

When [Clear IR Mode] is set to [On] or when [Night Mode] is set to [Enabled], the white balance cannot be specified. If you select [Auto]
for Night Mode, however, you will be able to set the white balance, but those settings will be cleared when the camera switches to Night
Mode.



Adjust the Focus and Speed

You can use the [Focus and Speed] tab in the [Advanced Camera Settings] dialog box to adjust the focus and the pan/tilt/
zoom speeds.

- Advanced Camera Settings
Image Adjustment | Focus and Speed | External Outputs
Focus
) Autg (1)
Auto (for domes)
) Fixed at infinity 2)
) Manual (3)
Far Near:
Speed
Pan/Tilt: O Slow (4)
) Mormal
(®) Fast 7
Zoom: O Slow (5)
® Fast
=<
@
=
()
=
w
@
=
=
Q
[

(1) [Auto], [Auto (for domes)]
Automatically focus the video.
Use [Auto (for domes)] for cameras equipped with an indoor dome housing. The setting prevents the camera from
focusing onto the dome surface.
(2) [Fixed at infinity]
Fix the focal point at infinity.
(3) [Manual]

Adjust the focus manually by clicking the [Far] or [Near] button.
Click [One Shot AF] to focus once on the current subject and then return to manual focus.

(4) [Pan/Til]
Specify the panttilt speed ([Slow], [Normal] or [Fast]).

(5) [Zoom]
Specify the zoom speed ([Slow] or [Fast]).

C500

When the digital zoom on the camera is set to [Disable], the zoom speed is unavailable.
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Configure External Outputs

Use the [External Outputs] tab on the [Advanced Camera Settings] dialog box to configure output to external devices
connected to the camera.

@ Advanced Camera Settings [ = |
| Image Mjus{mentl Focus and Speed :LExtemaIOu't_putsJ:
[ — (1)
Output 1: Off ' On
Cutput 2 : * Off | On (2)
Close
(1) [Off]
Disable the external output.
(2) [On]

Enable the external output.
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Chapter

Backup

This chapter explains about the storage destination of data necessary for restoring the Storage Server, and
how to restore a backup.



142

Destinations of the Backup Files

Recording data, event data, and settings files are stored in the following folders on the drive specified according to Storage
Server drive settings (P. 67). Backing up these files will allow you to use them to restore the Storage Server.

B Recording Data

<Destination drive>:\Canon-NVR\videofiles
The following recording data file is backed up:

NVR3_MEDIA_  xxxxxxxx _ yyyymmdd _ hhmmss .edt
Camera ID Year, month and Time
day when
recording

started

Video being recorded is saved to a temporary file on the hard disk. By default, a recording file is created and saved
on the destination drive when the temporary file size reaches 1 GB or when 24 hours have elapsed since the start of
recording. This size can be changed using the [Maximum File Size/Duration] option on the [Recording Settings] tab
in the [Storage Server Group Settings] dialog box.

m Important

Recording data saved to the above folders is automatically deleted when the maximum storage period set in RM Manager has
elapsed. When disk space becomes low, data within the maximum storage period will also be deleted (P. 68). We recommend
that you make regular backups.

E Note

e Greenwich Mean Time is used for the time added to the file name of the recording data. Add or subtract the necessary time for
your time zone to determine the time for the data.

e This software uses lossy compression for the recording data. You do not need to compress the recording files further using a
tape drive or other devices.

Temporary Files

The following is a temporary file, before it is made into a recording data file by the system. This file cannot be backed
up using the standard backup method.

NVR3_UNINDEXED_MEDIA_  xxxxxxxx _ yyyymmdd _ hhmmss .edt
Camera ID Year, month and Time
day when
recording

started

B Event Data

<Destination drive>:\Canon-NVR\eventfiles
The following event data file is backed up:

NVRB_EVENT_ xxxxxxxx _ yyyymmdd _ hhmmss .evt
Camera ID Year, month and Time
day when
recording
started
Greenwich Mean Time is used for the time added to the file name of the recording data. Add or subtract the

necessary time for your time zone to determine the time for the data.




B Configuration Files

The settings for the Storage Server and the Viewer are saved in the following folders on the computer where the
program is installed. You must back up all of these folders to completely back up the configuration files.
<System drive>:\ProgramData\Canon\WebView\NVR30\

<System drive>:\Users\<User name>\AppData\Local\Canon\WebView\NVR30\

E Note

e The configuration file names are not displayed unless [Show hidden files and folders] is selected in the [View] tab of Windows
Explorer [Folder Options].

e You cannot use the OS’ shadow backup feature with this software.

e You can also use [Backup/Restore Configuration] in the [Tools] menu (P. 59) if you simply want to back up or restore settings
data.

Notes on Backup

e You do not need to stop recording to back up recorded data that is complete. However, the frame rate may
change because of increased disk 1/O load and/or CPU load.

e |f you want to restore a backed-up recording file, the computer you restore the backup to must have the same IP
address and drive configuration as the original Storage Server. For example, if the original Storage Server includes
a system drive and a recorded data drive, the Storage Server you restore the backup to must also have a system
drive and a recorded data drive. Determine the hard disk capacity based on the volume of data to be restored.

dnyoeg
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How to Restore a Backup

Restoring from Backup Data

Use the following procedure to restore a Storage Server from backup data:

1 Prepare a new Storage Server for the restore.
2 Install this software.

3 Stop the Storage Server.
For details on how to stop the Storage Server, please refer to “Stopping the Storage Server” (P. 144).
4 Restore the configuration file for this software to its original location.

The following folder is used by default:
<Systemdrive>:\ProgramData\Canon\WebView\NVR30\
<Systemdrive>:\Users\<User name>\AppData\Local\Canon\WebView\NVR30\

™ Important

¢ |f the configuration file is not properly restored, all settings will be reset to their default configurations.

e |f you upgraded the software from RM v4.0 or earlier, the maximum storage period for recorded data (P. 68) will be set to one
week by default. If the recorded data is restored with the default settings, any included data that is older than one week will be
deleted when the Storage Server starts up.

¢ |f the [Ensure video is kept for up to] option (P. 68) is set, any restored recording data that exceeds the specified storage period
will be deleted when the Storage Server launches.

5 Restore the recording files to their original location.

The following folder is used by default:
<Destination drive>:\Canon-NVR\videofiles\

6 Restore the event files to their original location.

The following folder is used by default:
<Destination drive>:\Canon-NVR\videofiles\

Launch the Storage Server.

Make sure that recording is performed correctly. Also make sure that the restored recording data plays back
correctly.

Stopping the Storage Server
The Storage Server runs in the background as a Windows service. When you restore backup data, you must follow
the following steps to temporarily stop the Storage Server.

1 Click [Start] > [Control Panel].
2 Click [System and Security].
3 Click [Administrative Tools].

4 Double-click [Services].



5 Double-click [RM Storage Server] to display [RM Storage Server Properties].

Double-click [RM-Lite Storage Server].

6 Click [Stop].

7 Click [OK] to close the properties.

=] Note

To restart the Storage Server, follow the same steps and click [Start] in step 6.

dnyoeg
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Chapter

Troubleshooting

This chapter includes solutions when you encounter problems and error messages that appear in this

software.
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Actions Required When Recording Errors Occur

When a recording error occurs (e.g., data is missing) during playback, you can troubleshoot the cause by checking the
information in the event log and the Storage Server log file.

Log

Event

Storage Server Log

Cause

Action

Error: Cannot Connect to
Camera

CameraServer
<host name>
disconnected
(<error content>)

A network error may have
occurred. Look for the cause of
the error by checking the
Winsock error code recorded in

the Storage Server log (P. 157).

Check the network (hub,
cables, etc.) for any problems
and make sure that the camera
is operating normally.

Recording frame rate
reduced due to high load
issues

The effective recording rate is

excessively low (50% or lower).

Sensor and motion detection
events may have been issued
too frequently.

The load on the Storage Server
CPU may be high.

Modify the recording schedule
and the motion detection
sensitivity.

Check the current CPU usage
and terminate any applications
that are a heavy load on the
CPU.

Recording paused
(Low disk space
<drive name>)

The load from writing recorded
data to the hard disk may be
too high.

Shorten the maximum storage
period or consider adding a
hard disk. Additionally, try to
modify the recording schedule.




Solutions When Viewer Problems Occur

If you encounter problems when you use the Viewer, refer to the following solutions:

Viewer and Video Windows

Problem

Solution

The pan, tilt and zoom feature of the
camera cannot be used in the video
window.

Double-click the video window or click [Control] on the [Camera Control] panel
(P. 105).

If video is being played (the title bar of the video window is gray), you cannot
operate the camera. Click [Live] on the timeline and get control of the camera.

When the video window is clicked to
display the [Video Window] menu, the
[Record Now] is grayed out
(unavailable). However the feature can
be used in another video window.

Display the camera properties for the video window and check on the
[Advanced] tab whether the camera is disabled. If the camera is disabled, click
[Enable Camera] (P. 51).

When you try to use the layouts created
by other users, layouts are not displayed
in the [Layout] menu, and cannot be
selected.

Layouts saved in the [User Layouts] folder cannot be seen by other users.
To allow all users to access layouts created by a user, the layouts must be
created by an administrator (or users with permission to edit shared layouts)
and must be saved in the [Shared Layouts] folder (P. 128).

The quality of video (live and recorded)
in the video window is low.

Change the receive size and display size settings. Depending on the receive
size and display size, the video quality may decrease. For example, if video
with a low receive size is displayed on a large video window, the video quality
will decrease. You can adjust the quality for recorded video with the advanced
recording settings.

None of the cameras will record.

Is the network cable for the server properly connected?

Was there a power outage?

Is “Do not Record” specified for a special day schedule?

If link lamps on the hub (switching hub) and on the network connector on the
server do not light, there may be a defect in the server’s cable, hub (switch), or
network connector.

Some cameras do not record.

Is the power and the network connection for the cameras working?
Do the cameras reply to a ping?

Can you view live video on the camera’s Viewer on the Storage Server
computer?

Is “Do not Record” specified for a special day schedule?

Is sensor recording or motion detection recording set?

The Storage Server cannot be
connected from the Viewer.

Are the login user name and password correct?

Is the network connection between the server and the Viewer working?
Is the IP address and port number of the destination server correct?
Does the server reply to a ping from the Viewer computer?

Live video cannot be viewed.

If “Could not connect to camera” is displayed in the video window, check the
camera’s power supply and network connection.

If a message is displayed in the timeline of the Viewer indicating that an error
occurred when connecting to the camera, check the camera’s power supply
and network connection.

If the screen goes blank when the layout is switched, but a video is displayed
after a few seconds, the number of cameras or the live frame rate setting
exceeds the performance capabilities of your computer. Reduce the number of
cameras, or decrease the frame rate.

In the H.264 or MPEG-4 video format, this may happen because there is not
enough memory. Reduce the number of open video windows or change the
video format to JPEG.

Bunooyss|gnoi
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Problem

Solution

The Storage Server slows down or it
takes longer to perform various
configuration changes, such as
registering cameras or recording
schedules from the Viewer (for Windows
Vista).

Make sure that less than ten cameras are registered on each Storage Server.
If the Storage Server is running Windows Vista, use Windows Server 2008
instead.

Live video is no longer displayed from
any camera (for Windows Vista).

Make sure that less than ten cameras are connected to one Viewer.

If you are using the layout sequence feature, set the interval to 20 seconds or
longer.

If the Storage Server is running Windows Vista, use Windows Server 2008
instead.

When the layout sequence feature is
used, the video windows suddenly go
blank and the video from the cameras
can no longer be displayed.

When you use the layout sequence feature to switch quickly to a layout where
there are a large number of video windows, the communication resources of
the system may become insufficient. Reduce the number of cameras in a
layout, or make the display interval for the layout sequence longer.

The Viewer slows down.

The performance of the Viewer depends largely on the specification of your
CPU and graphics card. When the Viewer seems to slow down, try to reduce
the number of cameras in the Viewer or decrease the frame rate.

If the video size or quality setting for the cameras is high, the large amount of
video data may cause processing to take longer. Try adjusting the video quality
and video size settings on the camera.

Timeline

Problem

Solution

Nothing happens when the playback
controls are clicked.

Move the playhead off of the [Live] position.

You must select a video window before you can play back video. In addition,
the previous frame and next frame buttons (P. 112) and the [Extract] button
(P. 114) are enabled only when one video window is selected.

[Extract Video]

Problem

Solution

An error message is displayed saying
that no video can be found in the
selected timeline segment, when trying
to save a recording.

Make sure that a recorded video is included in the selected portion of the
timeline (P. 111).

Video Recording

Problem

Solution

The Record Now feature cannot be
used.

Make sure that the camera is not disabled on the [Advanced] tab in the camera
properties. If the camera is disabled, click [Enable Camera] (P. 51).
Also make sure that only one camera has been selected to record.

The amount of Storage Server disk
space usage is much higher than the
calculated level (P. 69) and free disk
space is low.

When the video size or quality setting of the camera is high, the amount of data
per frame is large. In addition, if you are using anti-virus software, the software
records communication between the Storage Servers and the cameras and the
size of that log may reach several gigabytes. Change the anti-virus software
settings to exclude the Storage Servers from the target list.
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Connection Problems

Problem

Solution

The screen goes blank and the “Cannot
connect to camera” message is
displayed.

A network error occurred, the camera was disconnected from the network, or
the camera power was turned off.

Bunooyss|gnoi
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Error Messages

Messages Displayed in the Viewer

B Error Messages in the Video Window

Message

Cause

Video window

Connecting to camera.

The Viewer is in the process of connecting to the camera.

Cannot connect to camera.

The Viewer cannot connect to the camera and live video cannot be
displayed.

Getting camera control.

Displayed after the user tries to get camera control.

Cannot get camera control.

Another user with higher priority is already controlling the camera
when you try to get camera control.

Control will be lost in <count
down> seconds.

Displayed if the camera is idle for one minute; starts a countdown.
The countdown starts at ten and counts down one second at a time
until it reaches zero.

Camera control lost.

A timeout occurred while the Viewer was controlling the camera or
another user with higher priority requested camera control. Displayed
for three seconds.

No recorded video.

Displayed when playing back a recording if there is no recorded
video at the current playhead position.

Cannot Connect to the Storage
Server.

Displayed when you cannot connect to the Storage Server to play
back a recording.

Please wait.

Displayed when it may take some time to display an MPEG-4 or
H.264 live/recorded video.

Could not connect to send audio.

A connection for sending audio to the camera could not be
established, so audio cannot be sent to the camera.

Could not connect to receive
audio.

A connection for receiving audio from the camera could not be
established, so audio cannot be received from the camera.

You do not have permission to
view the live video.

The administrator has prohibited the display of live view.

B RM Manager Warning and Error Messages

Message

Cause

The <user name> already exists.

Tried adding a user to the Storage Server with a name that already
exists.

Unable to change the user
name. The user <user name>
already exists.

Tried adding a user to the Storage Server with a name that already
exists.

greater than or equal to 1 day.

User Please ensure that the password | The password in the [Confirm Password] field does not match the
management and confirmation match exactly. |user password.

The number of connecting

viewers has exceeded the

recommended number, and the | Tried connecting seven or more Viewers at one time.

recording server is under high

load.
Configuration The value for maximum must be Tried to specify less than one day for the maximum storage period.




Message

Cause

Adding a
recording
schedule

Streaming for recording is
applied only when the following
conditions are satisfied:

The video stream format is JPEG
The frame rate settings do not
exceed ten fps

There is no existing recording-
mode stream in the camera.

Tried to enable a recording-mode stream.

Recording
schedule

This schedule item overlaps a
previously scheduled item.
Please check your settings and
try again.

Recording schedules overlap.

Recording schedule items must
be set at least 15 minutes long.
Please check your settings and
try again.

Tried to set a schedule with a period shorter than 15 minutes.

Recording schedule items
cannot be created for the
following cameras because of a
clash with existing schedules:
<camera name>

Tried to drag a recording schedule window to add multiple recording
schedules, but one camera has a conflicting schedule.

Failed to create multiple
recording schedule items. All
selected cameras have
recording schedule items that
clash with a schedule time
range.

Tried to add a recording schedule to multiple cameras using the [Edit
Schedule ltem] dialog box, but the schedule time range clashes with
schedules that are already set on the cameras.

At least one day must be
selected. Please check your
settings and try again.

Tried to register a schedule without specifying a day.

At least one recording mode
must be selected. Please check
your settings and try again.

Tried to register a schedule without selecting the check box for a
recording mode.

You cannot use digital zoom with
<current camera position>.

Tried to specify the digital zoom range and close the [Edit Schedule
Item] dialog box with [Current Camera Position] selected.

Special day
schedules

This schedule type has days set
up for it to be used on. These
need to be removed before
deleting the schedule type.

Tried to delete the special day schedule that has scheduled days.

This day has already been set as
special day schedule <schedule
name>. Do you want to delete
the day from the special day
schedule <schedule name> and
use it in this schedule?

Tried to use dates that are already used for another special day
schedule.

Special day schedules cannot
be set the end time which is
earlier than the start time.

Tried to register a schedule that goes past 24:00.

A schedule with this name
already exists.

Tried to add a special day schedule with a name that already exists.

Adding and
editing a
camera

Could not connect to camera.
Please verify that the host name,
port number, user name, and
password are correct.

Could not connect to camera.

Are you sure you want to remove
the camera <camera name>" If
the camera is removed, you will
not be able to play back
recorded video.

Tried to delete a camera.
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Message

Cause

Event
notification

Invalid E-mail Address.

Characters other than alphanumeric characters and the underscore
(L) were entered for the e-mail address.

B Warning and Error Messages in the Viewer

Message

Cause

Viewer window

The time on this machine is out-
of-sync with the time used by the
storage server group. This
causes problems with the
display of events. To correct this
problem, please synchronize the
time of this machine to the server

group.

There is a time difference of 5 seconds or longer between the
Storage Server and the Viewer computer. Adjust the system time of
the Viewer computer to the time of the Storage Server.

This message is not displayed if the [Send notification when time is
out-of-sync with the storage server group] checkbox is cleared in the
[Viewer Settings] dialog box (P. 122).

Connection to storage server
<host name> could not be
established. Please verify that
the host name and port number
are correct.

A problem occurred when connecting to the Storage Server to
display a Viewer window.

Cannot save it in this folder.

The Windows folder or the Program Files folder was specified as the
destination folder for snapshots.

This layout cannot be saved
using the same name as an open
layout. Please try again using a
different name.

Tried to save a layout using the same name as another layout that is
open in another tab or window.

The length of the extracted video
must not exceed 1 hour.

Tried to make the time longer than one hour.

Unable to extract video. There is

Saving the no video data in the specified Could not save video because there was no recorded video in the
Specified Video |, P selected segment.
timeframe.
L The Windows folder or the Program Files folder was specified as the
Cannot save it in this folder. R .
destination folder for a .mov file.
You cannot move the layout
<layout name> because it is Tried to move a layout that is registered to the layout sequence
contained in the current layout currently in use.
sequence.
You cannot move the layout
<layout name> because it is the | Tried to move the current layout.
current layout.
[Organize You cannot delete the |ay_ogt Tried to delete the folder that contains the current layout or the
<layout name> because itis the current layout and layout sequence
Layouts and current layout. Y Y a :
Layout
Sequences] Unable to change layout name.
dialog box The name <layout name> Tried to rename a layout using the same name as an existing layout.

already exists.

You cannot move the layout
sequence <layout sequence
name> because it is the current
layout sequence.

Tried to move a layout that is registered to the layout sequence
currently in use.

You cannot delete layout <layout
name> because it is used by the
current layout sequence.

Tried to delete a layout that is part of the current layout sequence.




Message

Cause

[Organize
Layouts and
Layout
Sequences]
dialog box

You cannot delete the layout
sequence <layout sequence
name> because it is the current
layout sequence.

Tried to delete the current layout sequence.

You cannot move the folder
<folder name> because it
contains an open layout
sequence.

Tried to move the folder that contains the layout sequence currently
in use.

You cannot move the folder
<folder name> because it
contains an open layout.

Tried to move the folder that contains the current layout.

You cannot delete the folder
<folder name> because it
contains the current layout.

Tried to delete the folder that contains the current layout.

Unable to create folder.
The name <folder name>
already exists.

Tried to create a new folder using the same name as an existing
folder.

Unable to change layout folder
name. The name <folder name>
already exists.

Tried to rename a folder using the same name as an existing folder.

You cannot move folder <folder
name> because it contains
layout <layout name> used by
layout sequence <layout

sequence name> which is open.

Tried to move a folder that contains a layout registered to the current
layout sequence.

You cannot delete folder <folder
name> because it contains
layout <layout name> used by
layout sequence <layout

sequence name> which is open.

Tried to delete a folder that contains a layout registered to the current
layout sequence.

Messages Recorded in the Log Files

B Log File Locations

The Storage Server log files are saved in the following folder on the computer where the server is installed.
<System drive>:\ProgramData\Canon\WebView\NVR30\Log\

Types of Log Files

File Name

Description

storage_server_log_xxxxxxxxxxxx_x.csv

Log file for the Storage Server

viewer_0g_XXXXXXXXXXXX_X.CSV

Log file for the Viewer

RM_manager_log_XXXXXXXXXXXX_X.CSV

Log file for the RM Manager

B Error Messages

Messages shown below are recorded in the log file when an error occurs.

Message

Description

Cannot rename storage_server.cfg.tmp to
storage_server.cfg file

A temporary file for the configuration file was found, but
could not be renamed.

No configuration file found.

Could not find the Storage Server configuration file.
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Message

Description

Cannot delete old config <file name>, error code <win32
error>

Could not save the configuration.

Cannot rename config from <temporary file> to
storage_server.cfg, error code <win32 error>

Could not save the configuration.

Cannot write to config <storage server name>

Could not save the configuration.

Configuration file failed consistency check, exiting...

Inconsistency was found in the configuration file. This
occurs when the configuration file is rewritten directly.

Error: Local machine not in the config.

Could not find the IP address or host name of the
Storage Server in the configuration file.

Failed to bind to listen port <port number>

The Storage Server could not bind to the port.

Failed to setsockopt for conditional accept()

Could not apply a socket option to the socket for group
communication.

LS_start_service(apache) failed.

Apache startup failed.

Email Authentication error (<reason>): <host>

An authentication error occurred while sending e-mail.

Email error: recipient is unreachable (<reason>): <host>

A transmission error occurred while sending e-mail.

Email error: Email error: server not responding
(<reason>): <host>

Could not communicate with the SMTP host while
sending e-mail.

Unable to obtain file size on disk, GetFileAttributesEx
failed with error=%d for file %S

Could not determine the size of the media or event file.

CameraServer <host name> disconnected (<error
information>)

Could not connect to the camera.




B Error Codes

Winsock Error Codes

Code Error Messages Possible Cause
10038 An operation was attempted on something that is This may occasionally occur. No action is required.
not a socket.
All communication resources are in use. This error
Only one usage of each socket address (protocol/ |. .
10048 . . is frequently reported when a video can no longer
network address/port) is normally permitted. : . ;
be displayed in a Viewer layout sequence.
Occurs when the computer recognizes that the
network is down because the router or hub closest
10050 A socket operation encountered a dead network. | to the computer is powered off. Normally, this
cannot be recognized, therefore this error is rarely
reported.
Occurs when other network devices recognize that
A socket operation was attempted to an the network is down because the router or hub is
10051 i .
unreachable network. powered off. Normally, this cannot be recognized,
therefore this error is rarely reported.
The connection was aborted by the camera due to
- . . a camera restart or other causes. This may occur
An existing connection was forcibly closed by the : !
10054 remote host when the camera is restarted using the restart
‘ button on the Setting Page provided by the camera
software. However, this rarely occurs.
A connection attempt failed because the A timeout occurred in the TCP connection with the
connected party did not properly respond after a . .
10060 . . . : . camera. This occurs when the camera is powered
period of time, or established connection failed off
because connected host has failed to respond. '
. The camera rejected the TCP connection. This
No connection could be made because the target o
10061 : ; . occurs when the port number is incorrect or from
machine actively refused it.
another cause.
A socket operation failed because the destination | Occurs when the camera is powered off. Normally,
10064
host was down. 10060 occurs.
. There is no route for connecting to the camera. This
A socket operation was attempted to an . : .
10065 may also occur when there is a failure in the
unreachable host.
network cable connected to the computer or hub.
WSAStartup cannot function at this time because . . ,
. . } There is a failure on the computer’s network
10091 the underlying system it uses to provide network
. . . adapter.
services is currently unavailable.
11001 No such host is known. The host name could not be resolved in the DNS.
11004 The requested name is valid, but no data of the The host name could not be resolved in the DNS.
requested type was found.

SMTP Error Codes

Code Error Messages Possible Cause
401 ‘domain’ Service not available, closing transmission | The communication was terminated because the
channel mail server was stopped.
450 Requested mail action not taken: mailbox The requested mail processing was not performed
unavailable because the mailbox is not available.
451 Requested action aborted: local error in processing The requested Qperatlonlwas canceled because an
error occurred in the mail server.
502 Command not implemented The mail server does not support the command that
was sent.
550 Requested action not taken: mailbox unavailable The requgst was not executed because the mailbox
is not available.
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HTTP Error Codes

Code

Error Messages

Possible Cause

401

Unauthorized

The user name and password for connecting to the
camera is incorrect.

403

Forbidden

A connection cannot be established due to an IP
address restriction on the camera. This may also be
returned by a proxy server.

500

Internal Server Error

Occurs when the HTTP server is running but the
Storage Server is not launched. It may also occur
during normal operation if the camera is restarted.

503

Service Unavailable

Occurs when the camera is temporarily unable to
process requests due to server overload
(excessive requests from multiple clients), or an
uncompleted start-up process on the camera, or
other reasons.

wininet Error Codes

Code Error Messages Possible Cause
12002 The request has timed out. A reque_st timeout occurred. Ihd[cates_ that the
connection or request transmission failed.
The URL is incorrect. Normally, this does not occur,
12005 The URL is invalid. however, it may occur when an attempt is made to
connect to an unsupported camera.
The host name could not be resolved. This error is
12007 The server name could not be resolved. generated yvhen a'host name that is not registered
in the DNS is specified or when a problem occurred
in communication with the DNS itself.
The operation was canceled, usually because the | The communication was canceled. This error does
12017 handle on which the request was operating was not indicate a problem and may be generated
closed before the operation completed. during normal operation.
12029 The attempt to connect to the server failed. The copnectlon to the camera failed. Normally
12002 is generated.
. . The connection to the camera has been aborted.
The connection with the server has been . . . )
12030 ) The disconnect process itself is recorded when it
terminated.
executes normally.
12031 The connection with the server has been reset. The connection to the camera has been forcibly

severed.

POP Error Messages

Error messages

Possible Cause

ERR never heard of mailbox name

The e-mail address is incorrect.

ERR invalid password

The password is incorrect.

ERR unable to lock maildrop

The mailbox cannot be used. It is already in use by another
program.




Event Information

Events can be checked in the RM Manager [Live Events] tab and the Viewer’s [Live Events Log]. If an e-mail notification is

sent using the e-mail notification function, the event type is shown as a code.

Event Type Events Log Display Code
Motion Detection [Motion On] or [Motion Off] MOTN
Sensor Recording [Sensor On] or [Sensor Off] SENS
Manual Recording (Record Now) | [Record Now Started] or [Record Now Stopped] OPER
Intelligent Function [Intelligent Function On] or [Intelligent Function Off]

Volume Detection [Volume Detection On] or [Volume Detection Off] PLUG
Scream Detection [Scream Detection On] or [Scream Detection Off]

Event Consolidation [Event Consolidation ON] or [Event Consolidation OFF]

Recording Formats [Recording Started] or [Recording Stopped] RECD
Facrang Frame Rt Changea | PS5 Fame e fcced e o o o s (Feverted ™ gy
Low Disk Space Warning [Warning: Low Disk Space] DLIM
Delete recorded files (when disk | [Delete recorded files (when disk space is insufficient) started] or [Delete

space is insufficient) recorded files (when disk space is insufficient) stopped] LDDL
Delete recorded files (when disk | [Delete recorded files (when disk space is low) started] or [Delete recorded

space is low) files (when disk space is low) stopped] LDWN
Suspending/Resuming Recording | [Recording Suspended] or [Fixed: Recording Resumed] RSUS
Camera Communications Error [Error: Cannot Connect to Camera] or [Connection to Camera Fixed] COMM
Storage Server Starting/Stopping | [Storage Server Started] or [Storage Server Stopped] SSUP

Camera Errors

The e-mail notification feature will describe camera errors using a format of COMM codes, and detailed information such as

error type and error number. The event panel will only show the error number.

Error Error Meanin
Type Number 9
1 12004 An internal error occurred.
The host name could not be resolved. This error is generated when a host name that is not
2 12007 registered in the DNS is specified or when a problem occurred in communication with the DNS
itself.
3 12029 The connection to the camera failed. Normally 12002 is generated.
12030 The connection to the camera has been aborted. The disconnect process itself is recorded when
4 it executes normally.
12152 An unidentified server error.
401 The user name and password for connecting to the camera is incorrect.
403 A connection cannot be established due to an IP address restriction on the camera. This may also
be returned by a proxy server.
5 500 Occurs when the HTTP server is running but the Storage Server is not started. It may also occur
during normal operation if the camera is restarted.
404
HTTP related error.
5xx
0 Connection with the camera was terminated unexpectedly.
6 12017 The communication was canceled. This error does not indicate a problem and may be generated
during normal operation.
7 12002 A request timeout occurred. Indicates that the connection or request transmission failed.
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Error Error Meanin
Type Number 9
8 12005 The URL is incorrect. Normally, this does not occur, however, it may occur when an attempt is
made to connect to an unsupported camera.
9 12006 http or https was not used.
10 - Camera not supported.
11 - General error.
407 Invalid request.
501 The specified session does not exist.
12 Occurs when the camera is temporarily unable to process requests due to server overload
503 (excessive requests from multiple clients), or an uncompleted start-up process on the camera, or
other reasons.
508 Request rejected due to temporary connection limits to camera.
13 - Not connected to camera.

Events Indicating Errors or Warning Levels and Corresponding Actions

You can check events to determine if errors related to the Storage Server status have occurred.
When an event indicating an error or a warning level occurs, it is immediately displayed in the event panel or timeline. Take
the appropriate action for the event.

Event Type

Message

Description

Corresponding Action

Low disk space
notification*’

Warning: Low disk space

Occurs when the free disk space
becomes less than the specified value, or
the disk usage becomes greater than the
specified value. Data may be deleted
before the specified number of storage
days has elapsed.

Starts/stops file
deletion due to low
disk space *

Warning: Files deleted due to
low disk space

Occurs when the free disk space
becomes less than the threshold, or the
disk usage becomes greater than the
threshold.

Pauses/resumes
recording due to low
disk space *

Recording Suspended (Low
Disk Space <drive name>)

Occurs when the free disk space
becomes less than the limit level, or the
disk usage becomes greater than the
limit level.

Check the recording
mode settings (P. 78).

Error connecting to the
camera

Error: Cannot Connect to
Camera

Occurs on an error when connecting to
the camera.

Error connecting to the
Storage Server

Error: Cannot Connect to the
Storage Server

Occurs on an error when connecting to
the Storage Server registered with the
Storage Server Group.

Error connecting to the
Storage Server Group

Error: Cannot Connect to the
Storage Server Group

Occurs on an error when connecting to
the Storage Server Group.

Check the network
status.

Change in the
recording frame rate

Recording Frame Rate
reduced due to high load
issues

Indicates that the recording frame rate
has been changed due to increased
server load.

Check the recording
mode settings (P. 78).

*1 Please refer to “Manage Disk Space” (P. 67).




Appendix

This chapter includes supplemental information for reference when using this software.
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Create a Shortcut Icon for Launching the Viewer

You can configure the way the Viewer launches, for example, to have it bypass the login screen with the user name and
password (P. 100) by creating a shortcut icon that specifies Viewer launching options.

m Important

* You cannot reconfigure the shortcut icon that is automatically created on your desktop when you install this software.

e The login password can be easily viewed in the properties of the shortcut icon. Make sure to take sufficient security measures when

using this feature.

1 Right-click [Viewer.exe] in the installation folder and click [Create shortcut].

[Viewer.exe] is located in the following folder by default:

<System drive>:\Program Files\Canon\WebView\NVR30

E Note

e ‘System drive’ corresponds to the drive containing the system files of the operating system. If the operating system is installed on

the C drive, the system drive is the C drive.

¢ A message may appear asking whether or not you want to create a shortcut icon on the desktop. Click [OK] if you want to create

the desktop icon.

2 Right-click the shortcut icon and select [Properties].

3 On the [Shortcut] tab, add a launching option to [Target].

Launching Options

Description

-group nvr://<User name>:<Password>@
<Storage Server Group name>

Or

-group nvr://<User name>:<Password>@
<Host name>:<Port no.>

The information in the options is used to connect to the server
group.

The [Connect to Storage Server Group] dialog box does not
appear.

=] Note

¢ \When connecting to multiple Storage Server Groups, use a comma (,) to connect from nvr and onward.

e The host name cannot be specified in IPv6.

4 Click [OK] to close the dialog box.

5 Move the shortcut icon to a location you prefer.




Check Event Notification E-malil

When RM Manager is configured to send e-mail notifications, an e-mail is automatically sent to the specified address when

an event occurs. Event details can be checked in e-mail notifications.

Content and Format of Event E-mail Notifications

Event types include system events that indicate Storage Server Group operation and status, and camera events that
indicate camera operation and status for cameras registered to the Storage Server Group.
A sample e-mail notification is shown below.

(1)

An event of priority Highest occurred on Wed Oct 01 03:08:11.068 2014 LOCAL=+0900 [Wed Oct 01 12:07:25.118 2014].

2) 3) (4)

Camera ID is: 1.1:2014-10-01T03:08:11.068,11,COMM,1,1,7&12002.

(5) (6)

(7) (8) (99(10) (1)

Descriptor

Description

(1) Priority

Event Priority

(2) Date and time of occurrence
(Greenwich Mean Time)

This is the time and date an event occurred based on the Storage Server computer
time.

(3)Time difference

This is the time difference from Greenwich Mean Time based on the time zone of
the Storage Server computer.

(4) Date and time of occurrence
(local time)

This is the date and time calculated in (2) and (3).

(5) Camera ID

This is a unique ID used for camera identification. Only displayed for camera events
(no descriptor for system events). See also “How to Check the Camera ID”.

(6) Date and time of occurrence
(Greenwich Mean Time)

The time and date an event occurred based on the Storage Server computer time is
shown in the following format.

yy-mm-ddThh:mm:ss. fff

Year-Month-Day Hour:Min:Sec  Ms

(7) Camera ID

Described in the same way as (5) without a period. System events are usually ‘0.

(8) Event content

A code that indicates event content. Please refer to “Event Information” (P. 159) for
an explanation of codes.

(9) Value

These values show occurrence and termination of the event. ‘1" is On, ‘2" is Off.
Events that do not correspond to On/Off are usually *-1’.

(10) Priority

Event Priority

1: Highest

2: High

3: Medium

4: Low

5: Lowest

(11) Detailed information

These values indicate event details. Multiple values are separated by ‘&'

B How to Check the Camera ID

When a camera event occurs, the camera ID for the applicable camera is included in the event notification e-mail.
You can use the following steps to check which camera is indicated by the camera ID.

1 Launch a web browser.
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2 Access the following URL.

When used on the Storage Server computer:
http://localhost/webview-nvr/get_config.cgi?cmd=GetCameras

When used on a computer other than the Storage Server:

http://<Storage Server computer IP address>/webview-nvr/get_config.cgi?cmd=GetCameras

Enter “administrator” for the user name and the administrator password for the password (P. 46), and click [OK].

This action displays a camera and ID added to the Storage Server.

Total: 3

Camera Host: 192.168.100.1
Camera Name: Camera

Camera ID: 1.1

Camera Type: Canon VB-M600VE

Camera Host: 192.168.100.2
Camera Name: Camera
Camera ID: 2.1

Camera Type: Canon VB-H730F

Camera Host: 192.168.100.3
Camera Name: Camera
Camera ID: 3.1

Camera Type: Canon VB-M40




Changing the Storage Server IP Address

When the IP address of a computer on which a Storage Server is installed changes, the IP address of the Storage Server
must also be changed in some cases.

If “IP Address Configuration Error” appears for [Status] in the [Storage Server Search Results] tab of the lower section of RM
Manager, change the IP address of the Storage Server as follows.

Changing the Storage Server IP Address with RM Manager RM-64/25/9

1 Launch RM Manager.

2 Click [Tools] > [Change IP Address].

Or select the Storage Server in the [Storage Server Search Results] tab, and select [Change IP Address] in the
right-click menu.

3 Enter the Storage Server’s changed IP address, user name, and password, and then click [OK].

Change the Storage Server IP Address with the Command Line

Select [RM Storage Server] from [Control Panel] > [System and Security] > [Administrative Tools] > [Service] and
stop the service.

2 Open the command prompt using [Run as administrator], enter command line option
(-resethost=IP address) and execute.

Example: 64-bit OS

“C:\Program Files (x86)\Canon\WebView\NVR30\storage_server.exe” -resethost=XXX.XXX.XXX. XXX

Example: 32-bit OS

“C:\Program Files\Canon\WebView\NVR30\storage_server.exe”-resethost=XXX.XXX.XXX. XXX
(Enter the IP address the computer changed to in “XXX. XXX XXX.XXX".)

3 Select [RM Storage Server] from [Control Panel] > [System and Security] > [Administrative Tools] > [Service] and
start the service again.

e To stop or start the service from the control panel, select [RM-Lite Storage Server].
* When executing the command, enter “storage_server_rm_lite.exe”.
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Checking the Software Versions

The steps below explain how to check the software versions.

Checking the Version of RM Manager

1 Launch RM Manager.
2 Click [Help] > [About].

3 Check the version of the software on the displayed dialog box.

Checking the Version of the Viewer

1 Launch the Viewer.
2 Click [Help] > [About].

3 Check the version of the software on the displayed dialog box.

Checking the Version of the Storage Server

1 Click the Windows Start button > [Control Panel] > [Uninstall a program] or [Add or Remove Programs].

2 Check the version of the software in the displayed list.
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How to Upgrade the License

To purchase the upgrade license and upgrade from RM9 to RM64, for example, perform the following.

1 Launch RM Manager and connect to the Storage Server Group that you wish to change the license on.

2 Select the Storage Server Group from the [Tree View] tab.

E Note

Select the item with the [ icon.
3 Click [Tool] > [Change License].
The [Change License] dialog box appears.

4 Enter the new license key in [New License Key].

G | Change License “

Storage Server Group: 3501

Current License Key

New License Key

xipuaddy

| Click[OK].

The license is upgraded.

=] Note

If you want to change computers or reinstall a Storage Server, use the original license key to install RM, and then use the upgrade
license to change the license.
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Uninstall

Follow the steps below to uninstall this software.

m Important

e When upgrading the software, overwrite the installation with the installer so that settings and recording data are applied in the

upgraded version (P. 41). Note that when uninstalling the software using the following steps, settings used before the uninstall will not
be retained.

e Backup files and recording data from this software will remain on the computer after uninstallation. Note that recording data must be
manually deleted if you want to erase data before disposing of the computer. Please refer to “Destinations of the Backup Files”
(P. 142).

If you reinstall this software after uninstalling it, the setting configurations before uninstallation will not be retained.

1 Click the Windows Start button > [Control Panel] > [Uninstall a program] or [Add or Remove Programs].

2 Click the software to remove and select [Uninstall].



Functional Limitations for MPEG-4 and H.264 Formats

This software supports cameras that use MPEG-4 and H.264 video formats. This software has the following limitations.

Live View

e The following video window settings cannot be set, and the frame rate settings on the camera are enabled.
— Maximum Frame Rate

— Auto Adjust Frame Rate
e Synchronization of audio and video is not guaranteed.

Video Recording

¢ The frame rate settings on the camera are enabled.

e The [Reduce recording frame rate when disk is under high load] setting in the Storage Server Group Settings is disabled.

e The [Record Now] option only supports JPEG format. You cannot use this option to record video in MPEG-4 format or
H.264 format.

Playback

¢ You can perform the following operations. However, you cannot use [Fast Reverse], [Previous Frame], and [Next Frame].

— Specify the playback time on the timeline
— Start playback from the live event display window and the event search window
— You can use [Pause], [Fast Forward], [Previous Event], and [Next Event]

¢ |f you changed the recording format of a recording schedule from MPEG-4 or H.264 to JPEG part of the way through the
recording, then when you reverse the recording, the video disappears when you transition from the JPEG segment to the
MPEG-4 or H.264 segment, and the “No Recorded Video” error message is displayed.

e Recordings in MPEG-4 and H.264 format recorded with this software can only be played back with this software.
Although you can use [Extract Video] to save the MPEG-4 or H.264 recording as a .mov file and use a media player
compatible with .mov files to play the file, playback using media players is not guaranteed.
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Using the AXIS Q7404/Q7401 RM-64/25/9

For setting details for the AXIS Q7404/Q7401, please refer to the user manuals and safety precaution manuals included with
each product.

Supported Firmware

The following firmware is necessary when using the AXIS Q7404/Q7401.

Video Encoder Firmware Version
AXIS Q7404 Ver.5.50.4
AXIS Q7401 Ver.5.50.4

Usage Precautions

When registering the AXIS Q7404/Q7401 in RM-64/25/9, you must enter the host name, and the Administrator group
account user name and password just as with other cameras.

Register one AXIS Q7404/Q7401 at a time. You cannot search and register them.

If the number of simultaneous accesses to the AXIS Q7404/Q7401 increases, it may affect the recording or live video
frame rates. Be sure to test sufficiently before beginning operation.

A maximum of 20 clients can connect to the AXIS Q7404/Q7401. If the number of connecting clients exceeds 20, a
message stating you cannot connect to a camera will appear when you try to open an RM-64/25/9 video window.

If the AXIS Q7404/Q7401 is not connected to a camera, or if the input signal is lost, such as an interruption of the camera
connection, [NO VIDEO] will appear on the screen of RM-64/25/9.

Video size and video quality cannot be set with RM-64/25/9. Available video sizes are 160x120, 320x240, and 640x480.
If [Aspect ratio correction] is not selected in the AXIS Q7404/Q7401’s [Image] tab of the [Video Stream Settings], the
displayed video will be slightly compressed horizontally. We recommend that you select [Aspect ratio correction].
Reboot the AXIS Q7404/Q7401 if you use it to change settings.

Functional Limitations

The following limitations apply to AXIS Q7404/Q7401 when used with this software.

B Recording Schedule and Recording Mode Settings

¢ Only continuous recording can be used.

e The following functions are disabled in the [Edit Schedule Item] dialog box.
— Record audio if available
— [Advanced]
— [Use the recording-mode stream]

B Frame Rate

e The AXIS Q7404/Q7401 frame rate setting has no effect on the recording frame rate or live frame rate settings of
RM-64/25/9. Set the frame rate with RM-64/25/9. Only integer values for the frame rate are available in this case
(minimum one fps).

e \When four cameras are connected, you may not be able to record or play back video at the maximum frame rate
(30 fps).




Auto Adjust Frame Rate Function

Regardless of the RM-64/25/9'’s setting in [Auto adjust frame rate under heavy load] in [Viewer Settings], the Auto
adjust frame rate function is not available at any time.

Video Format

Only JPEG is available for recording or live view.

Camera Limitations

e Even if a camera has pan/tilt/zoom functions, they cannot be operated via the RM-64/25/9 control panel if the
camera is connected to an AXIS Q7404/Q7401.
e The control panel’s [Presets] is disabled.

Audio

e Audio input/output is not supported.
e Even if you select the AXIS Q7404/Q7401’s video window, the audio panel will be disabled.

Text Overlay Settings

The AXIS Q7404/Q7401 text overlay settings (date, time, text, video in video display) cannot be set with RM-64/25/9.

In addition, the text overlay settings time display and RM-64/25/9’s time display are not synchronized.

Sensor Input Terminal
The input terminals for the AXIS Q7404/Q7401 cannot be used.
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